Send Us Your Comments

Preface

1 Introduction to Oracle Depot Repair
   What is Oracle Depot Repair? ................................................................. 1-1
   Oracle Depot Repair Key Features ....................................................... 1-2
   Business Process Flows ........................................................................ 1-6
   Setup Parameters .................................................................................. 1-7
   Integration with Other Oracle Modules ............................................... 1-12

2 Overview of Using Oracle Depot Repair
   Accessing Oracle Depot Repair .............................................................. 2-2
   The Depot Repair Workbench .............................................................. 2-2
   The Service Request Information Area .................................................. 2-4
   The Service Order Information Area ..................................................... 2-7
   Details Tab ........................................................................................... 2-9
   Logistics Tab ......................................................................................... 2-12
   Diagnostics Tab .................................................................................... 2-21
   Estimate Tab ........................................................................................ 2-24
   Jobs Tab ............................................................................................... 2-31
   Tasks Tab ............................................................................................. 2-37
   Actuals Tab .......................................................................................... 2-39
   Drill into Order Management ............................................................... 2-39
   Depot Repair Workbench Tools Menu ............................................... 2-43
   Depot Repair Workbench Data Menu ................................................... 2-48
3 Oracle Depot Repair Business Scenarios

Process a Repair and Return..............................................................3-1
Process a Loaner, Repair and Return..................................................3-3
Process an Exchange........................................................................3-5
Process an Advance Exchange.............................................................3-6
Process a Replacement........................................................................3-7
Process a Repair, Refurbishment, Remanufacture or Recycling of Internally Owned Items.................................................................3-8
Process a Third Party Repair.................................................................3-11
Process a Return Only Repair...............................................................3-11
Process a Service Campaign or Recall..................................................3-12
Process a Supplier Warranty.................................................................3-14
Process a Customer Take-back Request.................................................3-14
Process a Trade-in or Upgrade.............................................................3-15

4 Depot Workbench

Overview of Managing Business Processes........................................4-3
View Customer Profile........................................................................4-4
View Coverage Information.................................................................4-5
View Service History...........................................................................4-6
Determine Contract and Price List Defaults at Service Order Creation.................................................................4-7
Create a New Customer........................................................................4-8
Create a Customer Contact.................................................................4-10
Create a Service Request......................................................................4-12
Find a Customer for an Installed Base Item...........................................4-15
Create a Service Order in the Depot Repair Workbench........................4-16
Create a Service Order Starting From Oracle TeleService......................4-21
Create a Service Order Starting From Oracle Order Management........4-22
Update the Service Order Status.............................................................4-23
5 Service Manager Portal

Overview................................................................. 5-1
Service Manager Portal Page.................................. 5-2
Using the Service Order Backlog region.................. 5-2
Using the Quality Event Watchlist region............... 5-3
Using the Advanced Search page............................ 5-4
Using the Batch Create Jobs region.......................... 5-7
Using the Create Service Order page....................... 5-8
Setting Up Aging Threshold.................................... 5-10
Setting Up Quality Threshold................................. 5-11

6 Returns Portal

Overview............................................................... 6-1
Interacting with the Returns Portal......................... 6-2
Using the Returns Portal....................................... 6-2

7 Service Campaigns and Recalls

Overview............................................................... 7-1
Service Campaigns and Recalls Process Flow.............. 7-2
Creating a Recall Event.......................................... 7-4
Using the Details Tab............................................. 7-6
Using the Items Tab............................................... 7-7
Using the Corrective Actions Tab............................. 7-9
8 Environmental Impact Dashboard

Overview ........................................................................................................... 8-1
Environmental Impact Dashboard Overview .................................................. 8-2
Using the Returns Tab ...................................................................................... 8-4
Using the Eco-Impact Tab ............................................................................... 8-6
Using the Disposition Summary Tab ................................................................. 8-8
Using the Put on Market Tab ............................................................................ 8-8

9 Bulk Receiving Module

Overview ........................................................................................................... 9-1
Entering and Processing Bulk Receive Data .................................................... 9-4
Bulk Receive Items Processing Logic ............................................................... 9-6

10 Technician Portal

Overview ........................................................................................................... 10-1
Searching for Service Orders .......................................................................... 10-3
Service Order Page Overview ......................................................................... 10-3
Using the Evaluation Tab ................................................................................ 10-5
Using the Service Execution Tab ..................................................................... 10-7
Using the Debrief Report Tab .......................................................................... 10-13
Launching Service Order Orchestration in the Technician Portal ................... 10-16
Generating Estimates ...................................................................................... 10-16
Using the Complete Work button .................................................................. 10-17
View Service Bulletins from the Technician Portal ......................................... 10-18
Manage ECOs .................................................................................................. 10-20
Backflush Service Parts .................................................................................. 10-21
Auto-Issue Service Items to Jobs ..................................................................... 10-21
Using Time Clock ............................................................................................. 10-21
Deleting Operations ......................................................................................... 10-24

A Windows and Navigator Paths

Depot Repair Windows and Navigator Paths .................................................. A-1

Index
Part No. E48965-02

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Introduction to Oracle Depot Repair
This chapter discusses the key concepts, features, and process flows of Oracle Depot Repair.

Overview of Using Oracle Depot Repair
This chapter provides an overview of the user interface and the major tasks that you can perform using Oracle Depot Repair.

Oracle Depot Repair Business Scenarios
This chapter describes working with different depot repair business scenarios.

Depot Workbench
This chapter describes task-based procedures for different processes that a user can perform to fulfill responsibilities.

5 Service Manager Portal
This chapter outlines the broad set of capabilities that a service manager performs in the course of normal service center operations.

6 Returns Portal
7 Service Campaigns and Recalls
8 Environmental Impact Dashboard
9 Bulk Receiving Module
This chapter describes how to easily receive items into the depot that arrive with or without an RMA.

10 Technician Portal
This chapter describes an enhanced set of operations to process service order items.

A Windows and Navigator Paths
This appendix lists each window available for use in the Oracle Depot Repair application as well as the associated navigator path for each window.

Related Information Sources
Oracle Depot Repair Implementation Guide

Integration Repository
The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite’s business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

You can navigate to the Oracle Integration Repository through Oracle E-Business Suite Integrated SOA Gateway.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.
Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Introduction to Oracle Depot Repair

This chapter discusses the key concepts, features, and process flows of Oracle Depot Repair.

This chapter covers the following topics:
- What is Oracle Depot Repair?
- Oracle Depot Repair Key Features
- Business Process Flows
- Setup Parameters
- Integration with Other Oracle Modules

What is Oracle Depot Repair?

Oracle Depot Repair is part of the Oracle E-Business Suite and offers an enterprise-wide solution for managing depot business processes. It targets the service business market from simple, quick services like routine maintenance to complex overhauls. Oracle Depot Repair integrates with other Oracle E-Business Suite modules to provide an integrated comprehensive solution for the service business sector.

The Depot Repair process includes the return of broken and serviceable items, their diagnoses and job estimates, customer approvals and services management, and subsequent return of items to inventory, part harvesting, recycling or scrap. The collection of charges for materials, labor, and expenses for the services is used to invoice the customer.

Depot Repair enables a business to process customer products and parts as well as internally owned items and parts. Parts can be returned from end consumers, field service technicians, partners, distributors, warehouses or other sources.

Customers expect quick and seamless service processing. Oracle Depot Repair provides end-to-end service management functionality for depots that are committed to delivering a total service solution.
Oracle Depot Repair Key Features

The major features of Oracle Depot Repair include:

- Customer Management, page 1-2
- Service Request Management, page 1-2
- Service Order Management, page 1-2
- Service Execution, page 1-2

Customer Management

Oracle Depot Repair provides a number of tools that enable a service organization to better know, understand and serve their customers. Depot supports customer interactions via phone, email, fax, walk in, store front, mobile device and web portal. Depot also provides tools to interact with customers other than end consumer, such as resellers, dealers, distributors, and partners.

Oracle Depot Repair also supports scenarios in which customers walk in at depots for service needs.

Oracle Depot Repair provides service organizations with the right tools and knowledge for responding effectively to the service issues that customers have.

Key customer management features include:

Oracle Depot Repair Workbench

The Service Orders window in Oracle Depot Repair provides the service agent instant access to information about the customer and enables the agent to effectively address the needs of the customer. The customer Profile menu option enables service agents to view the number of open Service Orders, open Service Requests, active contracts, and other details for a selected customer. In the Find Service Requests window, service agents can query for Service Orders to see the Service Order statuses, jobs, and tasks.

Relationship Management

Oracle Depot Repair lets service agents capture the contact’s relationship with others in the concerned organization, or other organizations, enabling service agents to engage knowledgeably with customers and other service agents.

Customer Data Store

Oracle Depot Repair enables service agencies to maintain a comprehensive database of all customer interactions with the agency. Oracle Depot Repair maintains detailed service history to trace the origin of a service issue and the follow up actions that solved
Service Request Management
Oracle Depot Repair enables service agencies to offer customers the convenience of accessing service through telephone, over the internet or over the counter. Key Service Request management processes include:

- Create and Update Service Requests
- Search Knowledge Management Database

Create and Update Service Requests
Oracle Depot Repair provides tools to create service requests in multiple ways. They can be manually created using the Depot Workbench, created in bulk using the Mass Create Service Order screen, created online using the Returns Portal or created automatically using the Bulk Receiving module. No matter how a service request is created, it can still be viewed and transacted in Oracle Teleservice, iSupport, HTML Service, the Returns Portal and Depot Workbench.

Search Knowledge Management Database
Oracle Depot Repair makes available a database of solutions, which the service agents can search with a view to solving the problem while the customer interaction is in progress. The Oracle Knowledge Management database can also provide information, such as guides, policies, procedures, and FAQs.

Where the problem affecting the current Service Order item is matched up with the solution in the Oracle Knowledge Management database of a similar problem, Oracle Knowledge Management can assist in the Service Order processing by defaulting charge lines for WIP and Task estimates and Bills and Routings for WIP Service Jobs.

Service Order Management
Oracle Depot Repair provides Service Types that enable service providers to be more efficient in managing the service through process automation. Service Types help to classify the Service Order and determine the service management processes and logistics to fulfill the service process.

Oracle Depot Repair supports the following Service Types:

- Repair and Return, page 1-2
- Loaner, Repair and Return, page 1-2
- Exchange, page 1-2
Repair and Return

Use this Service Type when a customer returns the broken or damaged item to the depot for service. After completion of the service, the serviced item is returned to the customer. This Service Type requires:

- A return materials authorization (RMA), or Return line, to receive the customer's broken or damaged item.
- A Sales Order, or Ship line, to ship the serviced item and invoice the customer.

Loaner, Repair and Return

This Service Type combines two Service Types, the Repair and Return, with the Loaner. The loaner concept indicates that depot sends the customer the loaner before the receipt of the customer's broken or damaged item. To track the shipping and return of both the loaner and the broken or damaged item, the system creates four logistics lines, one Sales Order to ship the loaner to the customer, one RMA Order for the return of the customer product into the depot, one Sales Order to ship the serviced item back to the customer and one RMA Order for the return of the loaner item back to the depot.

Exchange

This Service Type represents a scenario when the depot sends an exchange item to the customer after receiving the customer's broken or damaged item. The Exchange Service Type assumes that the serviced item does not return to the customer.

Advance Exchange

This Service Type is the same as the Exchange Service Type except that the depot can send the item to the customer before the service organization receives the customer's broken item.

Loaner

Use this Service Type when the depot sends an item to the customer solely for the purpose of temporarily replacing the damaged product. This Service Type requires a Sales Order to ship the loaner item to the customer and to create an invoice, and an
RMA order to track the return of the loaner item. A deposit and return due date may be a requirement. In a loaner scenario, the depot generally does not provide any service to the customer.

**Replacement**

A Replacement Service Type refers to a scenario when the depot sends an item to the customer without expecting a return. In this scenario, the service provider sends the customer an item to replace the customer's item. The service organization can:

- Link the replacement item to the original item in the Installed Base.
- Change the status of the replaced item to indicate that it is out of service and that the new item has replaced it.

**Standard**

Use this Service Type when logistics lines are not created automatically at time of Service Order creation. This Service Type is flexible however, and allows the manual creation of RMAs and Sales Orders.

**Refurbishment**

A Service Order and its associated Service Request can be created in Spares Management of Oracle Field Service as a result of a demand for refurbishment or replenishment. The Service Order has a Service Type of Refurbishment, and has two transaction lines, Move In and Move Out.

The Move In line tracks the shipment of defective items from its original location into the servicing depot. The Move Out line processes the shipment of the serviced items back to the original location.

The processing of Move In and Move Out lines leverages existing Internal Order and Internal Requisition functionality. From the depot's perspective, defective items are received via the Internal Requisition, and usable/serviced items are shipped via the Internal Order.

**Service Resolution Management**

Oracle Depot Repair improves operational efficiency by providing the following key service resolution management features:

- Job search functionality.
- Process automation based on Service Type, such as automatic creation of logistic lines.
- Estimate creation and approval.
• Leveraging of the depot knowledge base throughout service processing.

• Job creation and release to shop floor.

• Flexible options for receiving items and shipping items.

• Invoicing of final charges.

Service Execution

Use either of the following service modes to execute services:

• WIP (Work In Process): Recommended for use when a business desires costing and parts planning. The WIP mode leverages the costing of items through Oracle Costing. WIP mode is the recommended default execution mode as it allows a business to make use of the Technician Portal, Costing, Demand Planning and Service Parts Planning or Supplier Warranty Management.

• Task: Recommended for use when the services require minimal steps that do not necessarily require a series of sequential steps. In contrast to WIP mode, Task mode does not integrate with Oracle Costing, the Technician Workbench, Costing, Demand Planning, Service Parts Planning or Supplier Warranty Management.

You implement and manage either of these service modes on separate tabs in the Oracle Depot Repair Workbench.

During implementation, you associate the WIP or Task mode with Service Types. Though a service organization can have different Service Types associated with different service modes, it is recommended that a service organization select only one service mode for all Service Types to ensure consistent costing and material planning.

Business Process Flows

Oracle Depot Repair supports the following business process flows:

• Logistics and Maintenance with Call Center Facility, page 1-6

• Logistics and Maintenance without Call Center Facility, page 1-6

• Internal Party Service Operations, page 1-6

You can use either Oracle Work In Process (WIP) or the Task Manager (in Oracle Common Application Components) to manage the service process. Based on your choice, the Service Type for a given Service Order determines which service management process to use.
Logistics and Maintenance with Call Center Facility
This business flow starts with a Service Request, where the call center service agent records a problem. If the service agent cannot resolve the problem using information in Oracle Knowledge Management, the service agent refers the Service Request to a depot service agent. The depot agent can then create a Service Order and an estimate (if required) and seek approval from the customer for further processing.

Depending on the Service Type, the depot service agent completes the different RMA and Sales Order lines to assist the completion of the service process. The service mode (associated to the Service Type) determines whether to use Oracle WIP or JTF Tasks to manage the job. After the service completion, the depot returns the serviced item to the customer. The system captures the material, labor, and expenses that the service needed as charges and transfers that information to Oracle Order Management for invoicing.

Logistics and Maintenance without Call Center Facility
This process is similar to the Call Center, Logistics, and Maintenance business process except that there is no call center.

Businesses that do not incorporate a call center facility, or those that integrate their call center into the depot, can use this process.

Internal Party Service Operations
You can refurbish items and parts that your organization already owns. Oracle Depot Repair lets you process internal service operations in such cases. The customer is an internal party in the corresponding Service Request. RMAs and Sales Orders are not required to process service operations and items and parts can be moved internally from warehouse to warehouse. This is under the assumption that items already exist in a subinventory within the organization letting you create jobs.

Setup Parameters
Depot Repair provides a setup screen that allows administrators to select application configuration options using simple Attribute-Operator-Value (A-O-V) rules. The new setup parameters allow administrators to default values and system behavior based on A-O-V rules and not relying on fixed profile values. Explanatory text is available on the page to make setup and maintenance easier. Dependencies between options are made explicit and clear to understand.

As the Depot Repair application relies on integrations with many other CRM and ERP applications, the setup parameters allow the administrator to setup profiles for the Depot application as well as other applications that are required for successful depot business flows.

Depot Repair provides the ability to automate the disposition of products and the
assignment of services to specific resources based on the following two rules engines:

**Defaulting Rules Engine**

Service queue, SO owner, priority and other service order values default at the time of service order creation based on customer defined rules. The fields that default are: Inventory Organization, RMA Receiving Organization, RMA Receiving, Subinventory, Service organization, SO Owner, Service Priority, Service Type, Ship from Organization, Ship from Subinventory, Vendor Account, etc. Rules are based on service item, service location, customer, contract, etc.

**Setting up Defaulting Rules**

To set up defaulting rules

1. Navigate to the Defaulting Rules page. This page displays the summary of existing defaulting rules.

2. To set up a new defaulting rule, click Add Another Row button.

3. Enter the values in the following fields:
   - Precedence: Each rule is assigned a Precedence. Rules are evaluated in the order of precedence - the smaller the number, the higher is the precedence. The Precedence field accepts both positive and negative values.
   - Name: Name of the defaulting rule
   - Description: Description of the defaulting rule
   - Entity: Defaults from the system
   - Defaulted Attribute: The value of this field defaults when a defaulting rule is applied to a service order.
The list of values for Defaulted Attribute are:

- Inventory Organization
- RMA Receiving Organization
- RMA Receiving Sub-Inventory
- Service Organization
- SO Owner
- Service Priority
- Service Type
- Ship From Organization
- Ship From Sub-Inventory
- Vendor Account
- Material Transaction Reason Code
- Service Warranty

**Note:** All the attributes with the exception of Disposition Code has an Entity of Service Order.

- Value Type: It lists attributes whose values default using Defaulting Rules. Valid list of values for Value Type are:
  - Attribute: This enables the user to specify a value from a dynamically generated list of values for the Defaulted Attribute. This list of values is generated based on the selection in the Defaulted Attribute.
  - PL/SQL API: This defaults the value returned from a call to the specified PL/SQL API to the Depot Workbench when this rule is evaluated to be true.
  - Profile: When you select profile as the value type and there are multiple levels of profile setting (for example, profile values set at the User level and at the Responsibility level), the system behaves the way it does for other profile option selections. This means it defaults from the most specific level that has been set (in this example, giving the User level setting precedence over the Responsibility level setting).
4. Click the Details icon to navigate to the Update Defaulting Rule page.

This page displays the details of the defaulting rule you entered. Use this page to specify a value for the defaulted attribute and the conditions to trigger the rule.

5. In the Defaulting Conditions region, click Add Another Row to enter a self-explanatory name for the condition.

Defaulting Conditions region enable you to define one or more conditions for a defaulting rule. All the conditions must evaluate to true to execute the defaulting rule.

6. Click Apply to save your work and navigate back to the Defaulting Rules page.

7. Click Save to save the Defaulting Rule.

8. Duplicate icon duplicates the condition.

9. To delete a defaulting rule, click the corresponding Remove icon in the Defaulting Rules page.

**Using Defaulting Rules**

**To use defaulting rules**

1. Navigate to the Depot Repair Workbench and click the New button to navigate to the Service Orders page.

2. Create a new Service Request and click Save. See: Create a Service Request, page 4-12.

3. Create a new service order for the item for which you have set the defaulting rule. See: Create a Service Order in the Depot Repair Workbench, to create a service order.
4. Click in the Service Type field, in the Service Order Information region. Any field for which rules have been created which evaluate to true defaults. You can overwrite the default values till the service order is saved.

Disposition Rules Engine

Service type, service location, service organization, third party service vendor, exchange from location and other values default at the time of service order creation based on customer defined rules. Rules are based on service item, service location, customer, contract, and the like.

Disposition implies a specific set of attributes related to where a product goes and what is done to it, for example the shipping and receiving inventory organization, subinventories, the service type, and the like.

Returns Portal Parameters

The Returns Portal provides an effective and efficient way to enable customers to return products. Customers may exchange or return products for service, repair, testing, calibration or trade-in credit. The Returns Portal allows customers, business partners, and retail associates and distributors to request returns directly via a web portal.

Setting up Returns Portal Parameters

To set up returns portal parameters:

1. Navigate to the Returns Portal Parameters Page. This page displays the summary of existing returns portal parameters.
2. To set up a new parameter, click Add Another Row button.

3. Enter the values in the following fields:
   • Parameter Name: Enter a unique name for the parameter. Parameter name determines system behaviors for the entire business or only conditionally when specific conditions are true.
   • Description: Enter a description of the parameter.
   • Value: Enter a value of the parameter. Parameters are created with values that are enumerated list (Yes or No), integers, decimals, date times or LOVs.

4. Click Save to save the parameter.

For more information see:
Setting Up Service Types, Oracle Depot Repair Implementation Guide.

**Integration with Other Oracle Modules**

Oracle Depot Repair integrates with the following Oracle modules:

**Advanced Scheduler**

Oracle Advanced Scheduler enables optimal scheduling of tasks for depot business needs. While the Assignment Manager (in Oracle Common Application Components) searches for qualified resources to complete a depot task (based upon selection criteria set within the Assignment Manager), these qualified resources transfer to Oracle Advanced Scheduler to make the actual assignments based upon previously defined constraints. Oracle Advanced Scheduler uses the Assignment Manager to schedule Depot tasks.

**Assignment Manager**

Oracle Depot Repair uses Assignment Manager to schedule technicians to all open and planned tasks. This module permits the planner to use the Assignment Manager in an assisted or unassisted mode. For more information, see the Oracle Common Application Components User's Guide.

**Bills of Material**

Oracle Bills of Material store lists of items that are associated with a parent item, and information about how each item relates to its parent. Oracle Depot Repair uses Oracle Bills of Material to create service routers that the system uses for a submitted WIP Job,
and to create a bill of materials for an item that is linked to a service router.

**Contracts (Contracts Core and Service Contracts)**

Oracle Depot Repair integrates with Oracle Service Contracts to manage service contracts associated with a customer's Installed Base item. Oracle Service Contracts holds all service contracts centrally--including warranties, extended warranties or complex service agreements--and provides the service provider visibility to all service entitlement information. It leverages functionality that Oracle Contracts Core provides to support common contract management activities, such as contract renewal, versioning, article management, and change management.

**Counters**

Counter events and alerts provide a valuable tool to track critical service events that can affect a customer or items in the Installed Base. Oracle Depot Repair uses the Counters module to update item counters periodically, whenever a depot technician performs work on the item, and saves it in the Installed Base record. The Counters module also permits a service provider to set up logical or derived counters that use formulas that incorporate calendar dates, time, and cycle counts to trigger an event, such as a warranty or service contract expiration, or to alert the service provider when to schedule preventive maintenance on a customer's Installed Base item. The system can send alerts by the e-mail notification system to inform service personnel about warranty or service contract expiration, or about a preventive maintenance requirement that is due.

**Field Service**

When an organization sells an item to a customer, service contracts or warranties are often offered to the customer. Most companies offer on-site support for failures of the item. This is where field service is significant. After the customer reports the problem, the field service organization determines:

- Who and when a field service agent should visit the customer.
- What parts are needed to solve the problem.

If a field service agent cannot completed the service on-site, the service may need to be transferred to the depot for completion. Furthermore, internal order refurbishments can be initiated in the Spares Management module within Oracle Field Service.

**HRMS (Human Resource Management System)**

Oracle Depot Repair uses the Oracle HRMS module to define employees and locations.
Installed Base

Oracle Installed Base is a repository that tracks all installed customer items. Oracle Installed Base maintains and updates each item record to reflect the most current configuration. Service organizations rely heavily on their installed base to provide accurate customer and item information. The installed base permits quick access to all item records and information. Oracle Depot Repair leverages this information to expedite the service process when services involve incompatibility, configuration, revision, or counter history issues. Oracle Depot Repair integrates with Oracle Installed Base to assist accurate recording of all part and serial numbers that change during an item’s life. It retrieves all service contracts and warranties associated with an Oracle Installed Base serialized item or component. Depending on the definition of Oracle Installed Base transaction sub-types, the TeleService Charges APIs update the location and instance ownership information.

Inventory

Oracle Depot Repair uses the Oracle Inventory module to manage item and spare parts inventory.

iSupport

Self-Service Service Order tracking is now supported in Oracle iSupport. Oracle Depot Repair customers can now search for their Service Orders through an Oracle iSupport self-service user interface. Oracle iSupport will properly authenticate the user and display only Service Orders for accounts which the user is authorized to view.

Knowledge Management

Oracle Knowledge Management is an Oracle Service Core module that provides an open architecture repository to store technical information or solution sets. Service agents and technicians can retrieve this information to find a quick resolution to service issues that customers are reporting, or provide assistance in an inspection or item diagnosis. Oracle Knowledge Management provides a security feature that permits only users with specific responsibility to contribute new information to the database.

Oracle Depot Repair uses the Oracle Knowledge Management Search Engine to find the best possible solutions to resolve service issues. Agents can access the knowledge repository from the Service Request or the Service Order. You can search for solutions by entering a Diagnostic Code or keyword string to query on statements that have links to a symptom, cause, action, or fact solution set. A solution set can also include a Task Template or set of objects that can automate or expedite the service process.

Notes

Notes allow technicians, service agents, receiving clerks, billing clerks and others to
capture free form notes related to a specific service order. For more information, see the Oracle Common Application Components User’s Guide.

Order Management

Oracle Depot Repair uses the Oracle Order Management module to create RMA and Sales Orders, and invoice customers for services.

Oracle Depot Repair integrates with Oracle Order Management Pricing to provide an advanced, highly flexible pricing engine that executes pricing and promotional calculations. It allows Oracle Depot Repair users to view and select a Price List while charging for a service, and while receiving or shipping an item.

Purchasing

Oracle Purchasing enables Depot users to request parts and receive purchase orders for outside processing.

Trading Community Architecture

The Oracle Trading Community Architecture module integrates with Oracle Depot Repair to track and maintain customer information such as customer name, account, customer contacts, and location.

Resource Manager

Oracle Depot Repair uses Resource Manager to manage employees when using Task mode. The Resource Manager permits a user to import employees and non-employees from HRMS into the resource module. You can set up and manage resources as individual resources, or as a team or group, and assign roles and skill sets to distinguish their qualifications. For more information, see the Oracle Common Application Components User’s Guide.

TeleService (Charges)

Oracle Depot Repair uses TeleService Charges APIs to automatically create charge lines for estimates, actuals and logistics.

TeleService (Customer Care)

The Customer Profile summarizes customer information and indicates if a customer is critical. It can provide information such as the number of open Service Requests. A system administrator sets up the profile entries, which contain a set of defined verifications that you can configure. The Customer Profile engine displays these verification results. Oracle Depot Repair uses this functionality for customer management.
TeleService (Service Requests)

Service agents typically log a Service Request to record a service issue that a customer is reporting. Oracle Depot Repair invokes Oracle TeleService APIs to automatically create the Service Request after creation of the Service Order header. The TeleService APIs populate the Service Request number into the Service Order Header to permanently link the two source documents with an internal form identity. Depot business flows always start with the creation of a Service Request.

Task Manager

Oracle Depot Repair uses the Task Manager to assist service management. The Tasks model leverages the core functionality that Oracle Depot Repair provides by its integration with Resource Manager, Assignment Manager, and Oracle Calendar. The Task mode provides an alternate service process that is intended to manage simple service work that does not require extensive tracking or management processes. After task completion, the technician uses the Debrief Report in Oracle Depot Repair to log the material, labor, and expense transactions. For more information, see the Oracle Common Application Components User's Guide.

Work in Process

Oracle Depot Repair uses WIP APIs to automatically create the jobs, operations, materials and resources required to execute service. Technicians can drill down from the Technician Workbench into the native WIP screen to view on hand quantity of parts and other information.

**Note:** Oracle Depot Repair provides E-records and E-signature (ERES) functionality in WIP mode via Oracle WIP.
Overview of Using Oracle Depot Repair

This chapter provides an overview of the user interface and the major tasks that you can perform using Oracle Depot Repair.

This chapter covers the following topics:

- Accessing Oracle Depot Repair
- The Depot Repair Workbench
- The Service Request Information Area
- The Service Order Information Area
- Details Tab
- Logistics Tab
- Diagnostics Tab
- Estimate Tab
- Jobs Tab
- Tasks Tab
- Actuals Tab
- Drill into Order Management
- Depot Repair Workbench Tools Menu
- Depot Repair Workbench Data Menu
- Find Service Orders for Job Submission Window
- Submit Jobs for Service Orders Window
- Define Triggers for Service Bulletins
- Receive Unplanned Returns
- Receive Planned Returns
- Execute Repair
Accessing Oracle Depot Repair

At the core of Oracle Depot Repair is the Depot Repair Workbench that provides service agents with instant access to customer and Service Order information. You can access a number of tabs from the Depot Repair Workbench. Some tabs show information about the customer, the Service Request, and the service history of the item. Other tabs let you process transactions, such as:

- Receipt or shipment.
- Creation and processing of Jobs and Tasks.

The Depot Repair Workbench also provides access to a knowledge base through Oracle Knowledge Management.

The following procedures describe how to access the Depot Repair Workbench.

Steps

1. Navigate to the Find Service Requests window.

2. Click New. The Service Orders window opens providing access to the Depot Workbench.

3. Alternatively, in the Find Service Requests window, you can retrieve a specific Service Order by entering search criteria, and clicking the Find button.

   **Note:** You can also open the Depot Repair Workbench from the Service Request Quick Menu.

The Depot Repair Workbench

Oracle Depot Repair user operations start in the Service Orders window that is generally referred to as the Depot Repair Workbench.

In the Depot Repair Workbench you can perform many depot service functions, including Service Order creation, status monitoring, receiving, and shipping. From the Depot Repair Workbench you can create Service Orders to track the activities on customer or vendor items returned to depot repair for service, upgrade, or overhaul.
Using the Depot Workbench, you can capture a value for a Project, Task and/or Model Unit Number on a Service Order. The list of values for Project is restricted to those Projects defined in Oracle Project Manufacturing. The list of values for Task is restricted to the valid Tasks for the selected Project. When a Project, Task or Model Unit Number is selected on the Depot Repair Workbench, the values are passed to Order Management when an RMA or Ship line is created from Depot. Also, the values are passed to any WIP jobs created from the Depot Workbench.

You can use the Depot Workbench to cancel an order line in Order Management to the point of booking the order from the Depot Workbench. Select an RMA or Ship line in the Logistics tab, and select Cancel Order from the Tools menu.

The Depot Repair Workbench provides integration with Oracle E-Business Application Suite modules and components, such as Notes, Charges, Knowledge Management, Installed Base, Work in Process (WIP), Bills of Material (BOM), General Ledger, Inventory, Shipping, and Receiving.

For more information, see Integration with Other Oracle Modules, page 1-12.

Service organizations can start their depot business process from the Depot Repair Workbench. When a service agent enters the customer and item information, the Depot Repair Workbench automatically validates the customer and item in the Installed Base.

From the Depot Repair Workbench, you can:

- Create new customers.
- Review your customer profiles.
- Automatically create Service Request and charge lines based on the selected Service Type selected.
- Access shipping and receiving areas.
- Access WIP or Tasks for service management.

For more information on the Depot Repair Workbench, see:

- The Service Request Information Area, page 2-4
- The Service Order Information Area, page 2-7
- Details Tab, page 2-9
- Logistics Tab, page 2-12
- Diagnostics Tab, page 2-21
- Estimate Tab, page 2-24
- Jobs Tab, page 2-31
The following features, that in previous versions were available through tabs in the Depot Repair Workbench, are now accessible through menu options:

- Coverage Window, page 2-43
- Activity Window, page 2-48
- Service History Window, page 2-48

For more details about these features, see Depot Repair Workbench Tools Menu, page 2-43 and Depot Repair Workbench Data Menu, page 2-48.

The Service Request Information Area

You can enter and view customer information in the Service Request Information area. The fields in the Service Request Information area include:

- Customer Information Fields, page 2-4
- Contact Information Fields, page 2-4
- Item Information Fields, page 2-4
- Service Order Information Area, page 2-7

Customer Information Fields

Fields in the Customer Information area include:

- Customer Type: Caller types.

- Customer: Customer names. The customer can also be the internal party. Validation of items occurs against the party ID to assist the service of internally owned items.

- Account: Customer Account Number.

- Phone: Customer’s contact telephone number.

- Bill-To: Bill-to address of customer or a related party.
• Ship-To: Ship-to address of customer or a related party.

Note: The Bill-To and Ship-To addresses always default to the primary bill-to and ship-to addresses of the customer party, even if you select a primary address for the Installed Base instance.

Note: Also, the list of values for the Bill-to and Ship-to fields contains only the bill-to and ship-to addresses of the customer party. The Bill-to and Ship-to fields do not contain the addresses of the contact even if you have selected one.

Customer Information Buttons

The button in the Customer Information area is:

• New Customer: To create a new customer, click the New Customer button

Contact Information Fields

Fields in the Contact Information area include:

• Contact Type: Choose this value from the list of values.

Note: This field does not automatically default to a null value. If you do not want to enter any contact information, then select the blank value from the Contact Type list of values; the remaining contact information fields that follow are disabled.

• Contact: Contact's name (customer account validation is required). Select from the contacts that your organization defined during Oracle Depot Repair setup.

• Relationship: Specifies the contact’s relationship with the customer, such as Associate of, Child of, and Benefactor of. Select from the Relationship list of values.

• Contact ID: Contact’s Identification Number.

• Phone: Contact's telephone number.

• Email: Contact’s email address.

• Service DFF: The Service DFF enables you to add more information.
Contact Information Area Buttons

The button in the Contact Information area is:

- New Contact: To create a new customer contact, click the New Contact button.

Item Information Fields

Fields in the Item Information area include:

- Installed Items Only check box: Validates the item against the Installed Base.
  
  When the Installed Items Only check box is not set, the list of values for the Item field displays both the Installed Base trackable items and the non-Installed Base trackable items.

  When the Installed Items Only check box is set, the list of values for the Item field displays Installed Base trackable items only, that is, those that have an Instance value.

- Item: Specifies the Item Number for which there is a Service Request.

- Revision: Displays the item revision, if the item is revision controlled.

- Instance: Shows the Instance value of the item, and applies only to items that have an Installed Base instance. If you choose to enter the Instance field for an item first, the Item field becomes automatically populated when you select the Instance value from the list of values.

- Serial Num: For serialized items, displays the Serial Number of the item.

  If you have not already entered or selected the Item, and when both of the following conditions occur:

  - Installed Items Only is not checked

  - You choose to select or manually enter an already-existing Serial Number

  then the Item field and the other item-related fields are automatically populated.

If you have already entered or selected the item:

- For serialized, Installed Base trackable items, you must enter or select a valid Serial Number.

- For serialized, non-Installed Base trackable items, if you select a Serial Number from the list of values, then other item-related fields are automatically populated.

- For serialized, non-Installed Base trackable items, if you manually enter a Serial
Number, then, whether or not it already exists, no further item-related fields are populated.

- Opened: Displays the date when the request was opened.
- Closed: Displays the date when the request was closed.

**Request Information Fields**

Fields in the Request Information area include:

- **Request Num**: Displays the system-generated Service Request Number.  
  **Note**: Set the profile option CSD: Enable Service Request Drill-down to Yes to enable the Request Num field as a hyperlink from where you can launch the Update Service Request page.

- **Summary**: Enter or view a brief description for the request in the Summary field. The Summary field is a text string field and is classified as a Note.

- **Request Type**: Choose from the list of values that your organization defined. The default value for this field comes from the profile option Service: Default Service Request Type.

- **Severity**: Choose from the list of values to assign a severity to the request. The default value for this field comes from the profile option Service: Default Service Request Severity.

- **Status**: This defaults to Open when you create a Service Request, as specified by the default value of the profile option Service: Default Service Request Status.

- **Owner**: Assign a Service Request owner. Definition of the owners occur in Resource Manager. The default value for this field comes from the profile option Service: Default Service Request Owner.

**The Service Order Information Area**

The Service Order Information area displays:

- **SO Num**: Read-only field that displays the system-generated Service Order Number.

- **Service Type**: A mandatory field that is part of the Service Order line that contains a list of values of the user-defined Service Types. A workflow supports each Service Type to automate the depot business process. For more information, see Service
• Item: An automatically populated field that shows the item that you specified in the Service Request Information area. This field can be changed.

• Item Description: The Item Description is populated automatically after the user selects a value in the Item field.

• UOM (Unit of Measure): An automatically populated field that shows the unit of measure after you specify the item. This field can be changed.

• Qty (Quantity): Automatically defaults to 1, but you can overwrite the defaulted value. In the case of serialized items, entering a quantity greater than 1 results in the creation of a Service Order with a Draft status.

• SO Status: Status of the Service Order.

• Estimate Approved: Displays the associated estimate approval status value. Values include Approved, Pending, Rejected, and null.

  Note: This is not the same as the Estimate Status which appears in the Estimate tab. For more information, see Obtain Customer Approval for a Estimate, page 4-57.
Details Tab

The Details tab contains:

- **SO Num**: A read-only field that displays the system-generated Service Order Number.

- **Item**: An automatically populated field that shows the item that you specified in the Service Request Information area. If multiple Service Orders have already been created that are associated with a single Service Request, this field displays the item in the Service Order line that you selected in the Service Order Information area.

- **Revision**: Displays the item revision residing in the Installed Base record, if the item is revision controlled.

- **Instance**: Shows the Installed Base Instance value of the item, if the item is Installed Base trackable.

- **Serial Num**: Displays the Serial Number of the item for which service is requested, if the item is serialized.

- **Unit Num**: Displays a list of values that includes Model Unit Numbers defined in the Inventory Organization to which you are assigned.

- **Lot Num**: Displays the item Lot Number residing in the Installed Base record, if the
item is lot controlled.

- **Warranty Status:** The list of values are part of an extensible lookup. The seeded values are: In Warranty, Out Of Warranty, and Warranty Violated. These values are editable. This attribute is used for businesses that have standard warranties but do not want to use Oracle Service Contracts. You can use Personalization to default the warranty status based on rules such as 1 year from Sold On Date, 90 days since Last Serviced Date and the like. This field is useful for companies which query warranty status from a third party database.

- **Installed Site:** Displays the (current) location identifier for the Installed Base item.

- **Promise Date:** Specifies the date within which completion of the item service should occur. This date is a prediction only, and is derived after the depot owner has reviewed the activities and commitments of the depot.

- **Date Created:** A read-only field that displays the system-generated date and the creation date the Service Order.

- **Date Closed:** A read-only field that displays the system-generated date and time stamp when the Service Order status is set to closed.

- **SO Owner:** Depot resource that is responsible for execution and completion of the service.

- **Currency:** Displays the functional currency of the service organization, for example, US dollar.

  **Note:** Each Service Order can have one currency only.

- **Price List:** Displays the Price List for the default contract of the Service Order.
  - For more information, see Contract and Price List Defaulting at Service Order Creation, page 4-7.

- **Default PO Num:** A free form text field to capture the Purchase Order Number. This value, if entered, becomes the default value for the PO Num fields in the Estimate Charge Line Details form, and the Logistics and Actuals tabs.

- **Resolve By Date:** The Resolve By Date specifies the date by which a service order should be resolved in accordance with the service contract associated to the service order. If a Service Contract exists, the Resolve By Date value defaults from the contract. In the absence of a Service Contract the date is null. Resolve By Date can be calculated based on service order creation date or RMA receipt date. See: The Service Types Screen, *Oracle Depot Repair Implementation Guide.*

The Depot Workbench supports integration with Project Manufacturing by enabling
you to capture a Project ID, Task ID, and Unit Number on the service order. While service orders are not recognized on a Project, you can track the RMA lines, ship lines, and WIP jobs created as part of the service on a Project. The following fields enable this functionality in the Details tab:

- **Project**: Displays list of values that show only the active Projects defined in the Inventory Organization to which you are assigned.

- **Project Task**: Displays only the active Tasks linked to the selected Project.

  **Note**: Once you select values for Project, Task, and Unit Number any RMA lines, ship lines, or WIP jobs created using the Depot Workbench are stamped with the Project, Task, and Unit Number IDs. If these IDs are changed on the Details tab, the values on the already created RMA lines, ship lines or WIP jobs are not updated. Any lines or jobs created after the updated Project and Task are stamped with the updated values.

**Details Tab Check Boxes**

- **Estimate Approval Required**: Forces an approval step after an estimate or diagnosis is performed, requiring the customer to approve the Service Order before the depot can proceed with the service.

- **Automatically Enter and Book RMA**: Appears selected or cleared by default based on setup of the Service Type corresponding to the Service Order. When you create a Service Order with this check box selected, the system automatically enters and books an RMA line. You can manually override the default selection for individual Service Orders.

**Details Tab DFF**

- **Descriptive Flex Field**: Enter flexfield information associated with the Service Order. You cannot edit the DFF field after the Service Order status is changed to Closed.

**Details Tab Buttons**

- **View Configuration**: Displays item details for items that are Installed Base trackable. Item details include the most recent item configuration and revision status. The depot can use this information when attempting to troubleshoot, upgrade, or service the item.

- **Update Counters**: Displays the Counters Update window. In the Counters Update
window, service technicians can update the counters that are associated to an item.

- Update SO Status: Displays the Update Service Order Status window where you can change the status of a Service Order.

- Notes: Displays the Notes window. On the Notes window, you can record and share relevant information about customers and service processes.
  
  Selecting the Service Request Notes option creates Notes linked to the Service Request, whereas selecting the Depot Repair Notes option creates Notes linked to the Service Order.

**Logistics Tab**

On the Logistics tab you process receiving or shipping transactions, for all types of service.

For logistics operations not initiated using the Spares to Depot flow, that is, services that are not internal order refurbishments, the main operations that you can perform in the Logistics tab are as follows:

- Create and view RMA/Sales Order charge lines that are linked to a selected Depot Service Order.

- Edit or save an existing charge line.

- Book an RMA or Sales Order.

- Pick release a Sales Order.

- Receive a returned item and move it into a subinventory.

- Ship a serviced, loaner, or exchange item and ship items to third parties.

- Cancel a Sales Order.

- Create, Pick Release, Ship and Receive Internal Sales Orders from the Internal Move Orders screen.

- Default Logistics Lines for OSP Operations: This enables a technician to automatically create a third party ship and RMA line on the Logistics tab whenever an OSP operation is executed. Set the profile option, CSD: Create Logistics Lines for OSP, to Yes to enable this functionality.

For the Spares to Depot Flow, the main operations that you can perform in the Logistics tab are as follows:

- Create and view the Move In and Move Out charge lines.
• Pick release the internal Sales Order.

• Receive the item for refurbishment and move it to a subinventory.

• Ship the refurbished item.

The main fields on the Logistics tab appear automatically in one of two different multi-record layouts, depending on the Service Type of the Service Order:

1. A general layout for most of the Service Types, page 2-12

2. A special layout for internal order refurbishment Service Types, page 2-12, that is, where the Service Type has been set up as follows:
   - The Service Type has Service Type Ref = Refurbishment.
   - The Service Type has the Internal Order flag set on.

   For details of setting up Service Types, see the Oracle Depot Repair Implementation Guide.

Under the multi-record area of the Logistics tab are the elements common to all Service Types:

• Logistics Tab Check Box and Radio Buttons, page 2-12

• Logistics Tab Buttons, page 2-12

**Logistics Tab General Multi-Record Area**

The general multi-record area of the Logistics tab contains the following fields:

• Process Trans (check box): Selects the charge line for processing. When you select a line, you can select the "Automate order processing steps through" check box and one of its associated process stage options to set the parameters for processing the charge line (see Logistics Tab Check Box and Radio Buttons, page 2-12)

• Action Type:

  In the Action Type field, select one of the following:
  - Return option to receive customer or vendor items.
  - Ship option to ship items to customers or vendors.

• Action Code: When the Action Code field is enabled, either leave the default value or select one of the following:
  - Customer Item option if the item belongs to the customer.
• Loaner option if the item is on loan to the customer.
• Exchange option if the item is an exchange.
• Replacement option if the item is a replacement.

• Service Activity: Select the relevant Service Activity in this field, for example: Return for Repair.

• Order Num: Displays the RMA/Sales Order Number that Oracle Order Management returns.

• Line Num: Displays the Line Number in the Oracle Order Management order that is specified in the Order Num field.

• Status: Displays the status of the active Order Management Order Number. The status can be Entered, Submitted, Booked, Released, Received, or Shipped.

• Item: Choose the Item Number from the list of values.

• Price List: Specifies an Order Management Price List to price the Charge line.

• Qty: Specify the item quantity.
  If the value of Action Code is Customer Item, then the Qty in the Logistics tab must not exceed the Service Order Qty, that is, the Qty in the Service Order Information area.

• UOM: An item’s unit of measure.

• Price: Specifies a price from the Price List for the charge line.

• Rev: Displays the item revision, if the item is revision controlled.

  Note: The Source fields that follow are based on item inventory attributes. For more information, see the Oracle Inventory User’s Guide and the Oracle Depot Repair Implementation Guide

• (Source) Serial Num: If the Source Item (the Item that is currently being shipped or received) is serialized, this field displays the Serial Number for the Source Item.

• (Source) Instance: If the Source Item (the Item that is currently being shipped or received) is Installed Base trackable, this field displays the Instance value for the Source Item.
  For a ship exchange line, the Source fields are optional and the fields are blank by default. You have two action items for the Source fields:
• You can leave the Source fields empty if you do not know which instance is being shipped out and let them get populated during shipping.

• You can select the instance/serial being shipped out if you know exactly which serial number is being shipped out.

If the list of values in the Source field is empty, then check the following:
• You have internally owned items.
• A value is specified for Service: Inventory Validation Organization.

Note: The Non Source fields that follow are based on attributes set up in Installed Base transaction subtypes. For more information, see the Oracle Depot Repair Implementation Guide.

• (Non Source) Serial Num: If the Non Source Item (the Item that is currently being replaced or exchanged) is serialized, this field displays the Serial Number for the Non Source Item. This applies only for Ship lines.

• (Non Source) Instance: If the Non Source Item (the Item that is currently being replaced or exchanged) is Installed Base trackable, this field displays the Instance value for the Non Source Item. This applies only for Ship lines.

For a ship exchange line, the Non Source fields are mandatory and the service order item information defaults. To enable entering the serial number in the Non Source field, execute the following steps:
• You need Non Source information for the Service Activities associated with the Service Types Exchange, Advance Exchange, and Replacement.

• The list of value for the Non Source fields is activated only when the Action Type is SHIP or WALK_IN_ISSUE and Action code is EXCHANGE for product transaction line.

• Lot Num: Displays the item Lot Number, for lot controlled items.

• Subinv:
  • Displays the subinventory into which the item is received for Return lines.
  • Displays the subinventory from which the item is shipped for Ship lines.

• Locator: If the item is Locator controlled, displays the Locator information.

• Return Reason: Specify a reason for returning the item from the list of values.
• Return by Date: Specifies the date within which the item you need to return the item.

• Contract: Specifies the default Contract Number that applies to the charge lines. For more information, see Contract and Price List Defaulting at Service Order Creation, page 4-7 and Coverage Window, page 2-43.

• PO Number: Specifies the Purchase Order Number corresponding to the order line in this field. This field value is not mandatory.

• (Addresses) Bill-To: Specifies the customer’s Bill-To address.

• (Addresses) Ship-To: Specifies the customer’s Ship-To address.

• Item Description: The description of the item.

• Picking Rule: The Picking rule for the ship line. This can be changed until the ship line is released.

• Add to Order: Displays the Order Management Order Number to which you want to add the Return/Ship line.

If set, the two profile options:

• CSD: Add to Order Num Within Service Order Default

• CSD: Add to Order Num Within Service Request Default provide default values for this field.

If both are set, the default value comes from CSD: Add to Order Num Within Service Order Default.

• No Charge (check box): You specify the default selection of this check box during implementation setup of the Service Activities and Billing Types. Selection of No Charge implies that you are not charging the customer for that transaction.

After the charge line has been interfaced to Oracle Order Management, and an Order Number appears in the charge line, you cannot update the No Charge check box.

**Note:** It is recommended that you do not use the Logistics tab to charge items for logistics-related transactions. Instead, enter charges on the Estimate tab.

---

**Spares to Depot Flow**

The multi-record area of the Logistics tab that is specific to internal order (not internal
party) refurbishments contains the following fields:

- **Process Trans (check box):** Selects the charge line for processing. When you select a line, you can select the "Automate order processing steps through" check box and one of its associated process stage options to set the parameters for processing the charge line (see Logistics Tab Check Box and Radio Buttons, page 2-12.)

- **Action Type:**
  In the Action Type field, select one of the following:
  - Move In option to receive items from a source organization, such as a Spares Management site, and move them into a depot.
  - Move Out option to ship items back to the source organization, such as a Spares Management site.

- **Action Code:** The Action Code field displays one of the following values:
  - Defective, for the Move In line.
  - Usable, for the Move Out line.

- **Order Num:** Displays the internal Sales Order Number that Oracle Order Management returns.

- **Line Num:** Displays the Line Number and the Shipment Line Number in the Oracle Order Management order that is specified in the Order Num field.

- **Status:** Displays the status of the active Order Management Order Number. The status can be Created, Entered, Booked, Released, Received, Shipped, or Issued.

- **Item:** Choose the Item Number from the list of values.

- **(Allocation Qty) Line:** Displays the number of units specified on the internal refurbishment Service Order. For serialized items, the value is always 1.

- **(Allocation Qty) Shipped:** Displays the number of units shipped
  - From the source organization for Move In lines.
  - From the depot for Move Out lines.

- **(Allocation Qty) Received:** Displays the number of units received
  - Into the depot for Move In lines.
  - The field is disabled for Move Out lines.
- Requisition Num: Displays the Requisition Number from Oracle Purchasing.
- Item Desc: Displays the description of the item.
- UOM: Displays the unit of measure of the item.
- Serial Num: Displays the Serial Number of the item for which service is requested, if the item is serialized.
- Lot Num: Displays the item Lot Number, for lot controlled items
- Locator: If the item is Locator controlled, displays the Locator information.
- Ship-To Address: Displays the address of the destination organization.
- Source Org: Displays the organization from which the item is moved.
- Source Subinv: Displays the subinventory from which the item is moved.
- Destination Org: Displays the organization to which the item is moved.
- Destination Subinv: Displays the subinventory to which the item is moved.
- Order Type: Type of order from Oracle Order Management.

**Logistics Tab Check Box and Radio Buttons**

The fields under the multi-record area of the Logistics tab are as follows:

- Automate order processing steps through (check box)
  Automates order processing steps through selected options for Service Order lines.
  If this check box is selected, you must also select one of the radio button options below this check box, to determine the default processing option for the Service Order line.

- Enter Order (radio button)
- Book Order (radio button)
- Pick Release (radio button)
- Ship Confirm (radio button)
  Some of these radio buttons are disabled depending on a variety of factors, including the Action Type of the line, the Status, whether the service item is serialized, and the type of serialization.
Comments

The following provides a list of the main conditions that affect the visibility and usage of the radio button options on the Logistics tab:

1. For Return lines, you can select only the Enter Order or the Book Order radio button.

2. For Ship lines, you can select any of the four radio button options.

3. For Move In and Move Out lines, the Enter Order and Book Order radio buttons are disabled.

4. For Move In and Move Out lines, the Pick Release radio button is always enabled if the Status is Booked.

5. For Move In and Move Out lines, the Ship Confirm radio button is disabled in either of the following cases:
   - When the serialized item is serialized at Sales Order Issue.
   - For partial shipments.

Logistics Tab Buttons and Actions Field

The buttons on the Logistics tab include the following:

- Refresh Logistics: Used to update the shipping or receiving information in the Depot Repair application. This only updates the information for the current line.

- Process: This button:
  - Works in conjunction with the Book, Pick and Ship radio buttons on the Logistics tab to book, pick and ship confirm and and submits the transaction lines, whose Process Trans check box is selected, to Order Management and returns a system-generated Order Number to the Order Num field.
  - Prevents ship replacement before faulty returns for an Exchange service type with the ship line Action Code as Exchange, Action Type as Ship Exchange, and the Automate order processing steps through is set as Pick or Ship. For such exchange service types, the system will check to ensure that if there is an RMA line linked to that service order, the RMA line must be received in full. If that RMA line is not received in full, a warning message displays to asking you to confirm or refuse ship replacements. Should you select Yes, processing will continue as normal. Should you select No, then the Process action is canceled.
Note: To prevent ship replacement before faulty returns you can select to grant or remove the Check RMA receipt before shipping the exchange function to a current responsibility/user.

The Actions field, accompanied by a Go button, contains a list of the operations available for processing logistics lines. Select an action and click Go to perform the corresponding operation. Depending on the Action Type and Status of the current logistics line, some options may be disabled, and you may not be allowed to perform some operations.

The list includes the following values:

- **Edit Transaction Details**: Displays the Transaction Details window. Depot users can edit the transaction details of the charges created for the customer item.
  
  This option is not available for Move In and Move Out lines.

- **View Line Status Details**: Displays the view-only Logistics Line Status Details window, that relates the Status for the current logistics line to the statuses in the corresponding Order Management, Shipping, and Receiving lines as maintained by the other, integrated Oracle applications.

- **Inspect/Move**: Used to perform inspection and moving of items to inventory during the receiving process.
  
  This option is only available for Return lines with a Status of Booked, and for Move In lines with a Status of Shipped.

- **Receive**: Displays the Oracle Receiving window to receive the item and place it in a subinventory.
  
  This option is only available for Return lines with a Status of Booked, and for Move In lines with a Status of Shipped.

- **Ship**: Displays the Order Management Shipping Transactions window to ship the item to the customer.
  
  This option is only available for Ship, Move In, and Move Out lines, when their Status is Released.

- **Transact Move Order**: Enables you to select a serial number for an item about to be shipped or moved.
  
  This option is only available for Ship, Move In, and Move Out lines, when their Status is Booked.

- **Cancel Order Line**: Allows you to cancel an order line, if the line processing has not gone beyond the booking stage.
This option is available for Return lines before the Status becomes Received, and for Ship lines before the Status becomes Released. It is also available for Move In and for Move Out lines.

**To cancel an order line:**

1. Navigate to the Depot Repair Workbench.

2. Create a Service Order. Alternatively, you can search and retrieve an existing service order. The Service Orders page opens.

3. Click the Logistics tab.

4. Select the line you want to cancel and select Cancel Order Line from the Actions list of values.

5. Click Go. The required order line is cancelled.

- Project Details: Displays the Project Details window. It enables you to select a different Project, Task ID, and Unit Number for a specific RMA line or ship line and override the value that defaults from the Details tab. The Project, Task, and Unit Number LOVs under Project Details have the same values and constraints as the LOVs on the Details tab.

   Once an RMA line, ship line or WIP job is created, the Project, Task, and Unit Number information in Order Management and WIP cannot be changed from the Depot Workbench. Project, Task, and Unit Number information are not passed to Estimate or Actuals lines.

- Internal Move Orders: Allows you to move items or parts from one warehouse or sub-inventory location to another. The Internal Move window wraps the capabilities provided by the Internal Requisition and Internal Sales Order modules provided by Purchasing and Order Management.

**Diagnostics Tab**

A diagnostic code signifies a specific condition or symptom found by a technician. A service code represents a discrete service or set of services offered by a service organization.

The Diagnostics tab has the following layout:

- **Diagnostic Codes Area**

  In the Diagnostic Codes area, you enter Diagnostic Codes and perform searches for solutions in Oracle Knowledge Management based on the selected Diagnostic Codes. You can also search for solutions without specifying any Diagnostic Codes.

- **Solutions Area**
In the Solutions area, you view matching potential solutions in Oracle Knowledge Management, determine which ones that you want to add as charge lines to the estimate or as Bills and Routings to the WIP Job or both, and indicate the usefulness of the solutions.

• Service Codes Area

In the Service Codes area, after you perform a solution search in Oracle Knowledge Management, linked solutions will be returned with associated Service Codes (if any exist). These associated Service Codes will be populated automatically in the Service Codes area, if the linked solution Status is Useful. When your implementor sets up Service Codes, your implementor associates material or labor costs or both to each Service Code. For more information on setting up Service Codes, see the Oracle Depot Repair Implementation Guide.

Note: If Oracle Knowledge Management is not installed or if the profile option CSD: Enable Knowledge Management is set to No, then Oracle Knowledge Management related elements will be disabled in the Diagnostics tab.

• Diagnostics Tab Button

The Search Solutions button enables you to search for solutions in Oracle Knowledge Management.

Diagnostic Codes Area

The Diagnostic Codes area contains the following elements:

• Select (check box): Selects the Diagnostic Code to be included as a parameter in the Oracle Knowledge Management search.

• Code: Choose the Diagnostic Code from the list of values. This list includes only those Diagnostic Codes whose domains include either the Item or the Item Category of the Service Order Item, as set up in Oracle Inventory.

For more information on setting up Diagnostic Codes, see the Oracle Depot Repair Implementation Guide.

• Name: This read-only field specifies the name of the chosen Diagnostic Code.

Diagnostics Codes Area Buttons

• Select All: Selects all the Diagnostic Codes in the Diagnostic Codes area.

• Deselect All: Deselects all the Diagnostic Codes in the Diagnostic Codes area.
Solutions Area

The Solutions area displays the solutions that have been given feedback in Oracle Knowledge Management and have been linked to a Service Order in Oracle Depot Repair.

The Solutions area contains the following elements:

- **Number**: The Oracle Knowledge Management Solution Number.
- **Title**: The Oracle Knowledge Management solution title.
- **Status**: The status indicates the usefulness of the solution. The values for Status correspond to the question posed in Oracle Knowledge Management: Is this solution useful in resolving your question or problem?
  - If the answer was Yes, the Status is Useful.
  - If the answer was Maybe, the Status is Possibly useful.
  - If the answer was No, and the value of the profile option Knowledge: Action for Negative Feedback Solution is Linked Solution as Not Solved, the Status is Not useful. If the profile option does not have the value Linked Solution as Not Solved, then the solution does not appear in the Solutions area.

You may change the Status value by clicking the Status field, selecting a different value from the list of values, and then clicking Update Status.

Solutions Area Buttons

- **Details**: Launches the window in Oracle Knowledge Management that displays the solution details.
- **Update Status**: In order to update the status of the solution, you must click the Status field that you want to change, select a new value from the list of values, then click Update Status.

**Note:** After you have brought back a solution from Oracle Knowledge Management, you can only change the status of the solution in Oracle Depot Repair. You cannot delete a solution from the Solutions area; however you can change the status of a solution to "Not useful".

Service Codes Area

The Service Codes area contains the following elements:
• Applicable (check box): Enables the Service Code and its associated elements to be included in the subsequent creation of estimate lines and WIP Jobs.

• Code: The Service Code that is associated to WIP and Task elements, such as Bills, Routings, and Task Templates, to assist in the creation of estimate lines and WIP Jobs.

This field is filled in either automatically or manually.

After performing a solution search in Oracle Knowledge Management, linked solutions which have associated Service Codes will populate automatically in the Service Codes area, if the linked solution Status is Useful.

You may choose Service Codes manually, whether you have any automatic entries or not.

For manual selection, select from the Code list of values. This list displays those Service Codes whose domain includes either the Item or the Item Category of the Service Order Item, as set up in Oracle Inventory.

For more information on setting up Service Codes, see the Oracle Depot Repair Implementation Guide.

• Name: This read-only field specifies the name of the selected Service Code.

• Solution Number: This read-only field specifies the identifying number of the Oracle Knowledge Management Solution associated with the chosen Service Code, if any.

Diagnostics Tab Button

The Diagnostics tab contains the following button that lies outside the three main tab areas:

• Search Solutions

When you click the Search Solutions button, you initiate a search for solutions in Oracle Knowledge Management.

Estimate Tab

The Estimate tab lists the materials and labor expected to be used during service and the cost of those materials and labor. Estimate lines can be created manually, generated from one or more service codes or pushed in from the technicians’s estimate on the Technician Portal. Additionally, materials and labor can be selected using the Select Materials screen launched from the Estimate tab.

Note: The Estimate tab can be hidden using the CSD:Enable Estimates
profile option. If the Estimate tab is not visible on the screen, check this profile option.

The Estimate tab performs the following functions:

- It uses Order Management Price Lists to determine the selling price for each item selected in the charge line.
- It obtains the Item Cost from the inventory Item Master list.
- It copies in charge lines associated with the applicable Service Codes selected in the Diagnostics tab.
- It calculates the profit margin for each of the charge lines as a percentage and actual dollar amount.
- It provides a summary of estimated charges, with subtotals for Material, Labor, and Expenses charges.
- It provides an estimate cost analysis, which lets you compare your estimated margins and profitability based on estimated costs and estimated charges.
- It enables a user to view estimate lines created and submitted by the technician from the Technician Portal. Users can update submitted estimated lines, reject the estimate, request the technician provide a new estimate, or submit the estimate to the customer for approval.

**Estimate Tab Header Fields**

The Estimate tab header fields and functionality include:

- **Status**: Select a status from the list of values. Estimate statuses in Oracle Depot Repair include:
  - Accepted: An estimate that the customer has approved.
  - Bid: An estimate that is awaiting customer approval.
  - Cancelled: A cancelled estimate.
  - Drafted: An estimate with information, but not ready to be revealed to the customer.
  - New: An estimate with no entered information.
  - Rejected: An estimate that the customer did not approve.
• Date: Select a date from the Calendar to enter the creation date of the Estimate.

• Reason: Select a Reason Code from the list of values that best describes the reason for rejecting or accepting the estimate. This field is enabled when the Status is Accepted or Rejected.

• Summary: Enter a free text work summary or problem description that best describes the service diagnosis or symptom of the broken or damaged item.

• Lead Time: Enter the number of units required to complete the item service.

• UOM: Select a unit of measure to describe the lead time units required.

• Descriptive Flex Field: Enter flexfield information associated with the estimate header. You cannot edit the DFF field after the Service Order status is changed to Closed.

**Estimate Tab Multi-Record Fields**

Fields and functionality in the Estimate multi-record area include:

• Source Type: Displays the source of the estimate charge line. Possible values are Manual, Service Code, Solution and WIP.

• Billing Category: Displays the categories of Material, Labor, or Expense.

• Item: Displays the selected Item Number from inventory

  **Note:** Items for estimates must be defined in the organization specified by the profile option Service: Inventory Validation Organization.

• Contract Number: Displays the Contract Number that is applicable to the estimate charge line.

• Price List: Displays the selected Order Management Price List.

• Pricing Attributes: Enter the appropriate Pricing Attribute flexfield information for the Price List.

• Qty: Displays the quantity if items for which service is being requested.

• UOM: Displays the unit of measure.

• Unit Price: Displays the item’s selling price from the selected Price List.
• Estimated Charge: Displays the charge after the contract entitlement has been applied.

• Override Charge (check box): Select this if you want to change the Estimated Charge field.

  **Note:** This field is only enabled if the profile option CSD: Allow Charge Override for Estimates is set to Yes.

  **Note:** When you change the Estimated Charge, any discount associated with the contract is ignored.

• No Charge (check box): Discounts the charge line amount to zero or no charge.

**Summary of Estimated Charges Fields**

The Summary of Estimated Charges area displays:

• Material: Displays the subtotal of the estimated material required.

• Labor: Displays the subtotal of the estimated labor required.

• Expenses: Displays the subtotal of the estimated expenses required.

• Total: Displays the combined subtotal of the material, labor, and expenses.

• Currency: Displays the currency for the Service Order, for example: US dollar.

  **Note:** A Service Order supports only a single currency. The system supports different currencies for different Service Orders within a Service Request.

**Estimate Tab Buttons**

Buttons on the Estimate tab include:

• Estimate Notes: Enter justification notes that describe the estimated transaction line.

• Costs: Launches the Estimated Costs versus Estimated Charges window.

• Line Details: Displays the detailed estimate worksheet.

• Add Lines from Diagnostics: Copies charge lines into the Estimates tab from the Service Codes marked as applicable in the Diagnostics tab, and their associated
Oracle Knowledge Management solutions, if not added already.

- **Save Estimate**: Records estimate header and charge line details.

- **Create Job**: Allows a user to create a job using the material and labor lines on the estimate. A number of key job data fields are defaulted from profile options to automate this process.

- **Select Materials**: Launches the Select Materials screen, in which a user can view the bill of all materials that are used in building or servicing the item. The bill of materials is displayed as a component hierarchy, and each level can be expanded or collapsed for ease of viewing. The user can choose which materials and which quantity of each material to add to the estimate. Users can also select a routing to indicate the labor required for the estimate.

---

**About Estimate Charge Line Details Window**

On the Estimate Charge Line Details window, you can edit details of charge lines that you had entered on the Estimate tab.

**Note**: You cannot add new charge lines or delete existing charge lines using the Estimate Charge Line Details window. To add a new charge line or delete an existing charge line, return to the Estimate tab.

In the multi-record area, the Estimate Charge Line Details window displays, as read-only fields, most of the charge line fields that appear in the Estimate Multi-Record Fields area of the Estimate tab, namely:

- **Source Type**
- **Billing Category**
- **Item**
- **Contract Number**
- **Price List**
- **Qty**
- **UOM**
- **Unit Price**
- **Estimated Charge**
- **Override Charge (check box)**
No Charge (check box)

When you select one of the charge lines in the multi-record area, the Estimate Line Details region shows more details of the selected charge line.

Of all the fields that appear in the Estimate Line Details region, you can edit or enter the following field values.

- Billing Category
- Item
- Resource: Displays the resource type that was selected from the item master. This field is enabled when Billing Category = Labor.
- PO Num: Enter the customer or vendor Purchase Order Number to validate the acceptance of the estimate or customer’s approval to proceed with the pending service. This field value is not mandatory.
- Price List
- Pricing Attributes
- Quantity
- UOM
- Quantity
- (Contract Information) Number
- Estimated Charge: You can edit this field if you set the check box Override Charge.
- Override Charge (check box): To be able to change this field, the profile option CSD: Allow Charge Override for Estimates must be set to Yes.

Note: When you change the Estimated Charge, any discount associated with the contract is ignored.

- No Charge (check box): If No Charge is checked, then Override Charge is disabled.

When you update these field values, the application automatically updates any associated fields.

The Number field in the Contract Information area of the Estimate Line Details region displays the default Service Order contract. This contract could be the best contract, the contract associated at the Service Request level, or the contract selected manually from the Coverage window that you can access using the menu option path Tools >
Coverage.

For more information, see Contract and Price List Defaulting at Service Order Creation, page 4-7 and Coverage Window, page 4-5.

The default Service Order contract populates the Number field in the Contract Information area for each estimate charge line. You can override this default value at the estimate line level by entering a different contract by selecting from the list of values.

Other fields include:

- **Revision**: Displays the item Revision Number if the item is revision-controlled.
- **Unit Price**: Displays the unit price of the item.
- **Extended Price**: Multiplies Quantity by Unit Price to display the extended price.
- **Item Cost**: Displays the inventory cost for the selected item.
- **Extended Cost**: Multiplies Quantity by Item Cost to display the extended cost.
- **(Contract Information) Description**: Displays the Contract name for the selected Contract Number.
- **Discount**: Displays the discounted charges by applying the selected contract.
- **Profit Margin**: Displays the profit margin as a dollar value, for example, Profit Margin = $128.45.
- **Profit Margin%**: Displays the profit margin as a percentage, for example, Profit Margin% = 30%.
- **Descriptive Flex Field**: Displays the flexfield information associated with the estimate line. You cannot edit the DFF field after the Service Order status is changed to Closed.

### Estimate Charge Line Details Check Boxes

Check boxes in the Estimate Line Details region include:

- **Override Charge**: Select this if you want to edit the charges in the Estimated Charge field.

  **Note**: To be able to change this field, you must set the value of the profile option CSD: Allow Charge Override for Estimates to Yes.

- **No Charge**: Discounts the charge line amount to zero or no charge.
Estimate Charge Line Details Buttons

Buttons on the Estimate Charge Line Details window include:

- Select Material: Enables the selection of materials.
- Save: Saves the estimate charge lines.
- Close: Closes the Estimate Charge Lines Details window.

Estimates Generated in the Technician Portal

Technicians generate estimates based on jobs created in the Technician Portal using the Generate Estimate button in the Technician Portal header region. This automatically creates an estimate on the Depot Workbench Estimate tab. There is an automatic change to the service order status when an estimate is generated from the Technician Portal.

Once the estimate is generated in the Technician Portal, customer service representatives can:

- View the generated estimate in the Depot Workbench Estimate tab.
- Add and remove lines to the generated estimate.
- Select or remove service contracts, capture pricing attributes and apply manual charge overrides to the generated estimate.
- Change the Estimate Status.

Note: When the estimate status is changed, the system triggers a specified workflow and/or custom code.


Jobs Tab

Access the Jobs tab from the Depot Repair Workbench. The Jobs tab displays details of WIP Jobs pertinent to the Service Order.

The Jobs tab displays:

- Job Name: The system shows the Job name after you have created the Job.
- Item: Displays the item for which the Job has been created.
- Organization: Displays the name of the service organization.
• Created: Displays the job quantity created.

• Completed: Displays the job quantity completed.

• (Allocated) Created: If the Job is created for more than one Service Order, displays the quantity created for this Service Order.

  **Note:** Jobs can be created for more than one service order using the Bulk Create Jobs form.

• (Allocated) Completed: If the Job is created for more than one Service Order, displays the quantity completed for this Service Order.

• Job Status: Displays the current status of the WIP Job.

• (Routing) Reference: Refers to the routing used for the Job.

  You create Routings in BOM. WIP uses Routings to assist the service process. Each routing contains the operations and resource requirements for the Job.

• (Routing) Alternate: Refers to the alternate if an alternate routing was used for the Job.

• Source Type: Displays Service Code or Manual, depending on how the Job was created.

• Source Name: If Source Type is Service Code, the Source Name is the name of the Service Code. If Source Type is Manual, the Source Name has no value.

**Buttons and Actions field**

Buttons on the Jobs tab include:

• Refresh Job: Updates the Job information in Oracle Depot Repair.

• Create Job: Launches the Submit Jobs window.

  For more information, see Submit Jobs Window, page 2-31.

  The Create Job button is disabled in the following situations:

  • The profile option CSD: Allow Creating WIP Job Without RMA is set to No and nothing has yet been received against the Service Order.

  • Estimate approval is required, and the estimate has not yet been approved.

The layout of the rest of the foot of the Jobs tab depends on the value of the profile option CSD: Service Execution Mode.
If the value is WIP, the Jobs tab contains an Actions field and a Go button. The Actions list of values contains the following entries, which trigger the corresponding operation when you click the Go button:

- **View Job**: Displays the WIP View Discrete Jobs window in a read-only mode to show details of the Job.
- **Execute Move**: Displays the WIP Move Transactions window, which enables you to move the service item through the operations.
- **Transact Materials**: Displays the Oracle Inventory Material Transactions window, which enables you to issue the broken or damaged items and needed material for the WIP Job.
- **Transact Resources**: Displays the Resources window, which enables you to transact resources to the WIP Job.
- **Complete Job**: Displays the Oracle WIP Completion Transactions window, which enables you to complete the WIP Job.

If the value is Depot Repair, the Jobs tab contains the following button:

- **Execute Job**: Launches the Service Order page, in the Service Execution tab. See: Submit Jobs Window

On the Submit Jobs window, you can submit one or more WIP Jobs for a given Service Order.

The Submit Jobs window includes:

- **Job Parameters Area Fields**, page 2-31
- **Service Order Area Fields**, page 2-31
- **Service Codes, Bills and Routings Area Fields**, page 2-31
- **Buttons**, page 2-31

### Submit Jobs Window

On the Submit Jobs window, you can submit one or more WIP Jobs for a given Service Order.

The Submit Jobs window includes:

- **Job Parameters Area Fields**, page 2-31
- **Service Order Area Fields**, page 2-31
- **Service Codes, Bills and Routings Area Fields**, page 2-31
- **Buttons**, page 2-31

### Job Parameters Area Fields

The Job Parameters area of the Submit Jobs window includes the following fields:

- **Item**: Defaults to the Service Order Item, but you can change the item.
- **Description**
- **Job Name Prefix**
If the value of the profile option CSD: Use CSD as Job Name Prefix is set to Yes, the value in this field appears as CSD, and cannot be updated.

If the value of the profile option CSD: Use CSD as Job Name Prefix is set to No, the value in this field defaults to the value of the profile option CSD: Default Job Name Prefix, and can be updated.

- (Quantity) Service Order: Displays the number of item units on the Service Order.
- (Quantity) Received: Displays the number of item units received on the Service Order.

The other fields in the Job Parameters area include:

- (Quantity) Submit: Enter the number of item units that you want to submit for the Job. This field is mandatory.
  (Quantity) Submit must be greater than 0.
  The default for the (Quantity) Submit depends on the value of the profile option CSD: Allow Creating WIP Job Without RMA, as follows:
  - If the value is Yes, (Quantity) Submit defaults to the Service Order quantity.
  - If the value is No, (Quantity) Submit defaults to the received quantity.
    If the Job Item is the same as the Service Order Item, (Quantity) Submit cannot exceed the default value.
    If the Job Item is different from the Service Order Item, (Quantity) Submit can exceed the default value.

- Job Status: The job status with which you submit a Job to WIP. Possible values are Released and Unreleased. This field is mandatory.
  This defaults to the value of the profile option CSD: Default Job Status.
  **Note:** For a WIP Job to begin or for materials to be issued against the job, the Job Status must be Released.

- Accounting Class: The valuation and variance accounts associated with the accounting classes determine which accounts are charged and when. You can select any active asset non-standard or non-standard expense class. This field is mandatory.

- Start Date: The system date defaults as Start Date.

- Complete Date: Select the completion date and time for the WIP Job. Defaults to the start date. This field is mandatory.
For more information on WIP-related fields, such as Accounting Class, see the Oracle WIP User's Guide.

**Service Order Area Fields**

The Service Order area contains the following read-only fields, related to the Service Order:

- Customer
- Number: The Service Order Number.
- Type: The Service Type of the Service Order.
- Status: The status of the Service Order.
- Promise Date

**Service Codes, Bills and Routings Area Fields**

The Service Codes, Bills and Routings area is the region where you select which method you want to use to create the Job, as indicated by the radio buttons at the top of the area:

- Use Service Codes
- Select Bills and Routings
- Do not Specify Bills and Routings

Below the radio buttons, there are two multi-record areas. The availability and use of these multi-record areas depends on which radio button option you select.

*Note:* You cannot select the Use Service Codes button unless there are Service Codes associated in the Diagnostics tab.

If there are any Service Codes associated to the Service Order, the Use Service Codes radio button option will be selected by default in the Submit Jobs window.

In the Submit Jobs window, you must perform the following sequence of steps:

1. Select one of the radio buttons.
2. Enter information in one of the multi-record areas, if the area is enabled.
3. Click Submit Jobs.
Use Service Codes

If you select the Use Service Codes radio button, then the associated Service Codes and Bills and Routings will be displayed in the multi-record areas, and cannot be updated.

If you deselect the Use Service Codes radio button, the Service Code and Bill and Routing information is cleared.

For details of selecting Service Codes, see Use the Diagnostics Tab and the Knowledge Base, page 4-36.

For details of setting up Service Codes, see the Oracle Depot Repair Implementation Guide.

Select Bills and Routings

If you select the Select Bills and Routings radio button, the first multi-record area is not applicable, but the second multi-record area is available for you to fill in manually, and you must enter at least one bill or routing.

The fields in the second multi-record area are as follows:
- Bills (Reference)
- Bills (Description)
- Bills (Alternate)
- Routing (Reference)
- Routing (Description)
- Routing (Alternate)

These fields refer to Bills and Routings that are set up in Oracle Inventory and Oracle Bills of Material. For more information, refer to the User’s Guides for these applications.

Do not Specify Bills and Routings

If you select the Do not Specify Bills and Routings radio button, neither of the multi-record areas is applicable. With this option selected, when you submit a Job, it is submitted without any Bill or Routing information for creation in WIP.

Buttons

The Submit Jobs buttons include:
- Submit Jobs: Submits the Job to WIP for creation.
• Close: Closes the Submit Jobs window.

**Note:** If there are any errors during the process of submitting a WIP Job, such as an inactive Service Code, they will appear in an Errors window.

### Tasks Tab

You can access the Tasks tab from the Depot Repair Workbench. On the Tasks tab, you can create, assign, plan and execute the tasks needed to assist an item service. This tab is enabled only if the Service Type chosen has been defined during implementation to use the service mode of Task.

The tasks appear in the Tasks table. The fields on the Tasks tab dashboard area include:

- **Number:** Displays the system-assigned Task Number.
- **Name:** Displays the task name.
- **Description:** Displays the task description.
- **Status:** Displays the current task status.
- **Priority:** Displays the task priority, for example: Critical, High, Medium, or Low.
- **Actual Start:** Displays the task start date.
- **Actual End:** Displays the task end or completion date.
- **Owner:** Displays the task owner's name.
- **Applicable QA Plans:** Indicates whether any quality collection plans are associated with the task.

The fields on the Tasks tab include:

- **Number:** Displays the system-assigned Task Number.
- **Type:** Displays the depot task type, for example: Callback, Diagnostic, General, Service, or Upgrade.
- **Name:** Displays the task name.
- **Status:** Displays the current task status selected from the list of values.
- **Priority:** Displays the task priority selected from the list of values, for example: Critical, High, Medium, or Low.
• Description: A free text field to enter a detailed description of the displayed task.

• Publish (check box): If you wish to display the task for the customer to see on their Oracle iSupport Web portal, then select the Publish check box.

• Private (check box): Select the Private check box if this is a personal task and you do not want other employees to view it. Any resource associated with the task, for example an assignee, will have access to the task whether it is marked as private or not.

• Owner Type: Displays the owner type selected from the list of values, for example: Employee, Group, or Team Resource.

• Owner: Displays the task owner’s name selected from the list of values.

• Assignee Type: Displays the assignee type selected from Assignment Manager.

• Assignee: Displays the assignee selected from Assignment Manager.

The fields in the Dates section of the Tasks tab include:

• Planned Start: Displays planned start date.

• Planned End: Displays planned end date.

• Scheduled Start: Displays scheduled start date.

• Scheduled End: Displays scheduled end date.

• Actual Start: Displays actual start date.

• Actual End: Displays actual end date.

The fields that appear in the Effort section of the Tasks tab include:

• Estimate Qty: Displays estimated number of units to complete the task.

• Estimate UOM: Displays unit of measure used to describe the estimated effort.

• Actual Qty: Displays actual number of units used to complete the task.

• Actual UOM: Displays unit of measure used to describe the actual effort.

**Tasks Tab Buttons**

Buttons on the Tasks tab include:

• Assignment Manager icon (next to the Assignee field): Displays the Assignment Manager window.
- Add Tasks from Diagnostics: Adds tasks associated with Task Template Groups associated with the Service Codes marked as applicable in the Diagnostics tab.

- Use Template: Displays the Create Tasks from Template Group window to permit creation of new tasks from previously defined templates.

- Launch Workflow: Starts the task workflow to reserve the designated resources and notify the task owner of task creation.

- Debrief: Displays the Debrief Report window to capture the Material, Labor, and Expense billing transactions used to complete the task.

- More: Displays the windows to display and capture additional task details including:
  - Resources: Defines and displays resource requirements, assignments, and scheduling information.
  - Dependencies: Specifies ordering and prioritization of multiple tasks.
  - References: Permits linking of task to different documents or to other pertinent background information.
  - Dates: Identifies more dates in addition to the planned dates.
  - Contacts: Enables creation and management of multiple contacts who are assigned to a task. The system obtains contact information from customer information.
  - Recurrences: Enables the scheduling of tasks to occur automatically.
  - Others: Identifies additional information about the task.
  - Audit: Displays an audit history log with the changed dates and the user responsibility that initiated the changes.

Note: Tasks functionality and secondary screen is sub-classed from the JTF Tasks and Field Service Debrief modules. Please see the User Guides for JTF Tasks and Field Service for more information on Assignment Manager, Resource Scheduler, Debrief, Task Templates and Task Workflow.

**Actuals Tab**

The Actuals tab enables a user to create invoices for charges incurred for services provided. Charges are submitted through Order Management to Oracle Accounts
Receivable. Charges can be billed directly to the customer logging the service request, to a related customer party or site or to a third party. Charges can be negative in cases where customers or third parties receive a credit. Charges or credits can be created for multiple different parties, each of which will be invoiced separately.

The Actuals tab contains the following elements:

- Default to Bill area
- The Summary of Actual Charges area
- A multi-record area consisting of the charge line fields
- Buttons to allow you to perform the following operations:
  - Specify from where to add lines to the Actuals tab
  - View further details of the charge lines
  - Select and deselect all charge lines
  - Book selected charge lines

Depending on how you choose to add lines to the multi-record area, certain fields and buttons may be enabled or disabled. See the Comments at the end of this section, page 2-39.

**Default to Bill area**

Allows you to capture different values for customer, account and address details to charge the invoice to. These values are only used if entered before the Actual lines are created. A user can invoice separate parties by entering one party as customer, creating actual lines for that party, then changing the party and creating additional charge lines. This area consists of the following fields:

- Account
- Party
- Address

**Summary of Actual Charges Area**

The Summary of Actual Charges area displays a summary of the information which appears in greater detail in the multi-record area.

The Summary of Actual Charges area consists of the following read-only fields:

- Material: Total charge of all the charge lines with the Material billing category.
• Labor: Total charge of all the charge lines with the Labor billing category.
• Expenses: Total charge of all the charge lines with the Expenses billing category.
• Total: Total charge of all the charge lines.
• Currency: Currency of all the charges.

**Actuals Tab Multi-Record Area**

The multi-record area in the Actuals tab is populated either with data copied from other Depot Repair Workbench tabs, or manually.

The multi-record area of the Actuals tab includes the following fields:

• Select (check box): Selects the charge line for booking.

• Source Type: Describes the source of the actual charge line.

  The available values are:
  • WIP, Estimate, and Task, for lines copied from other Oracle Depot Repair tabs.
  • Manual, if you enter the actual charge line manually in this window. This value appears when you start to enter a new charge line.

  **Note:** The fields marked with an asterisk (*) below are available for you to enter data if the Source Type field is Estimate or Manual.

• Order Number: Displays the Order Number returned from Oracle Order Management, after you click Book Selected.
• Billing Category*
• Item*
• Serial Num*: This field is enabled for items that are serialized at receipt.
• PO Number*
• Contract Number*
• Price List*
• Pricing Attributes*
• Qty*
• UOM*
• Unit Price
• Charge*: You can enter a Charge if you first set the check box Override Charge and if the value of the profile option CSD: Allow Charge Override for Actuals is set to Yes.

See: Comments at the end of this section.

• Override Charge* (check box)
• No Charge* (check box)

**Actuals Tab Button Area**

The button area contains mainly buttons, and one data field, as follows:

Select All button: Selects all the eligible charge lines in the multi-record area.

Deselect All button: Deselects all the eligible charge lines in the multi-record area.

Book Selected button: Books the selected charge lines in the multi-record area. This button is visible only if you have the User Function Name Service Orders: Submit Charges associated with your responsibility.

Line Details button: Shows details of the actual charge line.

Source field: Source of charge lines to copy into the Actuals window.

• For WIP mode services, the options are WIP and Estimate.

• For Task mode services, the options are Task and Estimate.

Add button: Click this to copy the charge lines into the Actuals tab from the source you selected in the Source field.

**Comments**

1. The Book Selected button and the Select check box are enabled for all sources.

2. For lines whose Source Type is WIP, all the fields in the multi-record area except Override Charge (if CSD: Allow Charge Override for Actuals is set to Yes) and No Charge are disabled. If you check Override Charge, you can enter a new Charge.

3. For lines whose Source Type is Task, the Select check box is checked, by default, and cannot be deselected. All the other fields in the multi-record area are disabled.

4. For lines whose Source Type is Task, only Book Selected and Line Details are available to you, as task lines have already been flagged for interfacing to Oracle.
Order Management.

Drill into Order Management

The Sales Order Number on the Logistics and Actuals tabs can optionally be hyperlinked to allow you to click on it to launch the Sales Order window in editable mode and in context of the clicked Order Number. You can enter information such as credit card number, ship method and payment details, save the order, close the Sales Order screen and return to the Depot Workbench without ever leaving.

You can navigate to the Sales Order window from the Logistics tab and the Actuals tab.

• From the Logistics tab: Select a Return Line, and book the order. A number appears in the Order Number field. Click the Actions list and select the Update Sales Orders option. This launches the Sales Order window. You can also launch the Sales Order window by clicking on the hyperlinked Sales Order number.

• From Actuals tab: Select the individual charge lines or click Select All to book all the charge lines and click the Book Selected button. A number appears in the Order Number field. Click the Order Number to launch the Sales Order window. You can also launch the Sales Order window by clicking on the hyperlinked Sales Order number.

Note: Set the profile option, CSD: Enable Sales Orders Hyperlink, to Yes. This profile enables the Sales order hyperlink on the Logistics tab and Actuals tab.

Depot Repair Workbench Tools Menu

The Tools Menu of the Depot Repair Workbench provides the following facilities:

• Quick Menu: Launches the Quick Menu. The Quick Menu provides a user with quick links to other Service family applications, opening up the selected application in context of the service request number on the Depot Workbench.

See: Oracle TeleService Implementation and User Guide for more information on using the Quick Menu

• Freeze Estimate: Freezes the estimate and prevents updates.

Note: Frozen estimates cannot be unfrozen, so only choose this option after the estimating process is completely finished and no more changes can take place.

• Print Estimate: Submits the estimate for printing.
• Profile: To view an existing customer profile, select Profile from the Tools menu. For proper setup of the Profile window with customizable options, see the `Oracle TeleService Implementation and User Guide`.

• Capture Serial Numbers: For details, see Capture Serial Numbers.

• Find Customer: For details, see Find Customer Window

• Send Message: Choose Send Message from the Tools menu to send a workflow notification message, and have that message link to the Service Order selected in the Depot Repair Workbench at the time the message was sent. For more information, see the `Oracle TeleService Implementation and User Guide`.

• View Message History: Choose View Message History from the Tools menu to display the Message History window. For more information, see the `Oracle TeleService Implementation and User Guide`.

• Coverage: For details, see Coverage Window and View Coverage Information, page 4-5.

• Split Service Order: Allows the user to split a Service Order. For more information, see Split a Service Order, page 4-70.

**Capture Serial Numbers**

The Capture Serial Numbers window enables you to quickly create service orders for multiple quantity of the same serialized item. You can create a single Draft service order for the serialized item with a quantity greater than one, rather than creating a service order for each item individually. When you create a service order for a serialized item with quantity greater than one, it is automatically saved with a service order status of Draft. Once that service order is saved, the Capture Serial Numbers menu item is enabled. Select the Capture Serial Numbers menu item to launch the Capture Serial Numbers window. Use this window to capture the serial numbers for each item.
Click the Process button to create a new service order for each serial number entered. The quantity of items on the Draft service order decrements for each new service order created. If you capture the entire quantity of serial numbers, the Draft service order disappears. However, you can enter a partial quantity of serial numbers and only process those which have been entered, leaving the remaining quantity of serialized items to be processed later.

Serial number region

The fields enable you to enter the desired serial numbers for creating the service orders. Count field displays the total number of serial numbers you enter. If the serial number is not currently in the installed base, then the system adds the item to the installed base for you.

Buttons

Buttons in the Capture Serial Numbers window include:

- View Errors: Button is disabled. This button enables if any processing errors occur, and allows you to determine the reasons of failure.

- Save: Saves the serial numbers you enter without processing them.

- Process: Creates a new service order for each serial number entered and the quantity of items on the Draft service order decrements for each new service order created. It also adds any new serial numbers to the installed base for the customer on the SR.
• Close: Closes the Capture Serial Numbers window

Find Customer Window

The Find Customer Window enables you to find customers based on an item in Oracle Installed Base. This feature is available when you create the Service Request for the Service Order.

The header of the Find Customer Window enables you to find customers. Enter the relevant search criteria in the following fields:

- **Item**: Select the item from the list of values.
- **Instance**: Select the appropriate instance from the list of values.
- **Revision**: This field is updatable only for items that are revision controlled. If the item is revision controlled, you can select one of the defined revisions in the list of values.
- **Serial Number**: This field is enabled when the item is defined as serial controlled in the Inventory Item Master.

The Results region displays the names of the customers based on the search criteria provided in the header.

Coverage Window

The Coverage window displays the service contract and warranty entitlements for the item on the service order. Service contract entitlements only exist for items tracked in
the Installed Base. When you select the Coverage option from the Tools menu in the Depot Repair Workbench, active entitlements or all entitlements (based on option button selection) applicable to the selected Service Order appear.

For more information see: View Coverage Information, page 4-5.

Option Buttons

Option buttons in the Coverage window include:

- View Active Contracts: Displays the active entitlements that are applicable to the selected Service Order.

- View All Contracts: Displays all the entitlements that are applicable to the selected Service Order, including expired ones. This is a useful tool for service agents to inform customers about contract coverage expiration and service contract renewal opportunities to reinstate item coverage.

Multi-Record Area Region

The fields that appear in the multi-record area region include:

- Default (check box): Permits the service agent to select a contract coverage to override the coverage selected at the Service Request level. Select the Default check box corresponding to the relevant contract coverage, and click Apply to cause this change. The system defaults this coverage to all charge lines associated with the selected Service Order. However, you cannot apply this selected default contract to the Task Debrief charge lines. The selected contract at the Service Request level applies by default to these debriefed charge lines.

- Contract Num: The item warranty or Service Contract Number.

- Service: The contract name, Warranty, PM, Support Only, and Full Service.

- Description: High-level description of the contract offering.

- Coverage: The service provider’s contract coverage window in days and hours.

- Start Date: The warranty or contract’s effective start date.

- End Date: The warranty or contract’s effective end date.

Buttons

Buttons in the Coverage window include:

- View Coverage: Displays the Service Contracts Coverage window that shows details of the selected coverage. You can access this window also by double-clicking the Coverage (field) value of an entitlement. For more information, refer to the
online help available from the Service Contracts Coverage window.

- Close: Closes the Coverage window.

- Apply: Select the contract entitlement that you want to use as default by using the Default check box, and click Apply. This selection overrides the existing default contract. This selected contract becomes the default contract for the Service Order. However, note that this contract cannot be applied to the Task Debrief charge lines. Instead, the contract selected at the Service Request level applies by default to the Debrief charge lines.

**Depot Repair Workbench Data Menu**

The Data Menu of the Depot Repair Workbench provides the following facilities:

- Service History Window, page 2-48
- Activity Window, page 2-48
- Reserve/Unreserve Serial Number, page 2-50

**Service History Window**

The Service History window displays all the Service Requests and Service Orders that have been logged against an Installed Base item.

**Note:** An item must be Installed Base trackable in order for this functionality to work.

A service agent can view a document by clicking the Service Order or Service Request Number links to display the historical document. This functionality permits the service provider to review the service history and service records spread over the lifetime of the Installed Base item.

The Service History window displays the following information in the multi-record areas:

**Service Requests Fields**

Service Requests fields include:

- Number: Service Request Number.

- Date Opened: Displays the creation date of the Service Request document.

- Date Closed: Displays the closed date of the Service Request document.
- Type: Displays the Service Request type.
- Status: Displays the current Service Request status.
- Severity: Displays the severity of the Service Request or Service Order that the owner set.
- Urgency: Displays the customer’s urgency being weighted on the Service Request.

**Service Orders Fields**

Service Orders fields include:
- Number: Service Order Number.
- Date Opened: Displays the creation date of the Service Order document.
- Date Closed: Displays the closed date of the Service Order document.
- Type: Displays the Service Request type.
- Status: Displays the current Service Order status.
- Service Request: Displays the Service Request Number that is linked to the Service Order.

**Buttons**

Buttons in the Service History window include:
- Close: Closes the Service History window.

**Activity Window**

The Activity window provides the depot agent with information about the major events and activities that occurred for a Service Order. The agent can view the latest status with each event date and time stamped at the completion of a process step.

The fields that appear in the upper section of the Activity window include:
- Qty Received: RMA quantity that the depot received.
- Qty Submitted to WIP: Service Order quantity submitted to the Job.
- Qty Completed in WIP: Job quantity completed in WIP.

**Note:** The Qty Submitted to WIP and Qty Completed in WIP fields...
appear only for services being processed in WIP service mode.

- Qty Shipped: Service Order quantity shipped against the Sales Order.

The fields that appear in the lower multi-record area include:
- Event: The Service Order event that the depot completed.
- Date: The completion date or time stamp of the activity.
- Details: Specific information about a particular activity.

Buttons

Buttons in the Activity window include:
- Close: Closes the Activity window.

Reserve/Unreserve Serial Number

Reserve Serial Number feature enables you to place a reservation for the serial number of the serviced item and perform pick release using the serial number reserved.

Navigate to the Reserve Serial Number option from the Data menu to perform serial number reservation manually. To un-reserve serial number manually, navigate to the Unreserve Serial Number option from the Data menu.

**Note:** The subinventory on the ship line is required for reserve serial number and un-reserve serial number.

Find Service Orders for Job Submission Window

The Find Service Orders for Job Submission window permits you to search for Service Orders against which you want to submit Jobs. Access the Find Service Orders for Job Submission window by double-clicking Submit Jobs under Depot Repair in the Navigator window. Double-clicking Submit Jobs displays the Organizations window, where you choose the organization that is servicing the item or where the item is being serviced.

In the Find Service Orders for Job Submission window, use the following fields to specify your search criteria or view the search results:
- Service Request Area Fields, page 2-50
- Service Order Area Fields, page 2-50
Service Request Area Fields

You can enter one or more Service Request search parameters in the following fields:

- **Request Num**: Service Request Number.
- **Customer**: Name of the person or organization.
- **Account**: Customer account.
- **Severity**: Service Request severity.
- **Urgency**: Service Request urgency.

Service Order Area Fields

You can enter one or more Service Order search parameters in the following fields:
• SO Num: Service Order Number.
• Item: The Service Order Item.
• Description: The description of the Service Order Item.
• Serial Num: The Serial Number of the Service Order Item.
• RMA/Sales Order Num: The RMA/Sales Order Number.
• Service Type: The Service Type of the Service Order.
• Supercession Item: The Item that has been upgraded or changed and used to replace another Item.
  For more information about superessions, see the Oracle Field Service User Guide.
• Description: The description of the supersession item.
• Internal Order Num: The internal Order Number for a refurbishment generated from Spares Management.
• Internal Requisition Num: The internal Requisition Number for a requisition generated from Oracle Purchasing.
• Create Date: Creation date of the Service Order. Optionally, start and end dates for a range of creation dates.
• Promise Date: The Promise date of the Service Order. Optionally start and end dates for a range of promise dates.
• Create Date: Creation date of the Service Order. You can enter a creation date range if you want to perform a search based on this attribute.

Search Buttons

The Search buttons, below the Service Order area, include:
• Find: Searches and returns results based on your entered search criteria.
• Clear: Clears the fields in which you have entered values to specify your search criteria. You can enter new values to perform a new search.

Results Area Fields

The fields in results area are almost completely the same as the search parameter fields in the Service Request and Service Order areas. The main result fields, that appear in the non-scrolling area, are:
• Request Num: The Service Request Number for the Service Order.

• SO Number: The Service Order Number.

• Item: The Service Order Item.

**General Buttons**

The General buttons, in and below the Results area, include:

• Select All: Selects all the Service Orders in the Results area.

• Deselect All: Deselects all the Service Orders in the Results area.

**Note:** To select multiple, non-contiguous rows from among the Search Results, press and hold the Control key, and click each row.

**Note:** To select a range of rows from among the Search Results, click the first row of the range, then press and hold the Shift key, and click the final row of the range.

• OK: Displays the Submit Jobs for Service Orders window for the selected Service Orders.

• Cancel: Closes the Find Service Orders for Job Submission window.

**Submit Jobs for Service Orders Window**

On the Submit Jobs for Service Orders window, you can submit a single WIP Job for single or multiple Service Orders to WIP.

The Submit Jobs for Service Orders window includes:

• Job Parameters Area Fields, page 2-53

• Service Order Details Tab, page 2-53

• Bills and Routings Tab, page 2-53

• Buttons, page 2-53
Jobs Parameters Area Fields

The fields in the Jobs Parameters area include:

- **Item**: The item Number of the Job. This field is mandatory.
- **Description**: The item description.
- **Job Name Prefix**: The job name prefix for the Job.
  - If the value of the profile option CSD: Use CSD as Job Name Prefix is set to Yes, the value in this field appears as CSD, and cannot be updated.
  - If the value of CSD: Use CSD as Job Name Prefix is set to No, the value in this field defaults to the value of the profile option CSD: Default Job Name Prefix, and can be updated.
- **Job Status**: The job status with which you want to submit a Job to WIP. Possible values are Released and Unreleased. This field is mandatory.
  - This defaults to the value of the profile option CSD: Default Job Status.

  **Note**: For a WIP Job to begin or for materials to be issued against the job, the Job Status must be Released.

- **Accounting Class**: The valuation and variance accounts associated with the accounting classes determine which accounts are charged and when. You can select any active asset non-standard or non-standard expense class. This field is
mandatory.

- **Start Date**: The system date defaults as Start Date.

- **Complete Date**: Select the completion date and time for the WIP Job. Defaults to the start date. This field is mandatory.

- **Total Submit Qty (read-only)**: Shows the total of the (Quantity) Submit values in the lines of the Service Order Details tab. This is the number of items that you want to submit to WIP.

  This is the same as the Released quantity for a Service Order line when you selected only one Service Order for submission to WIP. When you are creating a Job for multiple Service Orders, this field value is the sum of the quantities for all the Service Orders that you are submitting.

For more information on WIP-related fields, such as Accounting Class, see the Oracle WIP User's Guide.

### Service Order Details Tab

The Service Order line or lines that you selected from among the search results in the Find Service Orders for Job Submission window populate the Service Order Details tab. The fields on the Service Order Details tab include:

- **(Quantity) Service Order (read-only)**: Shows the item quantity in a Service Order.

- **(Quantity) Received (read-only)**: Shows the quantity of items that you received against a Service Order.

- **(Quantity) Submit**: Quantity of items in a Service Order that you want to submit to WIP for service.

### Bills and Routings Tab

You can optionally specify Bills and Routings to be used on the Job.

The fields on the Bills and Routings tab include two radio buttons:

- **Select Bills and Routings**

- **Do not Specify Bills and Routings**

The multi-record area, which is enabled only if you select the Select Bills and Routings radio button, consists of the following fields:

- **(Bill) Reference**

- **(Bill) Description**
• (Bill) Alternate
• (Routing) Reference
• (Routing) Description
• (Routing) Alternate

Buttons

The buttons include:
• Submit Jobs: Submits the Job or jobs to WIP for creation.
• Close: Closes the Submit Jobs for Service Orders window.

Define Triggers for Service Bulletins

Depot Repair provides an interface to the service manager enabling him to trigger
notifications, escalations, and/or workflows based on key business events in the service
shop. The service manager can drill down to the details of critical activities to speed up
the resolution of issues, thereby increasing customer satisfaction.

Key business events include:
• Past Due Repairs
• Overdue Customer Returns or Loaners
• Product Returned Multiple Times
• Products Under Recall
• Products Requiring WEEE, RoHS, or other Regulatory Compliance
• Overdue Returns from Third Parties

Setting up Service Bulletins

To set up service bulletins
1. Navigate to the Service Bulletins page.

This page displays the existing service bulletins in a summary table. The Simple
and Advanced Search options enable you to look for a particular service bulletin.
2. Click the New Service Bulletin button to navigate to the Create Service Bulletins page.

   To duplicate a service bulletin, click the Duplicate icon. This reduces the overhead of bulletin creation.

3. Enter the information in the following fields. The fields marked with an asterisk (*) are mandatory:
   - **Name**: Name of the service bulletin.
   - **Description**: Description of the service bulletin.
   - **Type**: Select the type of the service bulletin.
   - **Workflow Process**: Associate a workflow process to the service bulletin.
   - **Frequency**: Select how frequently the service bulletin is applied.
     - **Apply Once per Item Instance** implies that the service bulletin is applied only once for a particular instance. For example, you can set this frequency when an engineering change order is applied only once and for which the same bulletin does not need to be applied repeatedly. A bulletin with this frequency never gets attached to Service Orders with Non-Installed Base items.
     - **Apply Once Per Repair** implies that the service bulletin is applied every time there is a new service order.
   - **Mandatory**: Select this checkbox to mark the service bulletin as mandatory on the service order.
   - **Escalation**: Select an escalation status based on the rules within your organization.
• Start Date: The activation date of the service bulletin.

• End Date: The expiration date of the service bulletin.

  **Note:** If the dates' field is left blank, it implies that the service bulletin is always active.

4. In the Service Codes region, click Add Another Row to define the service codes for the service bulletin.

5. You can add one or more attachments to a service bulletin using the Attachments region. Click Add Attachment to navigate to the Add Attachment page.

  **Note:** You can add a File, URL, or Text as an attachment.

6. The Rules region enables you to define multiple rules to associate to the service bulletin. Click Add Another Row to define rules.

7. Click the Details link in the Rules region to navigate to the Update Service Bulletin Rule page.

8. Use the Conditions region to define conditions for the rule. Click Add Another Row to enter the condition.

   A rule can have multiple conditions and all the conditions are evaluated to hold
true for the rule to apply.

9. Click the Details link to navigate to the Update Rule Condition page.

10. Enter the required rule conditions and click Apply.

11. Navigate back to the Create Service Bulletin page and click Publish.

   **Note:** Once you publish the service bulletins, it becomes read only. You can only modify the start and end dates.

### Receive Unplanned Returns

The Bulk Receiving module enables the receipt of unplanned returns. A receiving clerk can enter customer, item, serial number and quantity for all items in a shipment and the system will automatically process the return and receive it into inventory even if a returns material authorization does not exist for the items. Even in cases where some items do have approved RMAs and other items do not, the system can process both the planned and unplanned returns.

See: Receiving Returns using the Bulk Receiving Module, page 9-1.

### Receive Planned Returns

A receiving clerk can receive items against the RMA and its associated Service Request and Service Order in cases where a customer requests authorization for return by calling the call center or requesting a return through the Depot Returns Portal. The receiving clerk enters the customer information from the outside of the package, and then enters the item, quantity, serial number (if applicable), and other applicable values for the items inside the package.

The receiving clerk then clicks the Process button to receive materials against RMAs if they exist. If no RMA matches the item and serial number entered, the materials are still received but are considered an unplanned receipt and flagged as such.

### Execute Repair

The Technician Portal automates and facilitates the creation of work orders, issuing materials, and assigning resources, helping the service technicians to take good decisions. Based on a finite number of possible symptoms and a finite number of responses to those symptoms, the system can recommend or dictate work to be done, materials demanded, and resources needed for complex services based on symptoms captured by a technician.

See: Technician Portal, page 10-1.
Service Manager Portal

The Service Manager Portal enables you to monitor and manage all returns and service center operations from a single screen. This portal provides instant visibility to bottlenecks and process exceptions and allows you to manage the exceptions quickly. It allows a manager to perform the following:

- Monitor and report product quality issues.
- Monitor and manage work backlog and resources.
- Monitor and manage processing exceptions and escalations.
- Create, update and search service orders.

See: Service Manager Portal, page 5-1

Service Campaigns and Recalls

A service campaign is a coordinated set of service actions focused on a specific set of customers or products in a business’s install base. Some examples include:

- Calling all customers approaching their next regular maintenance interval.
- Calling all customers who have received service in the last month to survey their satisfaction.
- Emailing customers whose warranties are about to expire soon.
- Coordinating warehouse personnel to replace batteries on all spare parts that have been on the shelf over a certain period of time.

Service campaigns also include field change orders (FCOs), field actions, technical bulletins, and safety alerts. A service campaign enables a business to increase service revenue, improve product performance and increase customer satisfaction. When a campaign is used to address imminent safety hazards or possible product failures, it is considered a recall.

A recall is an action taken to address a problem with an item that makes it likely to fail, cause injury, or violate safety laws. A recall is not always an intimation to a customer to discontinue using the product or return it to the company. It means that the item or device needs to be checked, adjusted, recharged or fixed.

A recall is either a correction or a removal depending on where the action takes place. A correction addresses a problem with an item in the place where it is used or sold. This is managed by providing information to end customers to fix the problem, sending replacement parts for end customers to swap out the defective part, or sending a field service agent to take care of the problem. A removal addresses a problem by removing
the item from where it is used or sold. Removals also include items in warehouse inventories; spare pools or parts inbound in transit. A company may ship a replacement product to the customer or the customer may return the product for service.

See: Service Campaigns and Recalls, page 7-1

**Environmental Impact Dashboard**

The Environmental Impact Dashboard enables you to monitor return streams to reduce returns processing costs, recover value from returned assets, build better products and minimize returns’ impact on the environment. Another rationale for this dashboard is the increasing number of environmental regulations such as WEEE and ROHS. These laws require taking back products that consumers no longer want, taking back packaging materials, tracking recycling programs and landfill contributions, and removing hazardous materials from returns and disposing of them properly. This dashboard helps manage these requirements, minimize their costs and provide the reporting necessary to comply with the legislation.

The Environmental Impact Dashboard enables you to perform the following actions:

- Monitor how much material is being returned through each return stream.
- Monitor how much scrap and hazardous material comes from returns.
- Track the recovered value, cost of recovery and profit margin for returns.
- Track how much quantity of each product is put on market in each geography.

See: Environmental Impact Dashboard, page 8-1.

**Internal Moves**

The Internal Move function enables you to move items or parts from one warehouse or subinventory location to another. The Internal Move window wraps the capabilities provided by the Internal Requisition and Internal Sales Order modules provided by Purchasing and Order Management. A single service order can be linked to both sales orders and internal sales orders at the same time. Moreover, one service order can be linked to many sales orders and many internal sales orders at the same time.

See: Move Items Internally, page 4-27.
Oracle Depot Repair Business Scenarios

This chapter describes working with different depot repair business scenarios.

This chapter covers the following topics:

- Process a Repair and Return
- Process a Loaner, Repair and Return
- Process an Exchange
- Process an Advance Exchange
- Process a Replacement
- Process a Repair, Refurbishment, Remanufacture or Recycling of Internally Owned Items
- Process a Third Party Repair
- Process a Return Only Repair
- Process a Service Campaign or Recall
- Process a Supplier Warranty
- Process a Customer Take-back Request
- Process a Trade-in or Upgrade

Process a Repair and Return

The following steps describe in the recommended order how to process a Repair and Return scenario.

For more information, see Repair and Return, page 1-2.

Steps:

1. If you have not already created a Service Request, then Create a Service Request in the Depot Repair Workbench, page 4-12.
2. Create a Service Order, selecting Repair and Return as the Service Type.
   If the create process is successful, the application automatically creates two charge
   lines, one with Action Type Return, the other with Action Type Ship.

3. If you have not created and booked the Return line automatically as part of the
   process of creating the Service Order, then book the Return line.
   See Create and Book a Return Line Manually, page 4-25.

4. Receive the item, with or without inspection, page 4-59.

5. If you want to diagnose the problem by searching Oracle Knowledge Management
   for solutions to related problems, or if you want to apply Service Codes to help in
   creating estimates and WIP Jobs for the current Service Order, see Use the
   Diagnostics Tab and Knowledge Base, page 4-36.

6. The ability to create an estimate is controlled by a profile option. If this is enabled,
   and you want to create an estimate, then Estimate the service charges, page 4-49
   and, if required, obtain the customer’s approval.
   • If the customer accepts the estimate, then proceed to step 7.
   • If the customer rejects the estimate, follow the business rules appropriate for
     your company, whether that be returning the product to the customer, storing
     the product for pickup, scrapping the product or closing the service order.
     Close the Service Order, page 4-109 and the Service Request, page 4-110, if
     appropriate, to end this scenario.

7. Manage the service process using either WIP or Task service mode.
   The definition of the Service Type that occurred during setup determines the
   service mode. Based on this definition, the Jobs tab or Tasks tab is available.
   
   Note: The service mode associated with the seeded Service Type
   Repair and Return is WIP.

   For more information, see the following topics:
   • Manage the Service Process, page 4-72
   • Create and Process WIP Jobs, page 4-72
   • Create and Process Tasks, page 4-82

8. If you have not created the Ship line automatically as part of the process of creating
   the Service Order, then create the Ship line manually.
   See Create a Ship Line Manually, page 4-93.
9. Ship the serviced item, and process the Ship line accordingly.
   See Ship a General Item, page 4-94.

10. If required, create actual charges for the Service Order.
    See Record Billing Data in Actuals, page 4-101.

11. If required, book the actual charges for the Service Order.
    See Book Actuals, page 4-108.

12. If required, invoice the customer.
    See Invoice a Customer, page 4-108.


**Process a Loaner, Repair and Return**

The following steps describe in the recommended order how to process a loaner, repair and return.

For more information, see Loaner, Repair and Return, page 1-2.

**Steps:**

1. If you have not already created a Service Request, then Create a Service Request in the Depot Repair Workbench, page 4-12.

2. Create a Service Order, selecting Loaner, Repair and Return as the Service Type.

3. If the create process is successful, the application automatically creates these charge lines:
   - Ship line for loaner
   - Return line for defective item return
   - Ship line for service of defective item
   - Return line to track the loaner item return

4. If you have not created the Ship line for the loaner automatically as part of the process of creating the Service Order, then create the Ship line manually.
   See Create a Ship Line Manually, page 4-93.
5. Ship the loaner item, and process the Ship line accordingly.

See Ship a General Item, page 4-94.

6. If you have not created and booked the Return line for the defective item automatically as part of the process of creating the Service Order, then book the Return line.

See Create and Book a Return Line Manually, page 4-25.

7. Receive the defective item, with or without inspection, page 4-59.

8. If you want to diagnose the problem by searching Oracle Knowledge Management for solutions to related problems, or if you want to apply Service Codes to help in creating estimates and WIP Jobs for the current Service Order, see Use the Diagnostics Tab and Knowledge Base, page 4-36.

9. The ability to create an estimate is controlled by a profile option. If this is enabled, and you want to create an estimate, then Estimate the service charges, page 4-49 and, if required, obtain the customer's approval.

   • If the customer accepts the estimate, then proceed to step 10.

   • If the customer rejects the estimate, follow the business rules appropriate for your company, whether that be returning the product to the customer, storing the product for pickup, scrapping the product or closing the service order. Close the ServiceOrder, page 4-109 and the Service Request, page 4-110, if appropriate, to end this scenario.

10. Manage the service process using either WIP or Task service mode.

    The definition of the Service Type that occurred during setup determines the service mode. Based on this definition, the Jobs tab or Tasks tab is available.

    **Note:** The service mode associated with the seeded Service Type Loaner, Repair and Return is WIP.

    For more information, see the following topics:

    • Manage the Service Process, page 4-72

    • Create and Process WIP Jobs, page 4-72

    • Create and Process Tasks, page 4-82

11. If you have not created the Ship line for the serviced item automatically as part of the process of creating the Service Order, then create the Ship line manually.

    See Create a Ship Line Manually, page 4-93.
12. Ship the serviced item, and process the Ship line accordingly.  
   See Ship a General Item, page 4-94.

13. If required, create actual charges for the Service Order.  
   See Record Billing Data in Actuals, page 4-101.

   See Book Actuals, page 4-108.

15. If required, invoice the customer.  
   See Invoice a Customer, page 4-108.

16. When the loaner item is returned, book the Return line for the loaner item.  
   See Create and Book a Return Line Manually, page 4-25.

17. Receive the returned loaner item, with or without inspection, page 4-59.  

18. If additional charges, such as rental charges, are required for the loaner item, create  
   actual charges for the Service Order.  
   See Record Billing Data in Actuals, page 4-101.

19. If required, book the actual charges for the Service Order.  
   See Book Actuals, page 4-108.

20. If required, invoice the customer.  
   See Invoice a Customer, page 4-108.


22. If appropriate, Close the Service Request, page 4-110.

**Process an Exchange**

The following steps describe how to process an exchange in which an item is sent to the  
customer after the depot has received the defective item.  

For more information, see Exchange, page 1-2.

**Steps:**

1. If you have not already created a Service Request, then Create a Service Request in  
   the Depot Repair Workbench, page 4-12.
2. Create a Service Order, selecting Exchange as the Service Type.
   If the create process is successful, the application automatically creates two charge lines, one with Action Type Return, the other with Action Type Ship.

3. If you have not created and booked the Return line automatically as part of the process of creating the Service Order, then book the Return line.
   See Create and Book a Return Line Manually, page 4-25.

4. Receive the item, with or without inspection, page 4-59.

5. If you have not created the Ship line automatically as part of the process of creating the Service Order, then create the Ship line manually.
   See Create a Ship Line Manually, page 4-93.

6. Ship the exchange item, and process the Ship line accordingly.
   See Ship a General Item, page 4-94.

7. If required, create actual charges for the Service Order.
   See Record Billing Data in Actuals, page 4-101.

8. If required, book the actual charges for the Service Order.
   See Book Actuals, page 4-108.

9. If required, invoice the customer.
   See Invoice a Customer, page 4-108.


11. If appropriate, Close the Service Request, page 4-110.

Process an Advance Exchange

The following steps describe how to process an advance exchange in which an exchange item is sent to a customer before the defective item has been received back from the customer for a credit.

For more information, see Advance Exchange, page 1-2.

Steps:
1. If you have not already created a Service Request, then Create a Service Request in the Depot Repair Workbench, page 4-12.

2. Create a Service Order, selecting Advance Exchange as the Service Type.
If the create process is successful, the application automatically creates two transaction lines, one with Action Type Ship, the other with Action Type Return.

3. If you have not created the Ship line automatically as part of the process of creating the Service Order, then create the Ship line manually.
   See Create a Ship Line Manually, page 4-93.

4. Ship the exchange item, and process the Ship line accordingly.
   See Ship a General Item, page 4-94.

5. If you have not created and booked the Return line automatically as part of the process of creating the Service Order, then book the Return line.
   See Create and Book a Return Line Manually, page 4-25.

6. Receive the item, with or without inspection, page 4-59.

7. If required, create actual charges for the Service Order.
   See Record Billing Data in Actuals, page 4-101.

8. If required, book the actual charges for the Service Order.
   See Book Actuals, page 4-108.

9. If required, invoice the customer.
   See Invoice a Customer, page 4-108.


11. If appropriate, Close the Service Request, page 4-110.

**Process a Replacement**

The following steps describe how to process a replacement in which the depot sends a replacement item to the customer.

For more information, see Replacement, page 1-2.

**Steps:**

1. If you have not already created a Service Request, then Create a Service Request in the Depot Repair Workbench, page 4-12.

2. Create a Service Order, selecting Replacement as the Service Type.
   If the create process is successful, the application automatically creates one transaction line with action type Ship.
3. If you have not created the Ship line automatically as part of the process of creating the Service Order, then create the Ship line manually.

See Create a Ship Line Manually, page 4-93.

4. Ship the exchange item, and process the Ship line accordingly.

See Ship a General Item, page 4-94.

5. If required, create actual charges for the Service Order.

See Record Billing Data in Actuals, page 4-101.

6. If required, book the actual charges for the Service Order.

See Book Actuals, page 4-108.

7. If required, invoice the customer.

See Invoice a Customer, page 4-108.


9. If appropriate, Close the Service Request, page 4-110.

Process a Repair, Refurbishment, Remanufacture or Recycling of Internally Owned Items

There are two different flows in Depot Repair for processing internally owned items: the Asset Recovery flow and the Spares-to-Depot flow. These flows are similar in that both are used for processing internally owned items or parts; however, they differ in a number of aspects.

The Asset Recovery flow is initiated by a depot manager, service advisor or spares pool manager who wants to service, refurbish, recondition, remanufacture or recycle inhouse items or parts owned by the service business. You create a depot order for processing the material(s) in the Depot Workbench or the Create Service Order HTML screen. No RMA or Ship lines are auto-created, but you have the option to move materials from one warehouse or subinventory to another using the Internal Moves screen on the Logistics tab. The Asset Recovery flow is performed completely within the Depot application and does not require Spares Management to trigger the processing.

In the Spares-to-Depot flow, a spares planner indicates the type, number and location of internally owned items or parts to be sent to a depot for processing. This flow is used for reconditioning defective parts returned by a field service agent to a spares warehouse and returning the usable parts back to the spares warehouse. The Spares-to-Depot flow is only for scenarios where the same items and amount of material are moved back to the originating location after processing in the depot. Whereas, the Asset Recovery flow allows one-way moves, multi-warehouse moves,
partial moves and moves involving upgraded materials. The Spares-to-Depot flow can only be performed by customers who have licensed both Spares Management and Depot.

The Asset Recovery flow requires the user to select a service type linked to the Refurbishment service type reference in the Service Type Setup window. Selecting Refurbishment as the service type reference disables the Estimate and Actuals tabs on the Depot Workbench. By entering the Internal IB Party in the Party field on the Depot Workbench SR Header, you can then select serial numbers and IB reference numbers for internally owned items from their respective LOVs. On the Depot Workbench Logistics tab, you can click on the Internal Moves button to move internally owned items and parts from one warehouse or subinventory to another.

From Spares Management, you identify how many units of each defective item you wish to service. Then you create a Service Request and one or more Service Orders, also within Spares Management, as follows:

- For serialized items, there is one Service Order for each item instance.
- For non-serialized items, there is one Service Order for each item.

The type of service carried out in this situation is called a refurbishment.

From the depot's perspective, defective items are received via an Internal Requisition, and usable or serviced items are shipped via an Internal Order.

The following steps describe how to process a refurbishment for an item or item instance, for which a Service Order has been created in the Spares Management module of Oracle Field Service.

Steps:
The steps below describe the processing for an individual refurbishment Service Order.

1. In the Find Service Orders window, search for the Service Order created in Spares Management.

   When the Service Order appears in the Depot Repair Workbench, certain fields are filled in, as follows:

   - In the Service Request Information area, the Summary contains a standard description, such as Internal Refurbish service.

   - In the Service Order Information area, the Service Type indicates that the item is to be refurbished; the value of the Service Type is provided by the profile option CSD: Service Type Internal Service Order.

   For internal refurbishments, the Service Type Ref that you select must be Refurbishment. The service type reference acts as a template for certain attributes and actions. Selecting Refurbishment as the service type reference disables the Logistics, Estimate and Actuals tabs on the Depot Workbench.
Additionally, if the Party entered on the SR header is the Internal IB Party, the system opens up the LOVs for SN and IB Ref Num to include internally owned items.

For more information on setting up Service Types, see the Oracle Depot Repair Implementation Guide.

**Note:** The check box labeled Internal Order on the Service Type Setup page is only used for Spares to Depot flow. The service types with that check box option selected are not displayed in the Service Types LOV on the Depot Workbench. Selecting this option means that the service type is generated only from the Spares application.

2. Click the Logistics tab.
   
The Service Order has two transaction lines, one with Action Type Move In, the other with Action Type Move Out.

   The Move In transaction processes the transfer of the defective item from the Spares Management location into a depot for service.

   The Move In transaction is a two-stage process:

   1. First, the item is shipped from Spares Management.

   2. Then, the item is received into a depot subinventory.

      The Move Out transaction is a single-stage process - the item is shipped from the depot after it has been serviced.

      **Note:** The Move In and Move Out transactions make use of existing Internal Order and Internal Requisition functionality. From the depot's perspective, defective items are shipped via the Internal Requisition, and usable or serviced items are shipped via the Internal Order.

3. Process the two-stage transfer of the item into a depot, page 4-63.

4. Perform any required services on the item, page 4-72.

5. Process the shipping of the item back to the Spares Management location after service, page 4-98.

6. If appropriate, Close the Service Order, page 4-109.

7. If appropriate, Close the Service Request, page 4-110.
Process a Third Party Repair

The service centres require the ability to interface with third parties to fulfill a customer’s service requirements. Service centres track the movement of products, work, and financial obligation between all the parties involved in executing a service.

To move products to and from third parties, the “Third Party Repair” service type automatically creates a third party ship and third party RMA line to move product to and from an outside processing center. The outside processor can be defaulted to the logistics lines using defaulting rules. To track the work performed at the third party, and outside processing (OSP) operation is executed in the Technician Portal. Once the OSP operation is executed in the Technician Portal, the WIP OSP function automatically creates a purchase order to procure the desired service from the third party. To track the financial obligations between the service organization and the third party a business can create an account payable directly from the OSP purchase order or can create service payables (negative charges) in the Actuals tab.

For a third party service execution, an Outside Processing (OSP) operation is created in the Technician Portal. OSP operations are not specific to Depot Repair, they are standard in Work in Process (WIP). Essentially, completing the OSP operation triggers the creation of a purchase order with a request to procure service from a third party.

See:
- Third Party Flows, page 4-112
- Logistics Tab, page 2-12
- Oracle Purchasing User Guide for information on receiving and paying for purchase orders.

Process a Return Only Repair

The return only repair functionality is used when a service type is setup to have an RMA line. In this case, there is no corresponding ship line. When an item is returned, you have the following options:

- Items are returned for credit
- Items are returned to stock
- Items are returned for salvage

For example, when an item is returned, all the parts are first salvaged, the parts are recycled, and the remaining parts are scrapped.
Process a Service Campaign or Recall

The following steps describe how to process a service campaign or recall. A service campaign is a coordinated set of service actions focused on a specific set of customers or products in a business’s install base. A recall is an action taken to address a problem with an item that makes it likely to fail, cause injury, or violate safety laws. Both service campaigns and recalls are executed from the same module.

For more information, see Service Campaigns and Recalls, page 7-1.

Steps:
1. Navigate to the Service Campaign / Recall Module.

2. Enter the following descriptive information in the Service Campaign / Recall header section.
   - Recall Number
   - Recall Name
   - Status

3. Expand Hide Additional Details to enter the required details.

4. The Details tab lets you capture desired information regarding items or partners involved. Enter the following information:
   - Item Category
   - Item Names
   - Description
   - Revision Start and End
   - Serial Number Start and End
   - Lot Start and End
   - Partner Type
   - Partner Name
   - Partner Location
   - Start Date
• End Date

5. Click Apply to save the details.

6. The Items tab contains a list of all known item instances impacted by the recall failure to service an item.

7. Click the Add Multiple Instances button to navigate to the Search Item Instances page.

8. Use the Search Item Instances page to select the item instance you want to add.

9. Click the Add to Recall button.

10. Click the Done button to navigate to the Update Recall page that displays the selected item instance(s).

11. Select one or multiple instance numbers and click the Generate Recall Work button to generate service requests, service orders and/or jobs for them. The system auto-assigns the work to the appropriate queue, employee or partner.

12. Execute the service campaign or recall by working the list of service requests, service orders and jobs as per normal operations. Update the service campaign or recall status as appropriate.

13. Use the Corrective Actions tab to store information regarding the reason for the recall, risk, discovery and resolution plan. Enter the following information in the Problem region:
   • Discovery Date
   • Recall Reason
   • Problem Description
   • Discovery Method
   • Incidents and Injuries
   • Risk
   • Consequence

14. Capture the details of the remedial actions taken in the Resolution region. Enter the following details:
   • Remedial Actions
• Recall Strategy Description

15. The Metrics tab provides information regarding how many item instances are impacted, how many customers are impacted, how many items still require processing, and how many customers are still impacted.

16. Use the Recalculate Metrics button to refresh the Recall Metrics.

Process a Supplier Warranty

The following steps describe how to process a supplier warranty, which provides the ability to manage supplier warranty claims resulting from maintenance and service work.

Steps:
1. Setup a supplier warranty template. Set the warranty template to automatically apply to item instances each time a new instance is created.

2. In the Warranty Workbench, search for all instances that have pending supplier warranties. Change the warranty status for each from Pending to Active.

3. Create a service order for an item with an active supplier warranty. In the Technician Portal, view the Debrief tab to see that the supplier warranty has automatically been linked to the service order. If more than one warranty applies to the item instance (for example, if there is a five year warranty on the item and a three month warranty for service previously performed on the item) the technician has the option to select either warranty.

4. Complete the Service Order.

5. Create a warranty claim using the Claim Workbench.

Process a Customer Take-back Request

The following steps describe how to process a customer take-back request.

Steps:
1. Create a Service Request for the customer’s take back request. You can perform this in the Depot Workbench, the Depot Create Service Order page, Depot Returns Portal, iSupport or Teleservice. Note that the Customer here can be an internal customer as well as a product-owning customer.

2. Create a Service Order with a Take-back Service Type. The Depot Disposition
Engine can automate the process of choosing how to process the returned material and to where the material should be returned.

3. Create a job to process the returned materials. If a service code is setup for take-back processing, use the service code to generate a job from the Technician Portal.

4. On the Service Execution tab of the Technician Portal enter the quantity of material recovered on the Materials region table.

5. Enter the Disposition Code in the Material Transaction Reason Code column for each part or material recovered and capture the location to which the material was recovered in the Subinventory column. Note that both of these data values can be defaulted by the system.

6. Use the Complete Work button to issue all materials recovered into inventory. Alternately, recoverable materials can be set to backflush automatically when the job is completed.

7. Close the Service Order and Service Request for the take-back item.

Process a Trade-in or Upgrade

The following steps describe how to process a trade-in or upgrade using the Returns Portal.

Steps:
1. Navigate to the iSupport Home page and select the Manage Returns link. This launches the Returns Portal.

2. On the Returns Portal Enter Items page, enter the item to be returned and select Trade-in or Upgrade as the return type. This triggers a partial page refresh displaying additional fields, such as serial number, return reason, and upgrade to item. Enter the appropriate values and click Next.

3. On the Locations page select the addresses for billing and shipping, or choose the defaults. Click Next.

4. On the Review and Submit page confirm that the information is as expected and review all charges and terms and conditions. Enter credit card information if required. Click Submit.

5. The Order Confirmation page displays with instructions for returning the item for trade in or upgrade.
6. To receive the returned item, a receiving clerk uses the Bulk Receiving portal to capture the returned item information.

7. Trade-ins are processed in the same manner as Take-back materials. See: Process a Customer Take-back Request., page 3-14

8. Upgrades are processed by logging into the Depot Workbench.
   • Select the Service Order for upgrade.
   • Click the Jobs tab and click the Submit Jobs button.
   • Enter the Upgrade to Item on the Submit Jobs header.
   • Create the job.
   • Click Execute Job to launch the Technician Portal and complete the upgrade from the Technician Portal.
   • Note that the item returned for upgrade is defaulted on the Materials table of the Execute tab.
   • Complete the upgrade and click the Complete Work button to finish the job and update the Service Order status to indicate the item is ready to ship back to the customer.

9. From the Depot Workbench, the Shipping Clerk sends the item back to the customer requesting upgrade and closes the Service Order and Service Request.
This chapter describes task-based procedures for different processes that a user can perform to fulfill responsibilities.

This chapter covers the following topics:

- Overview of Managing Business Processes
- View Customer Profile
- View Coverage Information
- View Service History
- Determine Contract and Price List Defaults at Service Order Creation
- Create a New Customer
- Create a Customer Contact
- Create a Service Request
- Find a Customer for an Installed Base Item
- Create a Service Order in the Depot Repair Workbench
- Create a Service Order Starting From Oracle TeleService
- Create a Service Order Starting From Oracle Order Management
- Update the Service Order Status
- Update the Service Type of a Service Order
- Create and Book a Return Line Manually
- Move Items Internally
- Find Service Requests and Service Orders
- Transfer Installed Base Ownership
- Create and Maintain Notes
- Use the Diagnostics Tab and Oracle Knowledge Management
• Manage Diagnostic Codes in the Diagnostics Tab
• Search Oracle Knowledge Management
• Manage Solutions in the Diagnostics Tab
• Manage Service Codes in the Diagnostics Tab
• Select Service Codes Manually in the Service Codes Area
• Activate and Deactivate Service Codes in the Service Codes Area
• Delete Service Codes in the Service Codes Area
• Estimate Service Charges
• Create an Estimate
• Revise an Estimate
• Obtain Customer Approval for an Estimate
• Auto-Receive an Item
• Receive an Item
• Receive an Item for an Internal Order Refurbishment
• Split a Service Order
• Manage the Service Process
• Create and Process WIP Jobs
• Create a WIP Job for a Single Service Order
• Process a WIP Job for a Single Service Order
• Create a WIP Job Across Multiple Service Orders
• Process a WIP Job Across Multiple Service Orders
• Create and Process Tasks
• Create a Task Manually
• Create a Task Using a Task Template
• Enter and Update Task Details
• Prepare the Tasks Debrief
• View Activities Related to a Service Order
• Update Service Orders Concurrently
• Send and View Workflow-Based Messages
• Create a Ship Line Manually
• Ship an Item
• Move an Item to a Usable Spares Subinventory
Overview of Managing Business Processes

Oracle Depot Repair improves the efficiency of the depot repair process.

Many different users can be involved in the overall depot process. These users and roles include the call center agent, service technician, shop floor technician, shop floor accountant, shop floor production manager, warehouse administrator, shipping administrator, receiving administrator, service administrator, accounts receivable manager, purchasing manager, HR manager, and depot manager.

For example, the call center agent logs the Service Request, the service technician diagnoses the broken part, the shop floor technician fixes the item, the shop floor accountant keeps track of the service costs, the shop floor production manager schedules the jobs, and the depot manager has the overall service process responsibility. Depending on the service organization, a user can have multiple roles. For example, the service technician can log the Service Request, and diagnose the broken part.

For key concepts and features of Oracle Depot Repair, see the Introduction to Depot Repair.

To explore the Oracle Depot Repair user interface, see Overview of Using Oracle Depot
Repair.

For an overview of the processes behind different depot repair business scenarios, see Oracle Depot Repair Business Scenarios.

**View Customer Profile**

The customer profile summarizes customer information. A system administrator usually sets up the profile entries that appear in the customer profile, which contain a set of previously defined verifications. You can configure these verifications, as well as the actual range values and value definitions. The verification results appear by using the Customer Profile Engine, which is a concurrent program.

The customer profile information appears in the Profile window when you select Profile from the Tools menu in the Depot Repair Workbench. Click Refresh in the Profile region to view the latest profile information for the customer. This Oracle Depot Repair functionality lets service agents verify a customer’s profile information, including Open Orders, Booked Orders, Cancelled Orders, Open Service Requests, Escalated Service Requests, Active Contracts, Expired Contracts, Cancelled Contracts, Open Service Orders.

**Prerequisite**

Service Order records associated with the customer must exist in the database.

**Steps:**

1. In the Depot Repair Workbench, select the customer whose profile you want to view.

2. Select Profile from the Tools menu.
   The Profile window opens.

3. Double-click a key indicator in the profile window.
   Oracle Depot Repair shows a summary list of that profile verification. For example, double-clicking Open Service Request (a key indicator) displays the list showing all open Service Requests for the selected customer type.
   This list displays information such as the Service Request Number, incident date, problem code and resolution code.

4. Double-click any line in the summary list.
   Oracle Depot Repair displays the appropriate window containing details of the selected line.
View Coverage Information

Items that a warranty or service contract covers and that link to Oracle Installed Base, populate the coverage fields with a list of all entitlements or all active entitlements (based on option selection) that apply to the selected Service Order.

Oracle Depot Repair permits the service agent to select a contract coverage that can be applied to the Sales Order charge lines that Charges created. The selected Contract Number automatically defaults on each charge line that is generated from the WIP Summary Report only. This option excludes those charge lines that relate to any new item upgrades and enhancements. The agent can verify active warranties existing for the item. Also, the contract selected as default in the Coverage window cannot be applied to charge lines in the Debrief Report. Instead, the contract selected at the Service Request level applies by default to the Debrief charge lines.

Oracle Depot Repair also permits the agent to find all contracts including those that have already expired. This is a handy tool for service agents to advise customers on contract coverage expiry, and service contract renewal offers to reinstate their coverage.

Prerequisite

You can view coverage information only for an Installed Base item referenced on a Service Order.

Steps:

1. Retrieve the Service Order referencing the item for which you want to view coverage information.
   
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
   
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. From the top menu, select Tools > Coverage.
The Coverage window displays the configuration and entitlements for the Installed Base item referenced on the Service Order.

Based on option selection, you can automatically query all contracts or all active contracts applicable to the Service Order. By selecting the Default check box beside a contract, you apply this as the default contract to the Service Order. For detailed field descriptions, see Coverage Window, page 2-43.

If you select a contract that does not specify a Price List, the application defaults the Price List that is set for the default Price List profile option. This happens if the Price List currency is the same as the Service Order currency. If the Price List currency is not the same as that of the Service Order, or if the profile option is not set, you can select any Price List from the list.

**View Service History**

Service agents can view all the Service Requests and Service Orders that were logged against a service item. The item must be serialized and linked to an Installed Base Instance value in order for this functionality to work. This valuable functionality permits the service provider to review the service history and service records that were recorded over the lifetime of the Installed Base item, and is especially useful when attempting to troubleshoot and diagnose service patterns and trends that affect the item.

The following procedures describe how to view an item’s service history.

**Prerequisite**

You can view the service history of only an Installed Base item. Service Order records must exist for the item.

**Steps:**

1. Retrieve the Service Order corresponding to the item, the service history of which you want to view.

   For more information, see Find Service Requests and Service Orders, page 4-30.
2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.

The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. From the top menu, select Data > Service History.

The Service History window lists all the Service Requests and Service Orders previously opened against the Installed Base item on a Service Order.

For detailed field descriptions, see Service History Tab, page 2-48.

---

**Determine Contract and Price List Defaults at Service Order Creation**

A service contract has entitlements, for example, discounts, and response time. Entitlements are specified for each business process setup for the contract. There are cases where a contract can have entitlements that are specified for the Business Process of the Service Request, but not for the Depot Repair Business Process. If that is the case, Oracle Depot Repair cannot use that contract.

The rest of this section describes how the default contract and Price List are evaluated when you create a new Service Order.

**Default Contract**

- If there is a contract in the Service Request, it becomes the default contract only if the contract is valid for the Business Process associated with the Oracle Depot Repair Service Type in the Service Order.

- If the contract in the Service Request is not valid for the Business Process associated with the Oracle Depot Repair Service Type or if there is no contract in the Service Request, the "best" contract calculated by response time becomes the default contract.
Default Price List

1. With Contract
   • If there is a contract, get the Business Process Price List of the contract for the Service Type in the Service Order and derive the currency.
   • If the contract does not have a Business Process Price List for the Service Type, get the contract (selling) Price List and derive the currency. If there is no Price List, then get the default from the profile option CSD: Default Price List.
   • If the profile option CSD: Default Price List is not set, get the Service Type Price List and derive the currency.
   • If Service Type Price List is not set, neither the currency nor the Price List is set.

2. Without Contract
   • If no contract is set, get the default Price List from the profile option CSD: Default Price List and derive the currency.
   • If the profile option CSD: Default Price List is not set, get the Price List from the Service Type setup and derive the currency.
   • If the Service Type Price List is not set, neither the currency nor the Price List is set.

Create a New Customer

You can create a new customer in the Depot Repair Workbench.

Steps
1. Navigate to the Depot Repair Workbench.

2. In the Service Request Information area click the New Customer button. The New Party - Customer window appears.
3. In the New Party - Customer window, the Customer Type defaults as Person. Enter the required information in the following fields:

- **Title:** Indicates the customer's title, such as Miss, Mr., Mrs., and Dr.

- **First, Last, Middle, Suffix:** Indicate the First, Last and Middle names of the customer and Suffixes in the name.

- **Phone:** Indicates the customer's phone number. You can look up area codes in the list of values.

- **Ext:** Indicates the phone extension of the customer.

- **Type:** Refers to the phone type, such as Work, Home, Cell, or General. Select from the list of values.

- **Email:** Enter the customer's email address.

- **Create Account:** Check box, when selected, creates an account for the new customer in your database.

- **Bill-to:** Refers to the address to which you should send the customer's bill. When you have entered the Country in the Address field, the Address window appears where you can select the Context Value to choose the customer's Address style, such as North European, Japanese, or South American. After you
select the Context Value, the Address window provides you with fields appropriate to the address style you have chosen. Enter the address, and click OK.

- Ship-to: Refers to the address to which you should ship an item for the customer.

- Primary: Check boxes that indicate whether the Bill-to and Ship-to addresses are the customer's primary addresses.

- Click OK to return to the Depot Repair Workbench.

Create a Customer Contact

You can create a new contact for a customer in the Depot Repair Workbench, and use this contact while creating your new Service Request.

Prerequisite

The customer whose new contact is being created must have an existing record in the database.

Steps:

1. In the Find Service Orders window, click New to display the Service Orders window.
   
   The Service Orders window serves as the Depot Repair Workbench. From the Depot Repair Workbench, you can perform all depot processes, end-to-end.

2. In the Service Request Information area of Depot Repair Workbench click New Contact.

   The New Party - Contact window opens.
3. In the New Party - Contact window, the Customer Type defaults as Person. Enter the required information in the following fields:

- **Title**: Indicates the contact’s title, such as Miss, Mr., Mrs., and Dr.
- **First, Last, Middle, Suffix**: Indicate the First, Last and Middle names of the contact, and Suffixes in the name.
- **Phone**: Indicates the contact’s phone number. You can look up area codes in the list of values.
- **Ext**: Indicates the phone extension of the contact.
- **Type**: Refers to the phone type, such as Work, Home, Cell, or General. Select from the list of values.
- **Relation**: Specifies the contact’s relationship with the customer, such as Associate of, Child of, and Benefactor of. Select from the list of values.
- **Party**: Refers to the name of the customer. Select from the list of values.
- **Email**: Enter the contact’s e-mail address.
- **Create Account**: Check box, when selected, creates an account for the new contact in your database.
• Bill-to: Refers to the address to which you should send the contact's bill.

When you have entered the Country in the Address field, the Address window appears where you can select the Context Value to choose the contact's Address style, such as North European, Japanese, or South American. After you select the Context Value, the Address window provides you with fields appropriate to the address style you have chosen. Enter the address, and click OK.

• Ship-to: Refers to the address to which you should ship an item for the contact.

• Primary: Check boxes that indicate whether the Bill-to and Ship-to addresses are the contact's primary addresses.

4. In the New Party - Contact window, click OK.

A note appears informing you that a Party Number and an Account Number (if you selected the Create Account check box) have been created and saved for the new contact.

5. In the note, click OK.

The application returns you to the Depot Repair Workbench.

Create a Service Request

Service Requests initiate the actions required to solve a customer problem. A Service Request is mandatory for any service process, and needs to be created before any Service Order can be created in the Oracle Depot Repair module.

You can log a customer request for assistance in the Depot Repair Workbench. The application lets you create Service Requests without having to leave the Depot Repair Workbench.

Generally, as you create a Service Request, you know which customer to associate with the Service Request. There may be situations where you are only provided with identifiers for Installed Base items, and the customer information is not provided. In this case, you can use an Oracle Depot Repair feature to find and select the customer associated with the item.

**Note:** You cannot create a Service Request without a value in the Item field if the profile CSD: Require Item For Service Request has been set to Yes during implementation. Setting this profile option to No lets you create a Service Request without entering a value in the Item field.

Also, when the profile option is set to No, you can specify an Installed Base item without specifying an Instance value in the Service Request.

You can search for existing Service Requests and Service Orders from the Find Service Orders window.
Prerequisite

The customer and contact records must exist in the database. Service Requests can be logged only for items recorded in inventory.

Steps:

1. In the Find Service Orders window, click New.
   The Depot Repair Workbench opens.
   In the Service Request Information area in the Depot Repair Workbench, the Contact Type, Customer Type, and Opened Date fields default to Relation, Organization, and the Current Date respectively.
   The Severity and Status fields default to the value of the profile options Service: Default Service Request Severity and Service: Default Service Request Status respectively.
   If you need to discover the customer for the Installed Base item that will be the subject of the Service Request, perform the operations in Find a Customer for an Installed Base Item, page 4-15.

2. If you select a customer using these operations, the customer-related and the item-related fields in the Service Request Information area are automatically filled in. The fields can be changed before you save the Service Request.

3. Choose the Contact Type and Customer Type from the lists of values, and use lists of values to select the Contact, Customer, Request Type (such as Customer Call, Depot Repair, Field Service), Severity, and Status fields.
   You can also enter the date and time in the Opened field.

   Note: Contact information is not mandatory for creating a Service Request. Selecting a blank contact type in the Contact Type field disables all Contact information fields.
   The Bill-To and Ship-To address fields are populated automatically when the Customer and Contact Names are entered. The addresses always default to the primary Bill-To and Ship-To addresses of the customer. Even if you select a primary address for the Installed Base instance, the Bill-To and Ship-To address fields default only to the primary address of the customer party. Also, the list of values for both fields contains addresses for related parties, which can be for either persons or for organizations.
   For more information, see The Service Request Information Area, page 2-4.
4. To validate the item against the Installed Base, select the Installed Items Only check box.

   **Note:** The system will not allow a service request to be created if the item instance selected is not owned by the party entered in the Customer field or owned by a party with an Installed Base relationship to the party entered in the Customer field unless the profile CSD: Default Instance-Party Association Type has a value assigned.

5. Select the Item that the customer is reporting as defective from the Item list of values.

   If the item is serialized, the Serial Number appears. After validation, the Instance field is automatically populated. For a given customer, the call center agent can view all the items in the customer Installed Base.

   For more information about entering the Item, Instance and Serial Number fields, see Item Information Fields, page 2-4.

6. Select the name of the person responsible for overseeing the Service Request in the Owner field from the list of values.

7. Enter a brief summary of the service issue in the Summary text field.

8. Click the Save icon on the toolbar to create the Service Request record.

   The application populates the Request field in the Service Request Information area with the Service Request Number. When you click any of the fields in the Service Order Information area, the application populates the Item, Item Description, UOM, and Quantity fields from the Service Request Information area.

9. Authorized users can launch the Service Request HTML page by clicking the hyperlinked Request Number from both the Depot Workbench and the Technician Portal. This renders the Service Request HTML page in editable mode where you can update and save data. This enables you to update service request values such as Customer Bill-to and Ship-to addresses, SR Status and SR Resolution Type.

   You can enable the hyperlink through profile option, CSD: Enable Service Request Drill-down (Yes/No).
Find a Customer for an Installed Base Item

Sometimes, when you are creating a Service Request, you may know the Item Name, or its Serial Number, or its Installed Base Instance Number, but the customer name is unknown or simply not provided.

In these circumstances, you can provide the item information, and search for the customers that have the item in their Installed Base.

After you select one of the customers for the item, all the customer-related and item-related fields appear in the Service Request Information area of the Depot Repair Workbench.

This procedure is only available when you are creating a new Service Request in the Depot Repair Workbench.

Prerequisites

You must be in the process of creating a Service Request.

The items provided as search parameters must be Installed Base trackable or serialized items.

Steps:

1. In the Depot Repair Workbench, from the top menu, select Tools > Find Customer.
   
   The Find Customer window opens.

2. Select one or more of the following fields as search parameters:
   
   • Item
   
   • Instance
   
   • Serial Num
   
   • Revision

3. Click Find.
   
   The Results area shows the customers that have the item in their Installed Base.

4. Highlight the customer whose data you want to have on the Service Request, and click OK.

Create a Service Order in the Depot Repair Workbench

The depot business process starts with a Service Order. Creation of Service Orders occurs only against Service Requests for serviceable items.

You can create a Service Order and its associated Service Request directly in the Depot Repair Workbench, which automates part of the process. Alternatively, you can start the process of creating a Service Order in another Oracle application. For more information, see Alternative Ways of Creating Service Orders, page 4-16.

For service items that are under revision control, a correct Revision Number is mandatory. If your Service Order Item is serialized, and the quantity to service is greater than 1, you will have specify each of the Serial Numbers of the item to be serviced, for Installed Base trackable items.

Oracle Depot Repair also lets you add items to a customer's Installed Base from the Depot Repair Workbench. This enables the depot to process (Installed Base trackable) service items that the customer purchased from outside the service organization. If you try to create a Service Order line without specifying an Instance value for an Installed Base trackable item, the application will prompt you to add a new item instance to the Installed Base. This lets you process the service.

Each Service Order must have a Service Type. When you create a Service Order in Oracle Depot Repair, then, depending on the Service Type, the application automatically creates one or more RMA and Sales Order lines. The RMA and Sales Order lines appear in the Logistics tab, with action types of Repair and Ship respectively. If you choose the Standard Service Type, no charge lines are created automatically; you must create them manually.

You can also choose to create RMA charge lines manually. If you want to create the RMA charge line manually, first you must clear the check box Automatically Enter and Book RMA, during the creation of the Service Order. Afterwards, you can create the RMA charge line, as described in Create an RMA Manually, page 4-25.

The following procedures describe how to create a Service Order in the Depot Repair Workbench.

Prerequisite

A Service Request record must exist for the broken item in order to create a Service Order for its service.

**Note:** You can also proceed to creating a Service Order immediately after creating a Service Request record, without having to navigate to the Find Service Orders window. In this case, start at step 3.

**Steps:**

1. From the Find Service Orders window, retrieve the pertinent Service Request.
For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant Service Request, and click OK.
   The Depot Repair Workbench shows the Service Request information.

3. In the Service Order Information area in the Depot Repair Workbench, confirm the information appearing in the table, or enter the appropriate information for the defective item.

4. Select the Service Type from the list of values.
   For more information on Service Types, see Service Type Processing, page 1-2. For field descriptions, see Details Tab, page 2-9.

   **Note:** A Service Order supports a single currency. Different currencies are supported for different Service Orders within a Service Request. The default currency is based on the default contract. If no default contract is selected, the default Price List determines the currency. If neither defaults are set, the currency selection is based on the manually selected Price List in the Details tab.

   After a charge line is created, you cannot change the currency of the Service Order in the Details tab or select another default contract that has a Price List with a different currency. To change the currency of a Service Order, all the charge lines have to be deleted.

5. Optionally, enter the quantity of items to be serviced in the Qty field.
   The default quantity is 1. If you specify a Qty that is greater than 1 for a serialized item, then you will need to capture the Serial Numbers separately, after the Service Order is created. For details, see step 13.

6. In the Details tab, optionally enter the Promise Date (date and time) for service completion after negotiation with the customer.

7. Optionally, select the name of the person responsible for overseeing the service in the Service Owner field from the list of values.

8. If you require estimates to be approved before you can proceed with the service of an item, then select the check box Estimate Approval Required, else clear this check box.

9. If you want the RMA line to be automatically entered and booked when you create the Service Order, then select the check box Automatically Enter and Book RMA, else clear this check box.
10. Click Save to create the Service Order.

11. If you have tried to create a Service Order line without specifying an Instance value for an Installed Base trackable item, or without specifying a Serial Number for a serialized item with a Qty of 1, a message window appears.

In the message window, you can either click Add to IB to add an item instance to the Installed Base, or you can click Save As Is to create the Service Order without adding to the Installed Base. You can only Add to IB if the User Function Name Service Orders: Add to IB is associated with your responsibility.

**Note:** If you select Save As Is, the Service Order is created, but no charge lines are created automatically. You will have to create all the required charge lines for your Service Type manually in the Logistics tab.

After the Service Order is created, the application populates the SO Number fields both in the Details tab, and in the Service Order Information area, with the Service Order Number.

12. For the case where the Service Order Item is serialized, and the quantity of the item Service Order Item is greater than 1, continue at step 13.

For all other cases, continue at step 18.

**Capture Serial Numbers**

13. If your Service Order contains a serialized item, and the quantity is greater than 1, when you click Save, a message window appears, which instructs you as follows:

- The Service Order created will be a draft Service Order, that is, its Service Status will be Draft.
You must enter the Serial Numbers using the Capture Serial Numbers option from the Tools Menu.

14. To complete the processing for servicing many individual serialized items, click OK in the message window, then, from the top menu, select the options Tools > Capture Serial Numbers.

In the Serial Numbers window that appears, your main functions are to select a Serial Number for each individual item instance, and to process the Serial Numbers. Processing the Serial Numbers creates a separate Service Order for each item instance.

15. Select a Serial Number from the Serial Number list of values for the customer account.

You can specify a Serial Number that does not exist yet. In this case, a message appears asking if you wish to create the new Serial Number.

16. You can optionally select the check box Add to Order within Service Request.

If you select this option, then, when the Serial Numbers are processed, each RMA line will be added to the same Order Number.

17. After you have specified the Serial Numbers, click one of the following buttons:

- **Save**: This saves the Serial Numbers, but does not process the values into separate Service Orders for each Serial Number.
- **Process**: This creates a separate Service Order for each Serial Number, each with a status of Open.
- **Close**: This closes the window without saving or processing the Serial Numbers.

**Note:** For serialized, non-Installed Base trackable items, if you enter fewer Serial Numbers than the Qty on the Service Order, Oracle Depot Repair creates as many Service Orders as the Qty number of units. For example, if Qty is 10, and you enter 8 Serial Numbers, you get 8 Service Orders with Serial Numbers provided, and 2 without Serial Numbers. You will need to provide the 2 missing Serial Numbers at time of receipt.

**Note:** For serialized, Installed Base trackable items, if you enter fewer Serial Numbers than the Qty on the Service Order, Oracle Depot Repair creates only as many Service Orders as the number of Serial Numbers you entered. For example, if Qty is
10, and you enter 8 Serial Numbers, you get 8 Service Orders with Serial Numbers provided.

Checking the Logistics Tab

18. Click the Logistics tab.

While not technically part of the creation process, after you have created the Service Order, you should check the Logistics tab to determine the next process to perform.

Depending on your choice of Service Type and whether you set the check box Automatically Enter and Book RMA, the Logistics tab generally contains one or more Return and Ship lines, each of which has a Status.

19. In certain cases, there are no charge lines in the Logistics tab, such as when one of the following has occurred:
   - The Service Type is Standard.
   - For a serialized service item, you selected Save As Is in the Create IB Instance window (see step 11).

You must create and book the required charge lines manually.

See Create and Book a Return Line Manually, page 4-25 and Create a Ship Line Manually, page 4-93.

20. If your Service Type involves the return of a defective item, then, in order to receive the defective item into inventory, the following conditions must apply:
   - There must be a Return line in the Logistics tab.
   - The Status of the Return line must be Booked.

To fulfill these conditions, except for the special case where you created the Service Order after creating an order in Oracle Order Management, proceed to create and book the Return line, as required.

See Create and Book a Return Line Manually, page 4-25.

Comments:

1. If you are creating more than one service order line, and the value of the profile option CSD: Default Service Order is set to Yes, then, as you arrow down from the last service order line, the values are defaulted from the last service order line into the new line.

2. After creating the Service Order record, you can attach additional information to the Service Request or Service Order by clicking the Notes button in the Details tab.
For more information, see Create and Maintain Notes, page 4-34.

After creating the Service Order record, you can attach additional information to the Service Request or Service Order by clicking the Notes button in the Details tab.

3. After creating the Service Order record, you can also search from the Diagnostics tab for possible solutions to the problem affecting the service item.

In the Diagnostics tab, by selecting Service Codes, either manually or as a result of a search performed in Oracle Knowledge Management, you can get the information ready to automatically create estimate lines and default Bills and Routings for WIP Jobs.

For more information, see Use the Diagnostics Tab and Oracle Knowledge Management, page 4-36.

**Alternative Ways of Creating Service Orders**

In addition to the method of creating a Service Order and its associated Service Request in the Depot Repair Workbench, which enables you to automatically create charge lines associated with the Service Type, there are two other ways by which you can create a Service Order, as follows:

- Create a Service Order Starting From Oracle TeleService, page 4-21
- Create a Service Order Starting From Oracle Order Management, page 4-22

**Create a Service Order Starting From Oracle TeleService**

The depot agent can view activities performed against a Service Request that was initiated in the call center and transferred to the depot for resolution. You can link RMAs and Sales Orders generated through the call center to Service Orders created within the Depot Repair Workbench.

This procedure shows an example of creating a Service Order, where an existing Service Request already has RMA and Sales Order lines.

1. Create a Service Request in Oracle TeleService, with a Service Request Type of Depot Repair.

2. In the Charges tab of the Service Request, create one or more charge lines with typical Depot Repair activities for the items that require service processing.

   A RMA charge line, for example, could include the following values:

   - Charge Line Type = Actual
   - Business Process = Depot Repair
• Service Activity = Return for Repair

A Sales order line, for example, could include the following values:
• Charge Line Type = Actual
• Business Process = Depot Repair
• Service Activity = Ship Returned Item

3. Submit the lines for processing.

4. In the Navigator, using the Depot Repair Super User responsibility, navigate the path Depot Repair > Service Orders.

5. In the Find Service Orders window, enter the Service Request Number you created in step 1, and click Find.

6. When the record appears in the Results area, click OK.
   A message window informs you that RMA/Sales Order lines not linked to a Service Order were found, and asks if you want to create a Service Order or associate the RMA/sales lines.

7. When you click OK, the Create Service Order window appears, containing the not-yet-linked RMA lines.

8. Select the lines that you want to become Return (RMA) lines in the Service Order, and click OK.
   If there are submitted Sales Order lines in the Service Request, the Link Sales Order window appears, containing the not-yet-linked Sales Order lines.

9. Select the lines that you want to become Ship lines in the Service Order, and click OK.
   The Service Order appears in the Depot Repair Workbench, with a Standard Service Type. The Return and Ship lines appear in the Logistics tab, each with the Status of Submitted.

Create a Service Order Starting From Oracle Order Management

This procedure shows an example of creating a Service Order, which starts with the creation of an order in Oracle Order Management, and includes the operation of receiving the service item into inventory.

1. In Oracle Order Management (if you use the Depot Repair Super User responsibility, navigate the path: Order Management > Orders, Returns > Sales
Orders), create a Sales Order, with the following values:

Order Information tab:
- Set Order Type = Mixed

Line Items tab, Main sub-tab:
- Specify the item to be serviced in Ordered Item, and set Qty = -1

Line Items tab, Returns sub-tab:
- Specify the Return Reason

Line Items tab, Shipping sub-tab:
- Specify the Warehouse

2. When the order status is Booked, note the Order Number.

3. In Oracle Purchasing (if you use the Depot Repair Super User responsibility, navigate the path: Purchasing > Receiving > Receipts), in the Find Expected Receipts window, click the Customer tab, and search for the receipt whose RMA Number you noted in step 2.

4. In the Receipts window, select Inventory for the Destination Type, select the Subinventory.

5. If required, specify the Serial Number or Serial Number range of the item to be received.

6. Submit a request to run the program Create SR/SO from OM RMA Lines; specify the Organization and Subinventory parameters.

7. When this program finishes, the Service Order has been created, with a Standard Service Type.

   Because the item to be serviced has already been received, the Logistics tab contains neither Return nor Ship lines.

8. From the top menu, select Data > Activity, to find summary information in the Activity window about the receiving of the item.

**Update the Service Order Status**

You can update the Status of a Service Order either by selecting a Service Order and then clicking the Update SO Status button from the Depot Repair Workbench or by clicking the Update Status button from the Service Order page.

When you update the Status of a Service Order, you can only change to a Status defined
as acceptable for the current Service Type in your setup of Service Order Status Transitions. The list of values for New Status shows only the allowable statuses from which you can select.

For more details, see Service Order Status Transitions in the Oracle Depot Repair Implementation Guide.

If the transition has been set up to require you to enter a reason at the time of status change, enter the Reason, else it is optional for you to do this. You may also add or edit Comments.

![Update the Service Type of a Service Order](image)

**Update the Service Type of a Service Order**

Begin the process of updating the Service Type of a Service Order by selecting Tools > Update Service Type from the main menu.

You can update the Service Type of a Service Order only if the Status of the Service Order has previously been defined as a Status of both the current Service Type and your intended target Service Type.

For more details, see Service Type Transitions in the Oracle Depot Repair Implementation Guide.

Enter the New Service Type. The Description associated with the service type transition appears.

If the transition has been set up to require you to enter a reason at the time of service type change, enter the Reason, else it is optional for you to do this.
Important: Service type transitions do not add, delete, nor default any logistic lines. After a service type transition is performed on a service order, you must perform manual adjustments to your logistic lines, if your organization processes require this.

Create and Book a Return Line Manually

Important: In this section, the terms RMA, RMA line, and Return line are used interchangeably.

When creating a Service Order for Service Types that require RMA creation, the application automatically generates the Return line based on Service Type setup. If you choose or have to create an RMA manually, then, in the Details tab, clear the Automatically Enter and Book RMA check box, before saving the Service Order.

The main objective of creating and booking an RMA is to create an order in Oracle Order Management. When the RMA is fully interfaced with Oracle Order Management, an Order Number is associated with the RMA, and appears in the Return line.

The following procedures explain how you can create and book an RMA manually, after you have created the Service Order. If the RMA has already been created, you can just book the RMA.

For background information about RMA creation, see Create a Service Order in the Depot Repair Workbench, page 4-16.

Prerequisite

You must have created a Service Order.

Steps:

1. Retrieve the Service Order for which you want to create or book the RMA.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. Select the Logistics tab in the Depot Repair Workbench.
   If a Return line already exists for the defective item to be returned, but the Status is not Booked, then continue at step 10.
**Creating a Return Line**

4. If you need to create a Return line, click the Action Type field in the next blank line, and select Return.

5. Select the fields for the Return line.
   
The main fields that you must select are Action Code, Service Activity, Price List, and Return Reason. For serialized items, you must select the Source Serial Number. Item-related fields default to the Service Order Item. You may edit these as required.

   Note also the Add to Order field. Oracle Depot Repair lets you place all Return (RMA) and Ship lines on the same order.

   By default, all Return (RMA) and Ship lines appear on the next-highest Order Number created when the lines are transferred to Order Management.

   You can also select the specific order for the Return (RMA) or Ship line by selecting the Order Number in the Add to Order field before interfacing the specified line to Oracle Order Management.

   **Note:** Use the following profile options:

   - CSD: Add to Order Num Within Service Order Default to submit/book logistics lines to the same order number within a single service order.
   - CSD: Add to Order Num Within Service Request Default to submit/book logistics lines to the same order number across multiple service orders that belong to the same service request.

   For field descriptions, see Logistics Tab, page 2-12.

   If you want to process the Return line directly to the Booked stage, continue at step 10.


7. Select the Automate order processing steps through check box.

8. Click Process.

   Acknowledge the message in any message window that appears.

   The Status of the Return line changes to Entered or Submitted.

**Booking a Return Line**

10. Select the Automate order processing steps through check box.

11. Select Book Order radio button option.

12. Click Process.

   Acknowledge the message in any message window that appears.

   The Status of the Return line changes to Booked.

The Sales Order Number can optionally be hyperlinked to allow you to click on it to launch the Sales Order window in editable mode and in context of the clicked Order Number. You can enter information such as credit card number, ship method and payment details, save the order, close the Sales Order screen and return to the Depot Workbench without ever leaving.

Comments:

1. During the processing of the Return line, when the Return line is fully interfaced with Oracle Order Management, the Order Num field is populated with the system-generated RMA Order Number.

   If you have not selected the No Charge check box, the application returns the item price to the Price field based on Price List selected.

2. To delete a Return or Ship line, select the Return or Ship line on the Logistics tab, and click the Delete icon on the toolbar.

   **Note:** The Delete icon on the toolbar remains enabled as long as the Return or Ship line has not been fully interfaced with Order Management. After the order is fully interfaced to Order Management, the application disables the Delete icon, and you cannot delete the order line. You can cancel the submitted order line by selecting Cancel Order Line from the Actions drop list and clicking on the Go button.

---

**Move Items Internally**

The Internal Move capability allows you to move items or parts from one warehouse or sub-inventory location to another. The Internal Move window wraps the capabilities provided by the Internal Requisition and Internal Sales Order modules provided by Purchasing and Order Management. A single service order can be linked to both sales orders and internal sales orders at the same time. Moreover, one service order can be linked to many sales orders and many internal sales orders at the same time.

Additionally, it provides the ability to create Internal Requisitions and Internal Sales Orders in one step, ship and receive Internal Sales Orders and link Internal Moves to a service order along with RMAs and Sales Orders. The business value of this functionality is that it prevents losing track of items as they move from one location to
another, enables ad-hoc routing of material to the best processing location and reduces click count to create Internal Requisitions and Sales Orders.

**To move items internally:**

1. Navigate to the Find Service Requests window and select a Service Order to open the Service Orders window.

2. Select the Logistics tab.

3. Choose the Internal Move Orders option from the Actions drop down list and click Go.

Alternatively, click the Internal Orders button to navigate to the Internal Orders page. This button is enabled if at least one internal order for the service order exists.

The Move Items Internally page appears. The page displays the existing internal move orders linked to this service order. The Move Details region provides the ability to enter one or more serial numbers or a serial number range.

4. To create a new internal move order, click the New Internal Move button. The Create Move Orders page appears.
5. Enter the fields in the Internal Order Attributes region:
   - Item
   - Description
   - Quantity
   - Unit of Measure
   - Need By

6. Enter the Operating Unit and Inventory Organization in the Ship From region.

7. Enter the Operating Unit, Inventory Organization, and Location in the Receive Into region.

8. Optionally, specify the pick from (source) and receive into (Destination) subinventories.

9. Click Apply to create a new internal move order. A confirmation page appears. You cannot edit any fields once an Internal Sales order is created.

   The header of the Create Move Orders page populates with the following:
   - Order Number
   - Order Status
   - Requisition Number
   - Requisition Status
   - Quantity Shipped
• Quantity Received

10. In the Move Details region, choose the Range option to include the subsequent serial numbers in a continuous range. In the absence of a continuous range, it stops at the number after which the sequence is broken.

11. To Pick Release the internal sales order line, select the move order on the Move Items Internally page and click the Pick Release button. Provide the pick from subinventory or override the pick if subinventory has been previously provided. A confirmation message appears validating the pick release.

12. To Ship Confirm the internal sales order line, select the relevant move order and click the Ship Confirm button. A confirmation message appears validating the ship confirm.

13. You can receive the internal requisition associated with Internal sales order in the destination organization. If the shipping network between source and destination organization are set up as direct then the receipt automatically happens as part of ship confirm action in the source organization. Though the internal requisition is automatically received as part of ship confirm action, you must click the Receive button to refresh the receipt information in the depot schema. A confirmation message appears validating the receipt.

   Note: Users can specify the pick from subinventory and receive into subinventory at the following two stages:
   • During creation of internal orders.
   • During picking and during receiving using Internal Orders main page.

Additionally, you can perform partial shipments and partial receipts. For example, for an Internal Order with quantity of 5, the shipping clerk ships out only 3. In this case the destination organization receives these 3 into their inventory. Later when the remaining quantity of 2 is shipped out, the destination organization receives the remaining quantity.

Find Service Requests and Service Orders

On the Find ServiceRequests window, you can retrieve Service Requests or Service Orders from the database.

A search in Oracle Depot Repair enables you to retrieve Service Requests and Service Orders based on parameters related to a Service Request or Service Order (Number, Customer, Item, or Date Opened). You can use a combination of these parameters to restrict your search so as to retrieve only the Service Requests or Service Orders that
you want.

**Prerequisite**

The Service Request or Service Order record that you want to retrieve must exist in the database.

**Steps:**

1. In the Find Service Requests window, specify the parameters based on whether you want to search for the Service Request or Service Order.

2. The search parameters in the Service Request area include:
   - Request Number
   - Status
   - Customer Name
   - Customer Account
   - Date Opened
   - Item
   - Serial Number
   - Owner

The search parameters in the Service Order area include:

   - SO Number
   - RMA / Sales Order Number
   - Internal Order Number
   - Internal Requisition Number
   - PO Num
   - Project
   - Date Opened
   - Item
• Serial Number
• Status
• Job Name
• Project Task

**Note:** Performing a search based on these values searches for Project or Task values saved on the Service Order Details tab, and not the values stored on linked Sales Orders or WIP jobs.

3. Click Find to find matching Service Requests or Service Orders based on the parameters you have specified.

4. The Results region in the Find Service Requests window displays the search results. You can select any of the retrieved Service Requests or Service Orders, and click OK to view its details in the Service Orders window, generally known as the Depot Repair Workbench.
Transfer Installed Base Ownership

Transfer Installed Base Ownership function is performed in two ways:

- Changing ownership based on the service request
- Changing ownership on a service order

Changing ownership based on the service request

You can change the ownership based on the service request.

Prerequisite

You must set up Transfer Ownership from System Administrator Responsibility.

Steps:

1. Navigate to the Service Request region.
2. Enter an SR with Installed Base item instance owned by a party other than the SR party.

3. Save the SR.

4. Click OK when the system prompts you to change the ownership of instance.

5. Select Change Ownership option from the Tools menu.

6. Click Yes to commit the change in the decision window.

7. Save the SR.

From Installed Base query the instance number; you will find item’s owner name is changed to new one.

**Changing ownership on a service order**

You can change the ownership based on a service order.

**Prerequisite**

You must set up Transfer Ownership from System Administrator Responsibility.

**Steps:**

1. Navigate to the Service Request region.

2. Enter an SR without item details.

3. Enter Service Order details with item instance belonging to another customer other than the SR Party.

4. Save the SO.

5. Click OK when the system prompts you to change the ownership of instance.

6. Select Change Ownership option from the Tools menu.

7. Click Yes to commit the change in the decision window.

8. Save the SO.

From Installed Base query the instance number; you will find item’s owner name is changed to new one.

**Create and Maintain Notes**

Notes are used to record and manage the comments that the depot agents and
technicians generated against various services. Notes in a Service Request help in recording the descriptive information about customer service issues, any progress that the agent had done in resolving this issue, and so on. You can enter either Service Request or Service Order notes from the Details tab in the Depot Repair Workbench.

**Prerequisite**

A Service Order record must exist for an item before you can attach notes to the relevant Service Request or Service Order.

**Steps:**

1. Retrieve the Service Request or Service Order to which you want to attach a note. For more information, see Find Service Requests and Service Orders, page 4-30.

2. In the Results area of the Find Service Requests window, select the relevant result, and click OK.

   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. On the Details tab of the Service Order window, select Service Request or Depot Repair in the Notes area.

4. To open the Notes window, click Notes.

5. In the Type field, select a note type.

6. In the Status field, select a note status.

   The choices are: Personal, Internal, and Publish. If you use the Personal status, this note would not be viewable to any customer in a customer facing application. Employees at the depot can view Internal notes. All employees and customers can view Publish notes. You can create additional Status codes. For more information, see the Oracle Common Application Components Implementation Guide.

7. In the Note field, enter a brief description of the note.

8. To enter more notes, click the More button.

   The Detailed Note window opens and holds textual notes up to 32K characters.

9. After entering notes, click OK.

10. In the main Notes window, to specify more details for the note, specify the Related To and Value fields.

11. Save the note.
The note appears in the table under the Notes tab on the left. The Summary tab displays the notes as text in a chronological or reverse chronological manner. You can change the chronological view by clicking the Latest First check box.

12. To search for existing notes, use the Find Notes functionality.
   1. Open the Notes main window.
   2. Click the flashlight icon on the toolbar to open the Find Notes window.
   3. Enter the fields such as Source, Entered By, and so on.
   4. Click Search to display the results.

Use the Diagnostics Tab and Oracle Knowledge Management

The main purpose of the Diagnostics tab is to enable you to make use of solutions to previous problems stored in Oracle Knowledge Management. Oracle Knowledge Management is a repository of solution sets that have already been contributed. Solutions to previous incidents can guide users to resolve current problems at hand.

However, even if you have not installed Oracle Knowledge Management, you can still use the Diagnostics tab to select Service Codes, which enable you to automatically create estimate lines and default Bills and Routings for WIP Jobs.

This section consists of the following topics:

- Diagnostic Codes and Service Codes, page 4-36
- Using Diagnostic Codes and Service Codes with Oracle Knowledge Management, page 4-36
- Using Service Codes in the Service Order, page 4-36
- Diagnostics Tab Usage Overview, page 4-36

Diagnostic Codes and Service Codes

Depot repairs are generally repetitive in nature and the number of problems and resolutions is finite. As such, Oracle Depot Repair provides the ability to associate the potential problems with a Diagnostic Code, and to associate the potential resolutions with a Service Code. By utilizing Diagnostic Codes and Service Codes, users can quickly document service efforts for customer charges and depot service history.

For details of setting up Diagnostic Codes and Service Codes, see the Oracle Depot Repair Implementation Guide.
Using Diagnostic Codes and Service Codes with Oracle Knowledge Management

The association of Diagnostic Codes to Service Codes is done in Oracle Knowledge Management via Solutions. Once a Diagnostic Code is associated to a Service Code and that Service Code is linked to an Oracle Knowledge Management Solution, then the service work to be performed has been defined.

For details of associating Diagnostic Codes and Service Codes with Oracle Knowledge Management, see the *Oracle Depot Repair Implementation Guide*.

Using Service Codes in the Service Order

Oracle Depot Repair enables you to automate Service Order processing as follows:

- In WIP service mode, Oracle Depot Repair provides the ability to predefine work using Bills and Routings and any associated material, labor and expense charges. The user can retrieve the defined work using Service Codes. The Service Code association with Bills and Routings can be used to create material, labor and expense estimate lines as well as default routes to WIP Jobs.

- In Task service mode, Oracle Depot Repair provides the ability to predefine work using Task Templates and Task Parts and any associated material, labor and expense charges. The user can retrieve the defined work using Service Codes. The Service Code association with Task Templates and Task Parts can be used to create material, labor and expense estimate lines, and to create tasks.

For details of how Service Codes are used in the Service Order, see the following:

- Create an Estimate, page 4-51
- Create a WIP Job for a Single Service Order, page 4-73

Diagnostics Tab Usage Overview

The interface from Oracle Depot Repair to Oracle Knowledge Management is the Diagnostics tab, which is divided into three areas:

- Diagnostic Codes
- Solutions
- Service Codes

The following figure shows an overview of the standard use of the different areas of the Diagnostics tab.
Overview of Standard Diagnostics Tab Usage

Oracle Depot Repair: Diagnostics Tab

Problem ————> Resolution

Diagnostic Codes

Search for Solutions with Parameters:
(i) Selected Diagnostic Codes
(ii) Problem Summary
(iii) Service Order Item

Solutions

Display Solutions with Status
(i) Useful
(ii) Possibly Useful
(iii) Not Useful

Service Codes

Displays Service Codes

Oracle Knowledge Management

Yes

Maybe

No

For each chosen solution, is the solution useful?

if there are Service Codes associated with the Useful Solution(s)

* - "Not Useful" solutions appear in the Solutions area only if the value of the profile option Knowledge Action for negative Feedback Solution is Link Solution as Not Solved.

See Also

- Manage Diagnostic Codes in the Diagnostics Tab, page 4-39
- Search Oracle Knowledge Management, page 4-40
- Manage Solutions in the Diagnostics Tab, page 4-44
- Manage Service Codes in the Diagnostics Tab, page 4-46
Manage Diagnostic Codes in the Diagnostics Tab

Prerequisites

You must have set up Diagnostic codes and Service Codes in Oracle Depot Repair.
You must have associated the Diagnostic Codes and Service Codes to Solutions in Oracle Knowledge Management.
For details of setting up and associating Diagnostic Codes and Service Codes, see the Oracle Depot Repair Implementation Guide.

Steps:
1. Retrieve the Service Order that you want to process.
   For more information, see Find Service Requests and Service Orders, page 4-30.
2. If you are not already in the Diagnostics tab, click the Diagnostics tab.
3. If you do not want to provide any Diagnostic Codes as parameters to the search in Oracle Knowledge Management, continue at step 7.
4. Enter a Diagnostic Code manually or select a Diagnostic Code from the list of values.
   The list shows all Diagnostic Codes that have been associated with either the Item or the Item Category of the Service Order Item.
   For more information on setting up Diagnostic Codes, see the Oracle Depot Repair Implementation Guide.
   
   Note: If you enter an invalid Diagnostic Code, the list of values appears, which contains all the valid Diagnostic Codes for your Service Order.
5. Click the Select check box.
6. Repeat steps 4 to 5 for as many Diagnostic Codes as you want to display.
   
   Note: You may click the Select All or Deselect All as appropriate any time before you click Search Solutions.

   Note: Only the Diagnostic Codes that are explicitly selected are forwarded as search parameters to the Oracle Knowledge Management search.
7. Click Search Solutions.

This launches two windows:

- A Refresh linked Solutions box, with the message: Please press OK after searching for Solutions.

- An Oracle Knowledge Management window.

The window that is launched in Oracle Knowledge Management depends on the value of the profile option Knowledge: Search to display for integrating applications.

If the value of this profile option is Unified Search, then the window that is launched is a Simple Search window; if the value of the profile option is Advanced Search, then the window that is launched is the Advanced Solution Search Results window.

Continue the search process at the section Search Oracle Knowledge Management, page 4-40.

**Search Oracle Knowledge Management**

The search in Oracle Knowledge Management is the second stage of the completely integrated process which starts in the Diagnostics tab. This section concentrates on the Oracle Knowledge Management search itself, and how it provides feedback back into the Diagnostics tab.

This procedure follows immediately after you have clicked the Search Solutions button in the Diagnostics tab.

**Use of the Search Parameters in Oracle Knowledge Management**

The parameters passed to Oracle Knowledge Management to search for solutions are the following:

- All selected Diagnostic Codes
- Problem Summary
- Service Order Item

The search for solutions is performed as follows:

- The Diagnostic Codes and Problem Summary are used as search keywords in the title and body of the Solutions.
- The Service Order Item are used to match the specified item with the Related Items as set up in the Solutions.
By utilizing the profile option Knowledge: Search results include weighting from Product, Platform and Category filters, you can narrow or widen your search results.

When the profile option is set to No, the search results contain only Solutions matching the specified Product/Platform/Category.

When the profile option is set to Yes, the results can also contain Solutions that do not match the Product/Platform/Category specified -- the Solutions that do match the Product/Platform/Category are given a boost in the scoring algorithm.

**Note:** Oracle Depot Repair does not make use of platform and category filters in Oracle Knowledge Management.

For additional information on how to use Oracle Knowledge Management, please refer to the Oracle Knowledge Management User Guide.

**Search Result Examples**

Consider the following search parameters:

- Selected Diagnostic Codes = DC01, DC02.
- Problem Summary = Mouse Malfunction.
- Service Order Item = ITM342.

With the profile option Knowledge: Search results include weighting from Product, Platform and category filters set to No, you get the following results:

- All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction, and whose Related Items include ITM342.

With the profile option Knowledge: Search results include weighting from Product, Platform and category filters set to Yes, you get both of the following sets of results, with the first set having a higher score:

- All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction, and whose Related Items include ITM342.

- All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction.

**Prerequisites**

You must have started the search process by clicking the Search Solutions button in the Diagnostics tab.

For details, see Manage Diagnostic Codes in the Diagnostics Tab, page 4-39.
**Overview of Main Oracle Knowledge Management Search Procedure**

**Steps:**

1. You can optionally add and edit search parameters in the Oracle Knowledge Management search window, and then perform an explicit search.
   
   The net objective of the Oracle Knowledge Management search is to specify whether a solution is useful or potentially useful for the current service problem. To do this, you must first select a solution in a "search results" window, then access the solution details for that solution.

2. If you are in the Simple Search window, click the Title hyperlink of the potentially
useful solution in the Simple Search Result area. If you are in the Solution Advanced Search Results window, click the radio button beside the potentially useful solution, and click Full Solution.

In the Solution Details window, there is a section available for you to decide the usefulness of the solution. This section is the Feedback section, whose main constituent is the question "Is the solution useful in resolving your question or problem?"

**Note:** The Feedback section only appears if the solution has not already been linked to the current Service Order. However, after a user explicitly selects an answer to the usefulness question, then the next time the Solution Details window appears for that solution, the Feedback section does not appear.

3. In the Solution details window, scroll down to, and just beyond, the External Objects area.

4. If the Feedback section appears, then, you can optionally respond to the question "Is the solution useful in resolving your question or problem?", by clicking Yes, Maybe, or No.

   If you choose one of these options, a confirmation message appears, indicating that your feedback was recorded.

5. You may optionally continue in Oracle Knowledge Management, and select more Solutions for feedback to Oracle Depot Repair.

6. When you have finished in Oracle Knowledge Management, close the Oracle Knowledge Management window.

7. Click OK in the Refresh linked Solutions box.

   If you have linked any Solutions from Oracle Knowledge Management to a Service Order, they appear in the Solutions area of the Diagnostics tab. Additionally, Service Codes appear in the Service Codes area of the Diagnostics tab (if any exist).

### Providing Feedback into the Solutions Area of the Diagnostics Tab

In step 4, your response to the question "Is the solution useful in resolving your question or problem?" causes the following to occur in the Solutions area of the Diagnostics tab:

- If you answered Yes, then the solution appears with a Status of Useful.
- If you answered Maybe, the solution appears with a Status of Possibly useful.
• If you answered No, and if the value of the profile option Knowledge: Action for Negative Feedback Solution is Link Solution as Not Solved, the solution appears with a Status of Not useful.

Providing Feedback into the Service Codes Area of the Diagnostics Tab
If the Useful Solutions returned to the Solutions area have any Service Codes associated with them, then those Service Codes will appear in the Service Codes area, together with their associated Solution Number and with their Applicable check box set.

Manage Solutions in the Diagnostics Tab
The main use of the Solutions area is to change the status of Solutions returned from Oracle Knowledge Management searches, in order to influence the Service Code information in the Service Codes area.

When you change the Status of a Solution in the Solutions area to Useful, any Service Codes associated with that Solution in Oracle Knowledge Management appear in the Service Codes area, and are initially marked as Applicable.

Under the following conditions:
• The profile option CSD: Use Tasks from Knowledge Base Solutions is set to Yes
• The Solution in the Solutions area is marked as Useful
• The corresponding Solution in Oracle Knowledge Management has one or more Task Templates among its Related Objects

you can retrieve the associated Task Template charge lines into the Estimate tab by clicking Add Lines from Diagnostics.

For more details, see Create a Estimate, page 4-51.

Note: From the Solutions area, you may also return to Oracle Knowledge Management to view the solution details, by clicking the Details button.

Prerequisite
You must have previously performed an Oracle Knowledge Management search for the Service Order, and returned one or more Solutions into the Solutions area (see Search Oracle Knowledge Management, page 4-40)
Steps:

1. If you have not already accessed the Service Order, retrieve the Service Order that you want to process.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. Click the right-hand side of the Status field of a solution whose status you want to change.

4. Select a different status from the list of values.
   This enables the Update Status button.

5. Click Update Status.
   If, in steps 3 and 4, you changed the Status to Useful, existing Service Codes associated with the solution will appear in the Service Code area with the Applicable check box set on.
   Continue at step 6.

6. If, in steps 3 and 4, you "downgraded" the Status from Useful to Possibly useful or Not useful, then an Update Solution Status message box appears, presenting the following information:
   • Service Codes associated with the solution in the Service Codes area will be marked as not applicable.
   • You may delete the Service Code in the Service Codes area manually.

   Click OK in the Update Solution Status message box.
   This clears the Applicable check box for the associated Service Code in the Service Codes area.
   For details of deleting Service Codes in the Service Codes area, see Delete Service Codes Manually in the Service Codes Area, page 4-48.

7. Optionally, repeat steps 3 through 6 for each solution whose status you want to change.

   **Note:** You cannot delete any Solutions from the Solutions area, you can only change the status values of the Solutions.
Manage Service Codes in the Diagnostics Tab

The topics in this section include the following:

• Activate and Deactivate Service Codes Manually in the Service Codes Area, page 4-47

• Delete Service Codes Manually in the Service Codes Area, page 4-48

Select Service Codes Manually in the Service Codes Area

As part of Oracle Depot Repair implementation, when Service Codes are set up, they are associated with Items, Categories, a combination of Bills and Routings, and Task Template Groups.

The main usage of the Service Codes area in the Diagnostics tab is to enable the associated elements of the Service Codes to be added to the estimate lines and WIP Jobs of the current Service Order.

The Service Codes area is populated with Service Codes in one or more of the following ways:

• Automatically by Useful Solutions (see Search Oracle Knowledge Management, page 4-40).

• Manually, by selecting Service Codes from the lists of values in the Service Codes area - in this case, there is no associated Solution Number.

This section deals with the manual selection of Service Codes in the Service Codes area.

Prerequisites

You must have set up Service Codes in Oracle Depot Repair.

To make use of prior service knowledge, you must have associated Service Codes to Solutions in Oracle Knowledge Management.

For details of setting up and associating Diagnostic Codes and Service Codes, see the Oracle Depot Repair Implementation Guide.

Steps:

1. If you have not already accessed the Service Order, retrieve the Service Order that you want to process.

   For more information, see Find Service Requests and Service Orders, page 4-30.
2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. Select a Service Code from the Service Code list of values in the Service Codes area.

   This list of values that appears shows all the Service Codes that have been
   associated with either the service Item or the Inventory Category of the service
   item.

   For more information on setting up Service Codes, see the Oracle Depot Repair
   Implementation Guide.

4. In the Code field, either enter a Service Code, or select a Service Code from the list
   of values.

   **Note:** If you enter an invalid Service Code, the list of values
   appears, which contains all the valid Service Codes for your Service
   Order.

   By default, as each valid Service Code is entered or selected, its Applicable check
   box is set.

   Manually entered Service Codes do not have a Solution Number.

5. Repeat steps 3 to 4 for as many Service Codes as you want to display.

6. Save your changes.

**Activate and Deactivate Service Codes in the Service Codes Area**

You activate Service Codes in the Service Codes area by marking them as applicable.

Activating Service Codes in the Service Codes area enables the following subsequent
processing options:

- In the Estimate tab, after you have created a estimate header, you can add lines
  from the Diagnostics tab associated with the activated Service Codes in the Service
  Codes area.

  Charge lines can be added in for WIP mode services (if Bills and Routings are
  associated with the Service Codes) and for Task mode services (if Task Template
  Groups are associated with the Service Codes).

- In the Jobs tab, you can create a WIP Job with the Bills and Routings associated with
  the activated Service Codes in the Service Codes area.

For more information on setting up Service Codes, see the Oracle Depot Repair
Implementation Guide.
Prerequisites
You must have previously performed one or more of the following operations for the Service Order:

- Searched Oracle Knowledge Management, and returned one or more Service Codes into the Service Codes area (see Search Oracle Knowledge Management, page 4-40 and Manage Solutions in the Diagnostics Tab, page 4-44).

- Selected one or more Service Codes manually (see Select Service Codes Manually in the Service Codes Area, page 4-46)

Steps:

1. If you have not already accessed the Service Order, retrieve the Service Order that you want to process.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. In the Service Codes area, check the Applicable check box for each Service Code that you want to activate.

4. In the Service Codes area, clear the Applicable check box for each Service Code that you want to deactivate.

5. Save your changes.

Delete Service Codes in the Service Codes Area
You may delete Service Codes from the Service Codes area, whether they are marked as applicable or not.

**Note:** After the first time that you use Service Codes in a Service Order in either the creation of a estimate or the creation of a WIP Job, then the selected Service Codes are protected against deletion in that Service Order.

Prerequisites
You must have previously performed one or more of the following operations for the Service Order:

- Searched Oracle Knowledge Management, and returned one or more Service Codes
into the Service Codes area (see Search Oracle Knowledge Management, page 4-40 and Manage Solutions in the Diagnostics Tab, page 4-44).

- Selected one or more Service Codes manually (see Select Service Codes Manually in the Service Codes Area, page 4-46).

**Steps:**

1. If you have not already accessed the Service Order, retrieve the Service Order that you want to process.
   
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. In the Service Codes area, click the marker field to the left of the Service Code that you want to delete.

4. From the top menu, select Edit > Delete.

5. Optionally, repeat steps 2 through 3 for each Service Code that you want to delete.

6. Save your changes.

**Comments**

If you wish to reinstate Service Codes that you have deleted, then perform one of the following operations:

- Change the status of any associated solution in the Solutions area to Useful, as described in Managing Solutions in the Diagnostics Tab, page 4-44.

- Select and activate Service Codes manually, as described in Selecting Service Codes Manually in the Service Codes Area.

**Estimate Service Charges**

Some service organizations provide customers an estimate of the expected charges for providing service on returned items before performing the service. Only if the customer approves the estimated charges will the service organization invest the effort to provide service. The depot technician typically performs this by inspecting or performing a teardown of the item to determine the required parts and labor for the service. After completing this process, the depot provides a formal quotation to the customer for approval before any work is scheduled. During the teardown and inspection, the technician identifies parts that need repair or replacement, and estimates how long the work will take. Technicians can use historical frequency data, service bulletins,
knowledge management and other tools as aids during the evaluation.

**Note:** If you have set up the application to not use the Estimate functionality, by setting the profile option CSD: Enable Estimates to No, the Estimate tab in the Depot Repair Workbench is not available and you cannot create an estimate. For more information, see the note in the topic Estimate Tab, page 2-24.

### Pricing and Currency

To charge for services, a service provider can use standard pricing method using Price Lists to determine the fixed service price. Variable pricing method can also be used, which permits the depot to charge the customer for the actual material, labor, and other expenses incurred during the service.

In Oracle Depot Repair, a Service Order supports a single currency. The default currency is based on the default contract. If no default contract is selected, the default Price List determines the currency. If neither defaults are set, the currency selection is based on the Price List manually selected in the Details tab. After a charge line is created, you cannot change the currency of the Service Order in the Details tab, or select another default contract that has a Price List of a different currency. To change the currency of a Service Order, all the charge lines, including the Logistics lines, have to be deleted.

The Service Order currency drives the list of Price Lists that you can use for estimate charge lines. You cannot select a Price List with a currency that is different from the Service Order currency.

### Estimate Lines from Diagnostics

If you have Service Codes marked as applicable in the Diagnostics tab, and these Service Codes are associated with Bills, Routings, and Task Template Groups, then you can copy the following into the Estimate tab:

- Charge lines associated with the Bills and Routings for WIP mode services.
- Charge lines associated with Task Template Groups for Task mode services.

When you add in lines for WIP mode services through Service Codes, then, typically:

- Bill of Material items are added as Material lines.
- Resources associated to the Operations for BOM Routing are added as Labor lines.

When you add in lines for Task mode services through Service Codes, then, typically:

- Items specified in Task Parts in Spares Management are added as Material lines.
• Planned Effort elements for a Task Template are added as Labor lines.

Estimate Cost Analysis

While preparing an estimate, you can also perform estimate cost analysis. Estimate cost analysis lets you compare your estimated margins and profitability based on estimated costs and estimated charges. The only supported costing method is standard costing. The estimate cost analysis is always an aggregate of all estimated costs and charges for the Service Order.

Materials, labor, and expenses comprise the totals for charges or costs. Taxes and other fees are not included in cost analysis.

Costing of items differs in WIP and Task mode.

• In WIP mode, Item Cost is used for material, labor, and expense charges; however, if a Resource Cost exists, it is used for the Labor charge.

• In Task mode, Item Cost is used for material, labor, and expense charges; Resource Cost is not used.

To enable estimate cost analysis, the following conditions must apply:

• The profile option CSD: Enable Costing must be set to Yes.

• Each material, labor, and expense item must have an item cost defined in Oracle Inventory.

Estimate Approval

On the Details tab for a Service Order, you can check or uncheck the Estimate Approval Required field. If the check box is set, you must get customer approval for the estimate, and record this as a status change in the estimate.

The topics in this section include the following:

• Create a Estimate, page 4-51

• Revise a Estimate, page 4-56

• Obtain Customer Approval for a Estimate, page 4-57

Create an Estimate

The following procedures describe how to prepare a service charges estimate for the customer.

For information on estimates generated in the Technician Portal, see Generating Estimates, page 10-16, and Estimates Generates in the Technician Portal in the Estimate
Prerequisite

You must complete all steps in the relevant business scenario prior to creating the estimate. For more information, see Oracle Depot Repair Business Scenarios.

Steps:

1. Retrieve the Service Order for which you want to estimate charges.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant record from the Results area of the Find Service Requests window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.


4. Optionally enter the Status, Date, Lead Time, and UOM field values.
   For field descriptions, see the topic Estimate Tab, page 2-24.

5. Click Save Estimate to save the estimate header record.

6. You can enter estimate details in one or more of the following ways:
   • Manually, by entering individual charge line details in the multi-record table area.
     For field descriptions, see the topic Estimate Tab, page 2-24.
   • If you have previously selected and activated Service Codes in the Diagnostics tab, then you can click Add Lines from Diagnostics.
     This adds the charge lines associated with the active Service Codes in the Diagnostics tab, that is, the Service Codes marked as applicable.
     You can also add Task Template charge lines associated with Solutions if the following conditions are true:
     1. The profile option CSD: Use Tasks from Knowledge Base Solutions is set to Yes.
     2. At least one Solution in the Solutions area of the Diagnostics tab is marked as Useful, and the corresponding Solution in Oracle Knowledge Management has one or more Task Templates among its Related Objects.
     When these conditions are true and you click Add Lines from Diagnostics, you
retrieve the associated Task Template charge lines into the Estimate tab.

After you have clicked Add Lines from Diagnostics, the added lines appear in the Estimate tab, and an information window appears which records any errors and information about the lines added.

If the lines that you expect to be added do not appear, you should check a variety of factors associated with your Service Order and the data that you are trying to add in. See Checks for Adding Estimate Lines from Diagnostics, page 4-51.

For more information, see the topic Activate and Deactivate Service Codes in the Service Codes Area, page 4-47.

**Note:** After you have added the lines associated with the active Service Codes, the Service Code rows from which you derived the estimate lines are disabled in the Service Codes area of the Diagnostics tab.

7. After entering a charge line, click Save Estimate to record the charge line.

   The application populates the Unit Price and Est Charge fields in the table. The Summary of Estimated Charges region is also populated. This region is updated as you add (or delete) charge lines.

8. Optionally, click Costs to see an estimate cost analysis.

9. The Estimated Costs versus Estimated Charges window opens and shows the estimated Cost, the estimated Charge, the estimated Profit (Charge less Cost), and the estimated Profit Margin % by separate Material, Labor, Expense, and Total lines.

   Click Close to exit the Estimated Costs versus Estimated Charges window.

10. Click Line Details to display the Estimate Charge Details window.

    Enter the detailed charge line values in the table fields.

    For field descriptions, see the topic About Estimate Charge Line Details Window, page 2-24.

11. To allow provisioning for overriding the entered charges later, select the Override Charges check box.

    This is enabled if the profile option CSD: Allow Charge Override for Estimates is set to Yes.

    The Override Charges check box lets you override service charges, in the Estimated Charge field, after you have saved it. Discounts associated with the contract are not applied if you manually change the Estimated Charge.
12. Click Save to record the changes.

13. Click Close to close the Estimate Charge Details window, and return to the Estimate tab.

The Totals fields in the lower part of the Estimate tab show charge line totals.

14. To delete a charge line, select the relevant charge line on the Estimate tab, and click the Delete icon on the toolbar.

Please refer to Select Repair Parts from Dynamic Repair BOM Window, page 4-118 section to learn more about creating an estimate from Dynamic BOM window.

Comments

1. You cannot add or delete charge lines in the Estimate Charge Details worksheet. You can add or delete charge lines only in the Estimate tab.

2. If you have added estimate lines derived from a Service Code, using Add Lines from Diagnostics, then you cannot add the lines again from the same Service Code.

Checks for Adding Estimate Lines from Diagnostics

You should ensure that the following conditions are true before you add lines from the Diagnostics tab. Failure to satisfy all the conditions results in rows not being imported as estimate lines.

(A) General Checks

The following checks apply to all lines:

- You must have at least one active Service Code, that is, a Service Code marked as applicable, associated to the Service Order.

- The default Price List must be defined and active.
• The Billing Type for the item must be defined.

Note: You cannot add an estimate line from the same Service Code entry on the Diagnostics tab twice.

(B) WIP-Specific Checks

The following checks apply to WIP lines:

• The Service Code must be associated with at least one work entity (bill or routing), and each associated work entity must be defined for the organization specified by the profile option Service: Inventory Validation Organization.

• Each work entity must have a Bill of Material.

• Each operation sequence must have a Resource.

• Each Resource must have a billing Item.

(C) Task-Specific Checks

The following checks apply to task lines derived through Service Codes and, under profile control, directly from Task Templates related to Oracle Knowledge Management Solutions.

• Each work entity must have a Task Template Group.

• Each Task Template Group must have a Task Template.

• You must have a product part defined for the Task Templates and the Service Order Item.

• For a task parts definition, you should have a manual or a rollup quantity or both.

• If there is a substitute defined for a task part, the task part is not added as an estimate line.

• For labor lines only, for Planned Effort, you must have provided a value for the profile option CSD: Default Labor Item for Estimate Line from Tasks.

• For labor lines, the Planned Effort Interval and UOM for the Task Template must not be null.

(D) Tasks-from-Solutions Checks

In addition to the Task-Specific checks, the following additional checks apply to task
lines derived directly from Oracle Knowledge Management Solutions:

- The profile option CSD: Use Tasks from Knowledge Base Solutions must be set to Yes.
- The Solution in the Solutions area of the Diagnostics tab must have a Status of Useful.
- The corresponding Solution in Oracle Knowledge Management must have an active Task Template among its Related Objects.

Revise an Estimate

Certain services can require service providers to revise estimates many times. The service agent should verify existing warranties or contracts while quoting and revising estimates.

**Note:** If you manually override the Estimated Charge, which you are allowed to do if the profile option CSD: Allow Charge Override for Estimates is set to Yes, then discounts associated with the contract are not applied.

**Note:** Net Discount will always be the Extended Price minus the Estimated Charge, not the contract discount.

The following procedures describe how to revise the estimated charges for an item under service.

Prerequisite

A charges estimate must exist for the broken item.

Steps:

1. Retrieve the Service Order for which you want to revise the estimate.
   For more information, see Find Service Requests and ServiceOrders, page 4-30.
2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.
The existing charge lines appear in the multi-record area.

4. Click Line Details.
   
The Estimate Charge Line Details window opens.

5. Make the necessary changes to the charge line field values.
   For more information, see Estimate Charges, page 4-49.

6. Click Save to record the revised charges.

7. Click Close to close the Estimate Charge Line Details window and return to the Estimate tab.
   The charge lines and totals on the Estimate tab reflect the revision made to the estimate.

8. To change the estimate status, choose an appropriate value from the list of values in the Status field.

9. Click Save Estimate to record the changes.

**Obtain Customer Approval for an Estimate**

If estimate approval is required for an estimate, then, after creating the service charges estimate, the service agent seeks the customer's approval of the estimate.

Upon customer’s approval, the depot receives the defective parts in service subinventory. If the customer rejects the estimate, the Service Order can be closed, or put on hold as appropriate.

Service Order estimates can be New, Drafted, Bid, Accepted, Rejected, or Cancelled. These statuses indicate whether to start a service process. Typically, a estimate must be approved prior to the start of the WIP Job.

The following procedures describe how to record customer approval for an estimate.

**Prerequisite**

A Service Order record with an approved estimate must exist. Also, you must have revised the original estimate as appropriate.

**Steps:**

1. Retrieve the Service Order that you want to revise.
   For more information, see Find Service Requests and Service Orders, page 4-30.
2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.

The Depot Repair Workbench shows the selected Service Request and Service Order details.

The Details tab of the Depot Repair Workbench displays the total charges for the service in the Charges area.

3. Make changes to the original estimate charge lines as required.

For detailed instructions, see Revise a Estimate, page 4-56.

4. Discuss the revised charges with the customer.

5. In the Estimate tab, update the estimate Status to Estimate Accepted or Estimate Rejected.

6. Click the Save icon on the toolbar to save the updated status.

The Service Order is revised with the new charges and customer approval information.

7. On the Details tab, create or consult notes as required.

For detailed instructions, see Create and Maintain Notes, page 4-34.

8. Click Update SO Status.

In the Update Service Order Status window, you can update the Service Order status.

For details, see Update the Service Order Status, page 4-23.

9. Optionally, from the top menu, click Tools > Freeze Estimate to freeze the estimate.

After the estimate is frozen, you cannot change the estimate.

**Auto-Receive an Item**

When you receive an item into a subinventory, you generally have to perform a number of operations in several different windows (for example, find a receipt, edit one or more receipt fields).

If you accept the option to auto-receive the item, the auto-receive operation is performed. The most efficient way to receive items on the Logistics tab is to use the auto-receiving capability.

Under certain conditions, you can receive an item directly from the Logistics tab, without having to navigate through extra windows. The operation of receiving an item directly from the Logistics tab is called *auto-receive*.
The conditions under which you can auto-receive an item are as follows:

- The item can be serialized or non-serialized. If it is serial controlled, the serial must be entered.

- The item must be lot controlled. If it is lot controlled, the lot must be entered.

- The item must be locator controlled.

- The quantity on the RMA (Return) line is 1.

- The Receipt Routing must not be Inspection Required.

- You must enter the Source Serial Num and Subinv fields on the RMA (Return) line.

  **Note:** After the successful completion of the auto-receive operation, the Status of the RMA (Return) line is Booked. After you click Refresh Logistics, the Status changes to Received.

**Steps:**

1. When all the above conditions apply, in Logistics tab, select the Process Transaction check box for the row you want to receive.

2. Select Receive from the Actions list and click Go.

3. An alert message appears informing you that item is eligible for auto-receive. To confirm the auto-receive, select Yes to complete the receiving process.

  **Note:** For serialized items, enter the serial number on the logistics line for auto-receiving to function. If the item is locator controlled, the locator must be entered on the logistics line before auto-receiving. In cases where you want to use the Inspection functionality from Oracle Receiving, selects No when asked to auto-receive and complete steps described in Receive an Item, page 4-59.

**Receive an Item**

Oracle Depot Repair provides a number of options for receiving items from customers and third parties, as well as for receiving items from other warehouses or sub-inventory locations. The system allows items to be received with RMAs or without RMAs, and can even receive serialized items when the serial number is unknown at time of booking the return. All of this flexibility can be made more restrictive using profile options to match the service organization's business rules.
Before receiving an item the system allows you to receive a serial number different from the one originally entered in the service order. In case of a mismatch or discrepancy the system allows the receipt of the discrepant serial number and logs an activity to track the discrepancy.

**Inspection**

You can also inspect items during the receiving process, which allows for more accurate estimates as a result of inspection. Inspection of items is possible only if the routing on the RMA order is either Standard Receipt or Inspection Required.

The procedure for receiving an item with inspection is more extensive than the procedure for receiving an item without inspection.

The following is an overview of the procedure for receiving an item without inspection:

- Receive the item on the RMA order into a subinventory.

The following is an overview of the procedure for receiving an item with inspection:

- Receive the item on the RMA order into a receiving location.
- Inspect the item, then accept or reject it.
- Move the item into a subinventory.

The following procedures describe how to receive an item.

**Prerequisite**

You must complete all steps in the relevant business scenario prior to receiving the general item. For more information, see Oracle Depot Repair Business Scenarios.

**Steps:**

1. Retrieve the Service Order for which you want to receive the general item.
   
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
   
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. Select the Logistics tab in the Depot Repair Workbench.
   
   If the RMA (Return) line was not created and booked automatically for the Service Order, then create an RMA order manually.
   
   For detailed instructions, see Create and Book a Return Line Manually, page 4-25.
4. Click Receive to open the Find Expected Receipts window.

5. In the Customer tab in the Find Expected Receipts window, enter the RMA Number, and click Find.
   
   If the RMA is found, the application displays the Receipt Header and Receipts windows.

6. Confirm the Received By field of the Receipt Header window, that is, the person receiving the RMA.

7. Confirm the Receipt Date, and click the Save icon on the toolbar to obtain the system-generated Receipt Number.

8. Close the Receipt Header window.

   If you want to receive an item without inspection, continue at step 9.

   If you want to receive an item with inspection, continue at step 16.

**Receiving an Item Without Inspection**

   **Note:** For Direct Delivery Routings, you must receive an item without inspection. Inspection is optional if your routing is Standard Delivery or Inspection Required.

   However, for Inspection Required Routings, Oracle recommends that you perform the steps starting at step 16.

9. In the Receipts window, in the Lines tab, select the check box located beside the Qty field to confirm quantity.

10. For the Destination Type, select Inventory.

11. Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory location in this field from the list of values.

   If the general item is a serialized item, the Lot-Serial button on the Receipts window is enabled.

   1. Click Lot-Serial to display the Serial Number window.

   2. Enter the received Serial Number, and click OK.

   You can manually enter a Serial Number even if the number does not appear in the list of values.

12. Click the Save icon on the toolbar.

13. Close the Receipts window to return to the Depot Repair Workbench.
   The status of the RMA (Return) line changes to Received.

15. Optionally, you can see item reception details in the Activity window. From the top menu, select Data > Activity to open up the Activity window.
   This completes the procedures for receiving an item without inspection.

   **Receiving an Item With Inspection**

   **Note:** For Inspection Required Routings, Oracle recommends that you perform the inspection steps that follow.

16. In the Receipts window, in the Lines tab, select the check box located beside the Qty field to confirm quantity.

17. For the Destination Type, select Receiving.

18. Select a Location.

19. Click the Save icon on the toolbar.

20. Close the Receipts window.


22. In the Customer tab in the Find Receiving Transactions window, enter the RMA Number, and click Find.
   The Receiving Transactions window appears.

23. If there is more than one line, select the lien you want to inspect.

24. Click Inspect.

25. In the Inspection Details window, select the Status (values are either Accept or Reject).

26. Click OK.
   This closes the Inspection Details window.
   The Destination Type of the item shows as Inspect.

27. Click the Save icon on the toolbar.


30. In the Customer tab in the Find Receiving Transactions window, enter the RMA Number, and click Find.

The Receiving Transactions window appears, with the Destination Type of the item showing as Inventory.

31. Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory location in this field from the list of values.

32. If the general item is a serialized item, the Lot-Serial button on the Receiving Transactions window is enabled.

   1. Click Lot-Serial to display the Serial Number window.
   
   2. Enter the received Serial Number, and click OK.
      
      You can manually enter a Serial Number even if the number does not appear in the list of values.
      
33. Click the Save icon on the toolbar.

34. Close the Receiving Transactions window to return to the Depot Repair Workbench.

35. In the Logistics tab, click Refresh Logistics.

   The status of the RMA (Return) line changes to Received.

36. Optionally, you can see item reception details in the Activity window. From the top menu, select Data > Activity to open up the Activity window.

   This completes the procedures for receiving an item with inspection.

   **Note:** You can enable the functionality of updating the Service Order Status automatically once an item is received successfully. This is done by setting the profile option CSD: Enable Auto Update of Service Order Status upon Receiving to Yes. The profile option CSD: Default Service Order Status After Receiving will hold the value for the new status.

   Use caution in setting the profile option CSD: Default Service Order Status After Receiving to Yes, as only one status can be chosen irrespective of the item or service type used.

---

**Receive an Item for an Internal Order Refurbishment**

When a Service Order has been created in the Planner's Desktop of Spares Management, or an equivalent external agency, and the item or items are to be sent to an Oracle Depot...
Repair depot for processing, this type of service is called an internal order refurbishment.

**Note:** This is not the same as an internal party refurbishment, where the items to be refurbished belong to an internal party. For more information, see Create and Process an Internal Party Refurbishment, page 4-110.

If you do not select a subinventory for the item, the subinventory is derived from the picking rule defined in the profile option CSD: Default Pick Release Rule for Sales Orders.

In Oracle Depot Repair, the Service Order for each item or item instance to be refurbished contains two transactions, with action types Move In and Move Out. This section describes the Move In transaction.

The Move In transaction has two components:

1. First, the shipment stage, where the item is shipped from a source organization, such as Spares Management.

2. Then, the receiving stage, where the item is received into a depot subinventory.

In the shipment stage, if you do not select a subinventory for the item, the subinventory is derived from the picking rule defined in the profile option CSD: Default Pick Release Rule for Sales Orders.

The shipment stage includes a Pick Release process, and then either a manual Ship process or an automatic Ship Confirm process. When both Pick Release and Ship Confirm processes can be performed automatically, that is, without any manual Serial Number entry required, you can select whether to perform both processes separately one after the other, or in sequence automatically.

**Inspection**

During the receiving stage, you can also inspect the items to be refurbished, which allows for more accurate estimates as a result of inspection. Inspection of items is possible only if the routing on the requisition order is either Standard Receipt or Inspection Required.

The procedure for receiving an item with inspection is more extensive than the procedure for receiving an item without inspection.

The following is an overview of the procedure for receiving an item without inspection:

- Receive the item on the requisition order into a subinventory.

The following is an overview of the procedure for receiving an item with inspection:

- Receive the item on the requisition order into a receiving location.
• Inspect the item, then accept or reject it.
• Move the item into a subinventory.

Prerequisites

The Service Request and the associated refurbishment Service Order or orders must have been created in the Planner's Desktop of the Spares Management module of Oracle Field Service.

**Note:** It is possible to create demand for refurbishment using a module other than Oracle Field Service and to pass this demand to Oracle Depot Repair.

**Note:** The module must be able to create Internal Requisitions and associate them to Internal Sales Orders. However, Oracle recommends using the out-of-the-box integration to Oracle Field Service.

Steps:

1. Retrieve the Service Order for which you want to receive the item for refurbishment.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.

3. Click the Logistics tab.

4. Click any field of the Move In line to make that line current.
   The Status of the Move In line should be Booked.

Shipping the Item to be Refurbished from Spares Management

**Note:** The following description assumes that you select the automatic Pick Release option when processing the Move In line.

**Note:** Even if you select Ship Confirm as your first choice for processing the Move In line, the application automatically processes the Pick Release stage first, then the Ship Confirm stage.

Pick Release
5. Click the Process Trans check box for the Move In line.

6. Click the Automate order processing steps through check box.

7. Select the Pick Release radio button.

8. Click Process.

   The Status of the Move In line generally changes to Released.

   However, for a serialized item that has Serial Control which is either Predefined or At Receipt, the resulting Status depends on whether you are performing the Pick Release processing for the first time or the second time.

   1. The first time, you must enter a Serial Number, navigating through the Find Move Order Lines window that appears automatically, to the Transact Move Orders window.

      For details of the Find Move Order Lines window and the Transact Move Orders window, see the Oracle Inventory User's Guide.

      When you return from the Transact Move Orders window, the Status of the Move In line remains as Booked.

   2. The second time you perform the Pick Release process (steps 5 through 8), you do not have to enter any further data, and the Status changes to Released.

      To see the Serial Number that you entered during the first-time Pick Release processing in the (Source) Serial Num field on the Logistics tab, click Refresh Logistics, after you complete the second-time Pick Release processing.

9. Optionally, from the top menu, select Data > Activity to see the details of the item shipment in the Activity window.

   If there has been a mismatch between the Serial Number in the Move In line and the Serial Number you entered in the Transact Move Orders window, an alert message line appears in the Activity window, recording the two Serial Numbers. You must explicitly select Data > Activity to display the alert message.

   This completes the Pick Release processing.

   **Manual Ship or Ship Confirm**

10. For the case of a serialized refurbished item, whose Serial Control is At Sales Order Issue, the Ship Confirm button is disabled. In this situation, click Ship and enter the item’s Serial Number in Oracle Shipping Execution windows. For details of these windows, see the Oracle Shipping Execution User’s Guide.

    When you return to the Logistics tab, click Refresh Logistics. The Status changes to Shipped.

    This completes the manual ship processing for these special Move In lines.
Continue at step 16.

11. For all other cases, click the Process Trans check box for the Move In line.

12. Click the Automate order processing steps through check box.

13. Select the Ship Confirm radio button.

14. Click Process.

   When processing the Ship Confirm stage, you should wait until the concurrent program Interface Trip Stop has completed successfully before you click Refresh Logistics, to see the changed value of the Status.

   You can monitor the progress of the program by selecting Requests from the View menu on the toolbar, and selecting appropriate search criteria.

15. Click Refresh Logistics.

   The purpose of this is to update the Status on the Move In line, so that it reflects in Oracle Depot Repair the results of the procedures executed in other Oracle applications when you clicked Process.

   After the background concurrent process Interface Trip Stop has completed successfully, the Status changes to Shipped.

   **Starting the Process of Receiving the Item to be Refurbished**

16. Click any field of the Move In line to make that line current.

17. Click Receive to open the Find Expected Receipts window.

18. In the Supplier and Internal tab in the Find Expected Receipts window, enter the Requisition from the Requisition Num of the Move In line, and click Find.

   If the requisition is found, the application displays the Receipt Header and Receipts windows.

19. Confirm the Received By field of the Receipt Header window, that is, the person receiving the requisition.

20. Confirm the Receipt Date, and click the Save icon on the toolbar to obtain the system-generated Receipt Number.


   If you want to receive an item without inspection, continue at step 22.

   If you want to receive an item with inspection, continue at step 29.

   **Receiving the Item to be Refurbished Without Inspection**
22. In the Receipts window, in the Lines tab, select the check box located beside the Qty field to confirm quantity.

23. In the Destination Type field, select Inventory.

24. Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory location in this field from the list of values.

   If the item is a serialized item, the Lot-Serial button on the Receipts window is enabled.

   1. Click Lot-Serial to display the Serial Number window.

   2. Enter the received Serial Number, and click OK.

      You can manually enter a serial number even if the number does not appear in the list of values.

25. Click the Save icon on the toolbar to save the receipt record.


27. Click Refresh Logistics.

   The Status of the Move In line changes to Received.

28. Optionally, from the top menu, select Data > Activity to see the details of the reception of the item in the Activity window.

   This completes the process of receiving an item without inspection.

   **Receiving the Item to be Refurbished With Inspection**

29. In the Receipts window, in the Lines tab, select the check box located beside the Qty field to confirm quantity.

30. For the Destination Type, select Receiving.

31. Select a Location.

32. Click the Save icon on the toolbar.

33. Close the Receipts window.

34. Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

35. In the Supplier and Internal tab in the Find Expected Receipts window, enter the Requisition from the Requisition Num of the Move In line, and click Find.

   The Receiving Transactions window appears.
36. Click Inspect.

37. In the Inspection Details window, select the Status (values are either Accept or Reject).

38. Click OK.
   This closes the Inspection Details window.
   The Destination Type of the item shows as Inspect.

39. Click the Save icon on the toolbar.

40. Close the Receipt Transactions window.


42. In the Supplier and Internal tab in the Find Expected Receipts window, enter the Requisition from the Requisition Num of the Move In line, and click Find.
   The Receiving Transactions window appears, with the Destination Type of the item showing as Inventory.

43. Scroll the horizontal bar to reveal the Subinventory field, and select a Subinventory location in this field from the list of values.

44. If the item is a serialized item, the Lot-Serial button on the Receiving Transactions window is enabled.
   1. Click Lot-Serial to display the Serial Number window.
   2. Enter the received Serial Number, and click OK.
      You can manually enter a Serial Number even if the number does not appear in the list of values.

45. Click the Save icon on the toolbar.

46. Close the Receiving Transactions window to return to the Depot Repair Workbench.

47. In the Logistics tab, click Refresh Logistics.
   The status of the Move In line changes to Received.

48. Optionally, from the top menu, select Data > Activity to see the details of the reception of the item in the Activity window.
   This completes the procedures for receiving an item with inspection.
Split a Service Order

Often as a result of an inspection carried out during the receiving of an item, you may decide to service some but not all of the defective units.

Under certain conditions (see the Prerequisites that follow in this section, page 4-70), Oracle Depot Repair allows you to split a service order so that part of an order can be processed separately from the rest of the order.

Service Type Change Options

One of the prerequisite conditions is that the original Service Type must have a Service Type Ref value of either Standard or Repair and Return. You can change the Service Type on the new Service Order, so long as the final Service Type also has a Service Type Ref value of either Standard or Repair and Return.

**Note:** The explicit condition specifies the Service Type Ref attribute of the allowable Service Types. The seeded Service Types Standard and Return and Repair have the same Service Type Ref values as their Service Type names.

For details of setting up Service Types, see the Oracle Depot Repair Implementation Guide.

Splitting Options

When you choose to split a Service Order, you have the following options:

- You can split into two separate Service Orders, as for example when splitting 10 units into two lines of 8 and 2 units.

- You can split into multiple Service Orders, each with a quantity of 1.

When you choose to split the Service Order into two separate Service Orders, you can also decide whether to copy attachments from the original Service Order to the new Service Order.

When you split into multiple lines, each with a quantity of 1, all attachments on the original Service Order, if any exist, are automatically copied to each new Service Order.

Prerequisites

- The Service Order Item must be serialized.

- The item must not be Installed Base trackable.
• All quantities must be received.
• For WIP mode, all jobs must be completed, that is, no partial completions are allowed.
• The Service Order status must be Open.
• The Service Type Ref of the Service Type must be Standard or Repair and Return.
• No Ship lines have been interfaced to Oracle Order Management.

Steps:
1. Retrieve the Service Order that you want to split.
   For more information, see Find Service Requests and Service Orders, page 4-30.
2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
3. From the top menu, select Tools > Split Service Order.
   The Split Service Order window appears.
   Your splitting options are indicated by the two radio buttons:
   • Split into 2 lines
   • Split into lines with quantity of 1

Split into 2 Lines
Under the Split into 2 lines option, there is a table showing the following fields:
• Original Service Order Quantity (enabled)
• Original Service Order Service Type
• New Service Order Quantity
• New Service Order Service Type (enabled)

There is also a check box under the Split into 2 lines option, enabling you to copy attachments from the original Service Order to the new Service Order.

If there are no attachments to the original Service Order, the check box is disabled.

Split into Lines with a Quantity of 1
Under the Split into lines with a quantity of 1 option, a message indicates that any attachments to the original order will be automatically copied to the new order.
4. Select one of the radio buttons.

5. If you selected Split into lines with a quantity of 1, you have no further choices. Continue at step 7.

6. If you selected Split into 2 lines:
   
   1. Enter the Original Service Order Quantity, that is, the new quantity that you wish to have on the original Service Order after splitting.

      The New Service Order Quantity is automatically calculated after you enter the Original Service Order Quantity.

   2. Select the New Service Order Service Type.

      You can only select a Service Type whose Service Type Ref was set up as Standard or Repair and Return.

   3. Optionally, select the check box Copy attachments from original Service Order to new Service Order.

7. Click OK.

Manage the Service Process

Oracle Depot Repair lets service organizations manage service by using either Oracle WIP or Task Manager, a module in Oracle Common Application Components.

WIP mode is the recommended mode as it allows a service organization to take advantage of integration with Costing, Demand Planning, Service Parts Planning, Supplier Warranty Management and the Technician Portal. Task mode is still supported for businesses with extremely lightweight repair operations.

The WIP or Task modes are associated to the Service Types during implementation. Though a service organization can have different Service Types associated with different service modes, it is recommended that a service organization select only one service mode for all Service Types to enhance usability.

The topics in this section include the following:

- Create and Process WIP Jobs, page 4-72
- Create and Process Tasks, page 4-82

Create and Process WIP Jobs

The topics in this section include the following:

- Create a WIP Job for a Single Service Order, page 4-73
Create a WIP Job for a Single Service Order

The Shop Floor Technician can create a non-standard WIP Job from the Depot Repair Workbench. You select the organization for the WIP Job, and the items for the WIP Job must be defined in that organization.

Multiple jobs can be created for each Service Order. You can release WIP Jobs on to the shop floor. You must provide the WIP Accounting Class through which costs are posted to Oracle General Ledger.

Depot agents can view WIP Discrete Jobs window in a read-only mode to verify the status and additional details of the WIP Job.

The following procedures describe how to create a WIP Job for a single Service Order.

Prerequisites

You must complete all steps in the relevant business scenario prior to creating the WIP Job for the Service Orders. For more information, see Oracle Depot Repair Business Scenarios.

Note: You may need to create a Job without an RMA in case of remanufacture or refurbishment on items that your organization already owns, or if your organization took ownership or possession of an item through a field service agent rather than against an RMA.

Note: Oracle Depot Repair provides you with a profile option, CSD: Allow Creating WIP Job Without RMA, which enables you to create a WIP Job without an RMA. Refer to Oracle Depot Repair Implementation Guide for details.

Steps:

1. Retrieve the Service Order for which you want to create a WIP Job.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order...
3. In the Depot Repair Workbench, select the Jobs tab, and click Create Job.

The Submit Jobs window opens. The job you create will be in the organization set up when you perform the Change Organization operation. If you have not performed the Change Organization operation, the organization is taken from the profile option CSD: Default Repair Inventory Org.

4. If the WIP Job item is different from the Service Order Item, select the relevant WIP item from the list of values in the Item field.

5. Select the Released Job Status from the list of values.

   **Note:** The default value for this field is taken from the profile option CSD: Default Job Status.

   **Note:** You may submit a WIP Job with a Job Status of Unreleased. You will be able to change the status later using Oracle Work In Process transactions.

6. Select an Accounting Class from the list of values, for example, Rework.

7. Enter the number of items that you want to submit in the (Quantity) Submit field.

8. The system date defaults as Start Date. Select the Complete Date for the WIP Job.
9. In the Service Codes, Bills and Routings area, select one of the three radio buttons:
   - Use Service Codes
   - Select Bills and Routings
   - Do not Specify Bills and Routings

If you select Use Service Codes, the following occurs:
   - Bills and Routings associated with the active Service Codes, that is, the Service Codes marked as applicable, in the Diagnostics tab are attached to the WIP Job.
   - Read-only summary information about the Service Codes, Bills, and Routings is displayed in the Service Codes, Bills and Routings area.
   - After you have added the Bills and Routings associated with the active Service Codes, the Service Code rows from which you derived the Bills and Routings are disabled in the Service Codes area of the Diagnostics tab.

   **Note:** After you have added the Bills and Routings associated with the active Service Codes, the Service Code rows from which you derived the Bills and Routings are disabled in the Service Codes area of the Diagnostics tab.

If you select Select Bills and Routings, enter appropriate Bill and Routing data in the Bill and Routing sections.

If you select Do not Specify Bills and Routings, you are choosing not to provide any Bill and Routing information for the WIP Job.

10. Click Submit Job to submit the job in a released status to WIP.

11. To make sure that the program completes successfully, monitor the requests by choosing View > Requests.


13. Click Refresh Job.
   
   The new job appears on the Jobs tab.

14. To view the job, select the job record on the Jobs tab, and click View Job.

   To process the WIP Job, see Process a WIP Job for a Single Service Order, page 4-76.

**See Also**

Create a WIP Job Across Multiple Service Orders, page 4-77.
Multiple WIP Jobs and Partial Quantities for a Single Service Order

Oracle Depot Repair lets you create multiple WIP Jobs for a single Service Order and supports the creation of multiple WIP Jobs with partial quantities per RMA.

WIP Job Item Same As Service Order Item

If the item selected for the WIP Job is the same as the one in the Service Order, then for each WIP Job submission, the submit quantity cannot be greater than the quantity received. A submit quantity less than the quantity received implies that you can create multiple WIP Jobs against a single Service Order, with each WIP Job handling part of the RMA quantity.

For example, consider that the item on the Service Order is A, and the quantity of item A is 5. When you submit WIP Jobs for item A, the maximum number of units of A that can be submitted in a WIP Job is 5, and the minimum is 1.

WIP Job Item Different From Service Order Item

If the item selected for a WIP Job is different from the one on the Service Order, the submit quantity restriction does not apply, and you can submit the WIP Job for any quantity. The application validates this quantity with the quantity received in the Service Order line. In this case, the quantity to be submitted to WIP must be at least 1.

Process a WIP Job for a Single Service Order

The following procedures describe how to process a WIP Job that contains a single Service Order.

Prerequisite

You must complete all steps in the relevant business scenario prior to processing the WIP Job for the Service Order. For more information, see Oracle Depot Repair Business Scenarios.

Steps:

1. Retrieve the Service Order for which you want to process the WIP Job.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. In the Depot Repair Workbench, select the Jobs tab.
4. Click Material Txn to display the Material Transaction window.

5. Issue the item and the material required to process the WIP Job.
   For details, see Issuing and Returning Specific Components in the Oracle Work In Process User's Guide.

6. Complete the item service using a recommended service procedure.

7. When the service is complete, click Complete Job in the Jobs tab.
   The Completion Transaction Find window opens.
   Enter the completion details, such as quantity completed and completion subinventory, for the WIP Job.
   For details, see Completing and Returning Assemblies in the Oracle Work In Process User's Guide.


Post-Processing
1. To see information about the WIP Job activity, from the top menu, select Data > Activity.
   For more information, see View Activities Related to a Service Order, page 4-90.

2. After you have processed a WIP Job, if invoicing is required, you must move the data to Actuals.
   For more information, see Record Billing Data in Actuals, page 4-101.

Create a WIP Job Across Multiple Service Orders
Oracle Depot Repair lets service organizations automatically create a single WIP Job against multiple Service Orders for identical items.
You search for WIP Jobs issued for items that have already been received into the service organization. You can perform the search against the Item Code, or attributes that pertain to the linked Service Request.
You perform this operation in two stages:
1. First, you search for the Service Orders, in the Find Service Orders for Job Submission window.

2. Then, you determine how many units to submit for service for each Service Order, and submit the WIP Job, in the Submit Jobs for Service Orders window.
The Find Service Orders for Job Submission window incorporates a multi-select feature to let you select any or all Service Order lines that appear in the search results.

In the Submit Jobs for Service Orders window, you can specify the quantity of the item to submit for each Service Order, and optionally, select Bills and Routings.

The following procedures describe how to create a WIP Job for multiple Service Orders relating to the same item.

**Prerequisite**

You must complete all steps in the relevant business scenario prior to creating the WIP Job for the Service Orders. For more information, see Oracle Depot Repair Business Scenarios.

**Steps:**

1. Select the relevant Service Organization from the list of values.
   
   Find Service Orders for Job Submission Window.
   
   The Find Service Orders for Job Submission window opens.
   
   For field descriptions, see Find Service Orders for Job Submission Window, page 2-50.

2. Enter one or more search criteria by using one or more of the following fields:
   
   • (Service Request) Request Num
   
   • (Service Request) Customer
   
   • (Service Request) Account
   
   • (Service Request) Severity or Urgency
   
   • (Service Order) Item
   
   • (Service Order) Promise Date or Date Range
   
   • (Service Order) Create Date or Date Range
   
   This is a sample list of the search parameters.
   
   For descriptions of all the fields, see Find Service Orders for Job Submission Window, page 2-50.

3. Click Find to start the query.
   
   The search results appear in the Results area of the Find Service Orders for Job Submission window.
4. Select the relevant Service Order or combination of Service Orders.
   • To select all the rows, click Select All.
   • To select multiple, non-continuous rows from among the search results, press and hold the Control key, and click each row.
   • To select a complete range of rows from among the search results, click the first row of the range, then press and hold the Shift key, and click the final row of the range.
   • To deselect all rows, click Deselect All.

5. After you select the relevant rows, click OK.
   Submit Jobs for Service Orders Window.
   The Submit Jobs for Service Orders window opens.
   The selected rows populate the Service Order Information area in the window, and the Total Quantity Submitted for service automatically appears.
   For field descriptions, see Submit Jobs Window, page 2-53.

6. In the Job Status field, select Released from the list of values.
   You may submit a WIP Job with a Job Status of Unreleased. You will be able to change the status later using Oracle Work In Process transactions.

7. Select an Accounting Class from the list of values, for example, Rework.
   Your organization determined these values during implementation of Oracle Depot Repair.

8. The system date defaults as Start Date. Select the WIP Complete Date.

9. In any line of the Service Order Details tab, you can optionally change the number of units to submit in the (Quantity) Submit field.

10. You can optionally click the Bills and Routings tab, and select one of the radio buttons:
    • Select Bills and Routings
    • Do not Specify Bills and Routings
   If you choose Select Bills and Routings, then you must select at least one Bill or Routing.

11. Click Submit Jobs to submit the job in a released status to WIP.
12. To verify that the program completes successfully, monitor the requests by choosing View > Requests from the toolbar.

13. Close the Submit Jobs for Service Orders window and return to the Navigator. Refresh Job for Each Service Order.

14. Retrieve these Service Orders by using the Find Service Orders window.

15. In the Depot Repair Workbench, select each Service Order, and click Refresh Job. The new job appears on the Jobs tab.

For more information, see Update Service Orders Concurrently, page 4-92.

Comments

After you have created and submitted a WIP Job for identical items across multiple Service Orders, you can process the WIP Job.

For more information, see Process a WIP Job Across Multiple Service Orders, page 4-80.

See Also

Create a WIP Job for a Single Service Order, page 4-73

Process a WIP Job Across Multiple Service Orders

The following procedures describe how to process a WIP Job containing multiple Service Orders. Processing a WIP Job across multiple Service Orders involves the following areas:

- Find Discrete Jobs Window, page 4-81
- Material Transactions Window, page 4-81
- Completion Transactions Window, page 4-82
- WIP Jobs and Schedules Window, page 4-82

Prerequisite

You must complete all steps in the relevant business scenario prior to processing the WIP Job for the Service Orders. For more information, see Oracle Depot Repair Business Scenarios.
Steps:

Find Discrete Jobs Window

1. Enter the WIP Job Number, and click the Find button. The Discrete Jobs window opens.
2. Confirm that the Job is in Released status.
3. Click the Routing Tab and select the Completion Subinventory from the list of values.
4. If the item is under Locator control, enter the Locator value.
5. Save your work.
6. Close the Discrete Jobs window to return to the navigator.

Material Transactions Window

2. Select the Specific Component option if the material to be issued is not defined as a material requirement for the job.
3. Enter the WIP Job Number, and click the Continue button. The WIP Component Issue window opens.
4. In the Components Issue window, enter the Items to be serviced. If you did not select the Specific Component option, and the material you want to issue is not defined as a material requirement for the job, you might not be able to issue the item.
5. Select the present Subinventory location of the items.
6. If the items are Locator controlled, enter Locator information.
7. Enter the Quantity to be serviced.
8. If the items are under Serial or Lot control, enter Serial or Lot information.
9. Enter the material needed to assist the service.
10. Click Done.
This issues the material and closes the window.

11. Close the Material Transactions window to return to the Navigator.

Completion Transactions Window

1. After completing the, navigate to WIP > Material Transactions > Completion Transactions.
   The Completion Transactions window opens.

2. Enter the WIP Job Number, and click the Continue button.

3. Enter the completed quantity and the completion subinventory if you did not enter this information previously.

4. If the items are Locator, Serial, or Lot controlled, and you entered such information previously, enter these values.

5. Click Done to perform the completion transaction and return to the Depot Repair Navigator window.

WIP Jobs and Schedules Window

1. Navigate to WIP > Discrete > WIP Value Summary.
   The WIP Jobs and Schedules window opens.

2. Enter the WIP Job Number, and click Find.
   The WIP Jobs and Schedules window opens.

3. Enter the From Period and To Period information.

4. Click Value Summary.
   The WIP Value Summary window opens.

Create and Process Tasks

Tasks consist of work assignments that detail the actions required of company personnel.

The Tasks tab in the Depot Repair Workbench provides a solution for service establishments that use simple, standard business processes without requirements for WIP-based processes. The Tasks module is accessed (Tasks tab is enabled or disabled) depending on the Service Type selected in the Depot Repair Workbench Details tab.

In the Tasks tab, you can create, update, assign, and view previous tasks assigned to a
Service Order. Tasks assigned previously appear in the table in the upper part of the tab, while details of the selected task appear in the fields below it. You can create a task directly from the Tasks tab by entering all the relevant information, or by using a template.

**Using Quality Collection Plans with Tasks**

You can assign Oracle Quality collection plans to tasks, through setups to be performed in Oracle Quality.

For general information about collection plans, see the Oracle Quality User’s Guide.

**Tip:** When creating the collection plan, copy the elements from the Template Depot Task Plan as a starting point.

To link a collection plan with a task, you must select Depot Repair Task Transaction as a Quality Collection Transaction. You may choose to make this transaction mandatory: this will require Oracle Depot Repair users to enter quality results before they close the task.

You can also set up one or more collection triggers to specify conditions under which the collection plan is to be assigned to tasks.

In Oracle Depot Repair, you must enter the quality results for mandatory plans. For details, see Enter and Update Task Details, page 4-87.

**Task Debrief**

On the Tasks tab, you can click the Debrief button to display Material, Labor, and Expense forms. You can debrief a job with actual Material, Labor, and Expense service charges.

For jobs that you have managed using Tasks, the Debrief provides the actual charges incurred during the service that would be invoiced to a customer. If both estimate and debrief exists for a service that you have managed using Tasks, the customer is invoiced based on charges that appear in the debrief.

The topics in this section include the following:

- Create a Task Manually, page 4-84
- Create a Task Using the Task Template, page 4-85
- Enter and Update Task Details, page 4-87
- Prepare the Tasks Debrief, page 4-89
Create a Task Manually

The following procedures describe how to create a task manually.

Prerequisites

You must complete all steps in the relevant business scenario prior to creating the tasks for the Service Order. For more information, see Oracle Depot Repair Business Scenarios.

Steps:

1. Retrieve the Service Order for which you want to create tasks.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. In the Depot Repair Workbench, click the Tasks tab.
   If tasks have already been defined for the Service Order, the table lists the tasks. If more than one task appears, selecting a different task displays the corresponding detail in the lower fields on the tab.

4. Enter the task information in the required fields by selecting from the list of values.
   For field descriptions, see The Tasks Tab, page 2-37.

5. Enter the values in the Assignee and Owner fields (or change them) by selecting from the list of values.
   You can also change the Assignee field values from the Assignment Manager. To access the Assignment Manager, click the Assignment Manager button next to the fields. For additional information about the Assignment Manager, see Oracle
6. Choose the Planned Start and End Dates.

7. Click the Save icon to save the task record. A system-generated Task Number populates the Num field.

8. Optionally, you can click Add Tasks from Diagnostics. This adds tasks from task template groups associated with the service codes marked as applicable in the Diagnostics tab.

9. To manually launch workflow, select the task from the table, and click Launch Workflow.

   Based on the task, the workflow runs. The designated resources are reserved, and the workflow notifies the task owner of task creation through email.

   **Note:** The Launch Workflow button is available only if resources have been assigned to the selected task.

10. To add or update task details, click More. The Task Details window opens.

    For more information, see Enter and Update Task Details, page 4-87.

### Create a Task Using a Task Template

The following procedures describe how to create a task using a Task Template.

**Prerequisites**

You must complete all steps in the relevant business scenario prior to creating the tasks for the Service Order. For more information, see Oracle Depot Repair Business Scenarios.

Before you create a task from a Task Template, a template design must exist.

**Steps:**

1. Retrieve the Service Order for which you want to create tasks.

   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.

   The Depot Repair Workbench shows the selected Service Request and Service
Order details.

3. In the Depot Repair Workbench, select the Tasks tab.
   If tasks have already been defined for the Service Order, the table lists the tasks. If more than one task appears, selecting a different task displays the corresponding detail in the lower fields on the tab.

4. On the Tasks tab, click Use Template.
   The Create Tasks from Template Group window opens.

5. In the Template Group field, select the Template Group based on the task which is to be created.
   Values in the Source Document, Source Name, Owner Type and Owner fields are default values. You can change these values.

6. Click Create Tasks.
   The Tasks tab opens and displays a new task line that shows a system generated Task Number in the Num field.

7. To manually launch workflow, click Launch Workflow.
   Based on the task, the workflow runs. The designated resources are reserved, and the workflow notifies the task owner of task creation through email.

   **Note:** The Launch Workflow button is available only if a resource
has been assigned to a selected task.

8. Click More to open the Task Details window to enter details such as resource assignments, dependencies, references, and contacts.

For more information, see Enter and Update Task Details, page 4-87.

**Enter and Update Task Details**

After a task record is created, you can update task information and task details. The following procedures describe how to update task information and to add task details.

**Prerequisite**

Task records that you want to update or add details to must exist in the database.

**Steps:**

1. Retrieve the Service Order for which you want to update task details.
   
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.

3. The Depot Repair Workbench shows the selected Service Request and Service Order details.

4. In the Depot Repair Workbench, select the Tasks tab.
   
   If tasks have already been defined for the Service Order, the table lists the tasks. If more than one task appears, selecting a different task displays the corresponding detail in the lower section of the window.

5. To update task information, make the necessary changes to the field values, and click the Save icon.
   
   For field descriptions, see the Tasks Tab, page 2-37 topic.

**Entering Quality Results**

6. If your task has any mandatory collection plans associated with it, you will not be able to set the task Status to Closed unless you first enter quality results for the task. To do this, either click the Enter Quality Results icon in the toolbar, or select Tools > Enter Quality Results; then enter the information required.

**Specifying Task Details**
7. To specify task details, select the task for which you want to update details, and click More.

The Task Details window opens. The Task Details window comprises the following tabs:

- Resources: Assign personnel information to a task. This tab defines resource requirements, assignments, and scheduling information.

- Dependencies: Determine the order of tasks. Oracle Depot Repair, however, does not enforce task dependencies.

- References: Link the task to different documents or tasks with pertinent background information.

- Dates: Identify more dates in addition to the planned dates, the scheduled dates, and the actual dates. You can track task progress by entering dates after task milestones such as task creation, resource reservation, or task completion.

- Contacts: Create and manage multiple contacts assigned to a task. Contact information is obtained from customer information. To enter this information, you must identify a customer in the main task window.

- Recurrences: Schedule tasks so as to occur automatically. Examples of intervals include daily, weekly, monthly, or yearly occurrences. To schedule recurring tasks, you must either specify a start date and the number of tasks to create, or the end date. The task dates are populated as the planned start and end dates.

- Others: Identify additional information about the task, and select different configurations for each task. Setting flags customizes each task according to business needs.

- Audit: Track each update to a task. The tab documents and dates the history of task change, and provides a trail from the original task through to the current task status.
8. Enter the field values on the different tabs as required.
   For detailed instructions, refer to the Task Manager topic in Oracle Common Application Components User's Guide.

9. Click OK to save your work and return to the Tasks tab in the Depot Repair Workbench.

**Prepare the Tasks Debrief**

On the Tasks tab, you can click the Debrief button to display the Debrief Report, with Material, Labor, and Expense tabs. You can debrief a job with actual Material, Labor, and Expense service charges.

For jobs that you have managed using Tasks, the Debrief provides the actual charges incurred during the service that would be invoiced to a customer. If both estimate and debrief exists for a service that you have managed using Tasks, the customer is invoiced based on charges that appear in the debrief.

*Note:* The Debrief Report form does not let you apply contracts per charge line. If you are using the Debrief Report form to generate charges, the system automatically applies the contract at the Service Request level to the charge line.

The following procedures describe how to create the Debrief. This procedure is
applicable only to service processes that you have managed by using Tasks.

**Prerequisite**

You must complete all steps in the relevant business scenario prior to creating the tasks for the Service Order. For more information, see Oracle Depot Repair Business Scenarios.

**Steps:**

1. Retrieve the Service Order for which you want to update task details.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant record from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. In the Depot Repair Workbench, select the Tasks tab.
   If tasks have already been defined for the Service Order, the table lists the tasks. If more than one task appears, selecting a different task displays the corresponding detail in the lower section of the window.

4. Select the task for which you want to create the report, and click Debrief.
   The Debrief Report window shows the selected task details populated in the fields at the upper part of the window. The lower half of the window comprises the Material, Expense, and Labor tabs.

5. Select the Material tab to enter required details of material transactions of the task.

6. Select the Expense tab to enter required details of other expenses of the task.

7. Select the Labor tab to enter required labor transaction details of the task.

8. Click Update to save the details.
   For detailed instructions and discussion on buttons and check boxes accessible from the Debrief Report window, refer to Oracle Field Service User Guide.

**View Activities Related to a Service Order**

The Activity window displays a real-time view of events and activities that surround a Service Order. This permits the depot agents and planners to know the exact status of each Service Order line.

The following procedures describe how to view the activities that have elapsed at the
depot in association with a Service Order.

Prerequisite

None

Steps:

1. Retrieve the Service Order for which you want to view the elapsed depot activities.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. From the top menu, select Data > Activity.
   The Activity window displays the quantity received, quantity submitted to WIP, quantity completed in WIP, and quantity shipped. It also displays individual events, event dates, quantity, and other details. For detailed field descriptions, see Activity Tab, page 2-48.
   
   **Note:** The fields, Quantity Submitted to WIP and Quantity Completed in WIP, appear only for services processed in WIP mode. However, when quantities are submitted in WIP mode across Service Orders, these Quantity fields do not contain valid values.

4. If the Activity window does not display the updated information that you expect, you may need to run the appropriate information update program:
   - Click the Logistics tab, then click Refresh Logistics.
   - Click the Jobs tab, then click Refresh Job.
Note: The programs triggered by the Refresh Logistics and Refresh Job buttons update the activity information only for the Service Order currently selected in the Depot Repair Workbench.

For more information, see Update Service Orders Concurrently, page 4-92.

Update Service Orders Concurrently

The following concurrent programs update all the open Service Orders at the same time:

- Depot Repair Job (WIP) Update
- Depot Repair Receipt Update
- Depot Repair Shipment Update

To access these programs, from the Depot Repair Navigator, navigate to:

Depot Repair > Other > Run Requests.

The Submit a New Request window opens. In the Submit a New Request window, you can choose to submit a single request. When you submit a single request, the Submit Request window opens. In the Name field, select the program that you want to run. Choices include Depot Repair Receipt Update, Depot Repair Job (WIP) Update, or Depot Repair Shipment Update. You also specify to update quantity received, quantity submitted to or completed in WIP, and quantity shipped respectively, for all open Service Orders.

In the remaining fields, you can schedule the program to run at times or intervals of your choice, choose whom to notify on completion, and choose whether to print or save the reports. For more information, refer to the online help available from these windows.

The Depot Repair Receipt Update concurrent program picks only the receiving lines that are delivered to a subinventory. This is to support business scenarios that involve quantity correction of goods received at the dock.

For example, during the inspection of goods received at a dock, you can correct or return some quantity of the goods delivered. This could be because not as many items were sent as the customer said they would, or the customer returned more than expected, such as, goods that were too damaged to qualify for a refund, or goods that your organization did not sell. Items are not considered as received until they pass the inspection, and are delivered to a subinventory. Only at this point does the Depot Repair Receipt Update concurrent program stamp the received quantity and show the change in the received quantity.
Send and View Workflow-Based Messages

At a high level, the Workflow-based Messaging functionality provides the ability to send a workflow notification message, and have that message link to the Service Order selected in the Depot Repair Workbench at the time the message was sent. Messages can be of various types, from information-only to those that request actions or approvals from others. When the message recipient responds to the message linked to the specified Service Order, that response is captured in the Service Order’s message history. A message can be sent to one or many recipients, and can be sent to group lists. Messages sent to multiple recipients can only be informational messages.

In Oracle Depot Repair, messages are tied to a Service Order, and are sent from the Service Orders form.

For more information on message types, sending, receiving, and viewing messages, and user procedures, see the Oracle TeleService User Guide and Oracle TeleService Implementation Guide.

Create a Ship Line Manually

The following procedures describe how to create a Ship line manually.

Prerequisites

You must complete all steps in the relevant business scenario prior to creating a ship line manually. For more information, see Oracle Depot Repair Business Scenarios.
Steps:

1. Retrieve the Service Order for which you want to create the Ship line manually.
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. Select the Logistics tab in the Depot Repair Workbench.

4. In the Action Type field, select Ship.

5. Select the fields for the Ship line.
   The main fields that you must select are Action Code, Service Activity, and Price List.
   Note also the Add to Order field. Oracle Depot Repair lets you place all Return (RMA) and Ship lines on the same order.
   By default, all Return (RMA) and Ship lines appear on the next-highest Order Number created when the lines are transferred to Order Management.
   You can also select the specific order for the Return (RMA) or Ship line by selecting the Order Number in the Add to Order field before interfacing the specified line to Order Management.
   For field descriptions, see Logistics Tab, page 2-12.

6. Click the Save icon on the toolbar to save the record.
   The Ship line is created with the Status of Entered.

Ship an Item

Depending on the business scenario, an item being shipped might be serviced. Shipments can include serviced, replacement, loaner, or exchange items.

If you do not select a subinventory for the item, the subinventory is derived from the picking rule defined in the profile option CSD: Default Pick Release Rule for Sales Orders.

The Ship line that corresponds to the shipment goes through several stages of processing, and at each stage the Status is updated. The Status values that it passes through are Entered, Submitted, Booked, Released, and Shipped.

You may go through each processing stage one stage at a time, or process several stages in sequence automatically.
**Enter Order (Submit to Oracle Order Management)**

After a Ship line is created, its first Status is Entered.

When you submit the line to Oracle Order Management, and it is successfully interfaced, it gets an Order Number returned from Oracle Order Management, and its Status changes to Submitted.

After the Ship line has been interfaced with Oracle Order Management, it cannot be deleted. However, the ship line can be canceled by selecting Cancel Order Line from the Actions menu in the Logistics Tab and clicking Go.

**Note:** It is not necessary to enter an order as a separate step from booking the order. Most businesses book the order, which automatically enters the order in Order Management as part of the booking process.

**Book Order**

In this stage, the line must be booked in Oracle Order Management. The main effect of this in Oracle Depot Repair is that the Status of the line changes to Booked.

**Pick Release**

During the Pick Release processing, the application reserves the exact items to ship. The Status of the Ship line at the end of the Pick Release stage changes to Released.

[For serialized items whose Serial Control is either Predefined or At Receipt, you are required to perform the Pick Release processing twice:

- The first time, you must enter the Serial Number in a separate Oracle Inventory window, but the Status of the Ship line remains as Booked.

- The second time, you automatically upgrade the Ship line Status to Released.]

**Ship Confirm**

At the end of the Ship Confirm stage, the item has been shipped and the Status of the line changes to Shipped.

**Automatic Processing of a Ship Line**

The standard way to process a Ship line for a general item is as follows:

1. Decide the stage you want to reach.

2. Click the Automate Order Processing steps through check box.
3. Select the radio button which corresponds to the stage you want to reach:
   • Enter Order
   • Book Order
   • Pick Release
   • Ship Confirm

4. Click Process.
   
   **Note:** You can optionally process the last stage, that is, with the Ship line in the Released status, by clicking the Ship button, and then entering data in Oracle Shipping Execution windows. For details of these windows, see the *Oracle Shipping Execution User’s Guide.*

**Prerequisites**

You must complete all steps in the relevant business scenario prior to shipping the general item. For more information, see Oracle Depot Repair Business Scenarios.

**Steps:**

1. Retrieve the Service Order for the item that you want to ship.
   
   For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant order from the Results area of the Find Service Orders window, and click OK.
   
   The Depot Repair Workbench shows the selected Service Request and Service Order details.


4. Click any field of the Ship line to make that line current.

5. Click the Process Trans check box.


7. Select one of the following radio buttons:
   • Enter Order
- Book Order
- Pick Release
- Ship Confirm

8. For the special case where you have chosen Ship Confirm, for a serialized item whose Serial Control is At Sales Order Issue, enter the Source Serial Number.

9. Click Process.

   Depending on how many stages you have chosen to perform, a variety of procedures are performed.

   In all cases, acknowledge the message in any message window that appears.

Enter Order

If, at step 7, you chose Enter Order, the Status changes to Submitted.

Book Order

If, at step 7, you chose Book Order, the Status changes to Booked.

Pick Release

If, at step 7, you chose Pick Release, the Status changes to Released.

Pick Release for Items with Serial Control Predefined or At Receipt

For a serialized item that has Serial Control which is either Predefined or At Receipt, the resulting Status depends on whether you are performing the Pick Release processing for the first time or the second time.

1. The first time, you must enter a Serial Number, navigating through the Find Move Order Lines window that appears automatically, to the Transact Move Orders window.

   For details of the Find Move Order Lines window and the Transact Move Orders window, see the Oracle Inventory User’s Guide.

   When you return from the Transact Move Orders window, the Status of the Ship line remains as Booked.

   Repeat the Pick Release processing (steps 5 through 9).

2. The second time you perform the Pick Release process, you do not have to enter any further data, and the Status changes to Released.

10. To see the Serial Number that you entered during the first-time Pick Release processing in the (Source) Serial Num field on the Logistics tab, click Refresh Logistics, after you complete the second-time Pick Release process.
11. When the Status of the Ship line is Released, the Pick Release stage is complete.

   **Ship Confirm**

   When processing the Ship Confirm stage, you should wait until the concurrent program Interface Trip Stop has completed successfully before you click Refresh Logistics, to see the changed value of the Status.

12. You can monitor the progress of the program by selecting Requests from the View menu on the toolbar, and selecting appropriate search criteria.

13. Click Refresh Logistics.

   The purpose of this is to update the Status on the Ship line, so that it reflects in Oracle Depot Repair the results of the procedures executed in other Oracle applications when you clicked Process.

   If, at step 7, you chose Ship Confirm, and the background concurrent process Interface Trip Stop completes successfully, the Status changes to Shipped.

14. When the transaction is completed, you can optionally view the shipping information in the Activity window, by selecting Data > Activity from the top menu.

**Move an Item to a Usable Spares Subinventory**

In Oracle Depot Repair, after a refurbished item has been received from the Spares Management warehouse and serviced, it is ready to be shipped back to Spares Management.

   **Note:** Spares Management is a module of Oracle Field Service.

If you do not select a subinventory for the item, the subinventory is derived from the picking rule defined in the profile option CSD: Default Pick Release Rule for Sales Orders.

You must process the item through the Pick Release and a Ship stages. These stages are similar to the Pick Release and Ship Confirm stages for shipping a general item.

Where both options are allowed (that is, where the equivalent radio buttons are both enabled), you can either perform the two stages one at a time, or process both stages in sequence automatically.

For serialized items whose Serial Control is either Predefined or At Receipt, you are required to perform the Pick Release processing twice, as for general items. For more information, see Ship a General Item, page 4-94.
Manual Ship Processing for Items with Serial Control At Sales Order Issue

The only difference in the processing of a refurbishment item and a general item occurs in the final, Ship stage, and then only for the case of a serialized refurbishment item, whose Serial Control is At Sales Order Issue.

To ship this type of item, you must use the manual method of clicking Ship and entering the Serial Number using Oracle Shipping Execution windows; you cannot use the automatic method of choosing Ship Confirm and clicking Process.

Note: You must also use the manual method for partial shipments.

The following procedures describe the Move Out transaction, that processes the shipment of the refurbished item back to Spares Management.

Prerequisites

The Service Request and the associated refurbishment Service Order or orders must have been created in the Spares Management module of Oracle Field Service.

The item must have been received and serviced.

Steps:
1. Retrieve the Service Order for which you want to ship the refurbished item.
   For more information, see Find Service Requests and Service Orders, page 4-30.
2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
3. Click the Logistics tab.
4. Click any field of the Move Out line to make that line current.
   The Status of the Move Out line should be Booked.
   Note: The following description assumes that you select the automatic Pick Release option when processing the Move Out line.
   Even if you select Ship Confirm as your first choice for processing the Move Out line, the application automatically processes the Pick Release stage first, then the Ship Confirm stage.

Pick Release
5. Click the Process Trans check box for the Move Out line.
6. Click the Automate order processing steps through check box.

7. Select the Pick Release radio button.

8. Click Process.

The Status of the Move Out line generally changes to Released.

**Pick Release for Items with Serial Control Predefined or At Receipt**

For a serialized item that has Serial Control which is either Predefined or At Receipt, the resulting Status depends on whether you are performing the Pick Release processing for the first time or the second time.

1. The first time, you must enter a Serial Number, navigating through the Find Move Order Lines window that appears automatically, to the Transact Move Orders window.

   For details of the Find Move Order Lines window and the Transact Move Orders window, see the Oracle Inventory User's Guide.

   When you return from the Transact Move Orders window, the Status of the Move Out line remains as Booked.

2. The second time you perform the Pick Release process (steps 5 through 8), you do not have to enter any further data, and the Status changes to Released.

9. To see the Serial Number that you entered during the first time Pick Release processing in the (Source) Serial Num field on the Logistics tab, click Refresh Logistics, after you complete the second time Pick Release process.

10. To check if there has been a mismatch between the Serial Number in the Move Out line and the Serial Number you entered in the Transact Move Orders window, select Data > Activity to display the Activity window. If a mismatch occurred, an alert message in the Activity window records the two Serial Numbers.

    When the Status of the Move Out line is Released, the Pick Release stage is complete.

**Manual Ship or Ship Confirm**

11. For the case of a serialized refurbished item, whose Serial Control is At Sales Order Issue, or for partial shipments, the Ship Confirm button is disabled. In these situations, click Ship and enter the item's Serial Number in Oracle Shipping Execution windows. For details of these windows, see the Oracle Shipping Execution User’s Guide.

    When you return to the Logistics tab, click Refresh Logistics. The Status changes to Shipped.

    This completes the manual ship processing for these special Move Out lines.
12. For all other cases, click the Process Trans check box for the Move Out line.

13. Click the Automate order processing steps through check box.

14. Select the Ship Confirm radio button.

15. Click Process.

   When processing the Ship Confirm stage, you should wait until the concurrent program Interface Trip Stop has completed successfully before you click Refresh Logistics, to see the changed value of the Status.

   You can monitor the progress of the program by selecting Requests from the View menu on the toolbar, and selecting appropriate search criteria.

16. Click Refresh Logistics.

   The purpose of this is to update the Status on the Move Out line, so that it reflects in Oracle Depot Repair the results of the procedures executed in other Oracle applications when you clicked Process.

   After the background concurrent process Interface Trip Stop has completed successfully, the Status changes to Shipped.

17. Optionally, from the top menu, select Data > Activity to see the details of the Move Out transaction in the Activity window.

---

**Record Billing Data in Actuals**

When you have completed the service and have determined the final billing for materials, labor, and expenses that you want to bill your customer, you need to put the billing amounts in Actuals. Sources of billing amounts in Actuals can include the estimate, WIP Summary, Task Debrief, or manual entries.

**Note:** For WIP mode jobs, although it is not prohibited to create actuals from both WIP and Estimate sources, generally you will copy in from either WIP or Estimate sources.

Similarly, for Task mode jobs, although you can copy in lines from both Task and Estimate sources, generally you will copy in from either Task or Estimate sources.

When you record the billing entries in Actuals, the system creates charge lines in the Actuals area. In turn, the system can transfer the billing data to other modules for invoicing.

**Note:** The Debrief Report form does not let you apply contracts per
charge line. If you are using Debrief Report form to generate charges, the system automatically applies the contract at the Service Request level to the charge line.

Topics that guide you through adding data into your Actuals tab include:

- Add WIP Summary to Actuals, page 4-102
- Add Task Debrief to Actuals, page 4-105
- Add Estimate to Actuals, page 4-105
- Create Manual Charges in Actuals, page 4-106

See Also

- Book Actuals, page 4-108

Add WIP Summary to Actuals

If your Service Order is in WIP mode, you can add the WIP Summary as a source for your Actuals.

When you add from the WIP Summary to your Actuals, the system adds all material, labor, and expense lines from the WIP Summary into the Actuals.

Generally, when adding in lines from WIP Jobs:

- Material Transactions are added as Material lines.
- Resources Transactions are added as Labor lines.

**Note:** Before you can add WIP Summary data into the Actuals, you must define a billing inventory item for all the BOM Resources that
are associated with a WIP Job. This requirement lets Depot Repair add the WIP Summary lines into Actuals as material, labor, and expense items. For more information, see the Oracle Depot Repair Implementation Guide.

After you add WIP Summary lines into the Actuals, you can:

- View the WIP Job Name in the Source column of the Actuals tab to see the source of the added lines.

- Update the WIP Summary-sourced lines in Actuals but not delete them. The updates you can perform are limited: under profile option control, you can either set No Charge for a charge line or you can override the charge.

  **Note:** If you manually override the charge, then discounts associated with the contract are not applied.

- View each line's details to let you view more information about the line, indicate whether or not to override charges, or indicate to make no changes.

  **Important:** After you have imported at least one line from a WIP Job into the Actuals, you cannot import any additional lines from that job.

  Additionally, lines will not be imported from WIP Jobs shared across Service Orders.

- Manually create additional charge lines. You can manually create charge lines before and after you add lines from the WIP Summary.

Upon importing the WIP Summary lines to the Actuals, the system creates charge lines for each line.

**Prerequisites**

You must be processing a Service Order.

**Steps:**

1. In the Source field, click the right-hand end of the field, then click the ellipsis (…) button.

   A window opens and displays the possible sources from which you can add data to Actuals.

   For a WIP mode service, the options are WIP and Estimate.
For a Task mode service, the options are Task and Estimate.

2. Select a Source and click OK.

3. Click Add.
   The system automatically populates rows and fields on the Actuals tab from the source that you selected. An information window appears which records any errors and information about the lines added.

   The Source field shows the Source Name. You should review each line on the Actuals tab to:
   - Determine if any lines require overrides.
   - Determine if any lines should be at no charge.

4. (Not available for lines imported from Task Debrief.)
   If the profile option CSD: Allow Charge Override for Actuals is set to Yes, you override an amount on a line, as follows:
   1. Select Override Charge.
   2. In the Charge column, enter a new amount.

5. (Not available for lines imported from Task Debrief.)
   To change a line to No Charge, select the No Charge check box.

6. Click Save to record the changes.

**View Line Details**

On the Actuals tab, you can view additional information about a charge line’s details. Additional details include costing and charge information. You can access a charge line’s details by selecting a charge line and clicking the Line Details button. An expanded window shows the detailed information.

**See Also**

- Record Billing Data in Actuals, page 4-101
- Add Task Debrief to Actuals, page 4-105
- Add Estimate to Actuals, page 4-105
- Create Manual Entries in Actuals, page 4-106
- Book Actuals, page 4-108
Add Task Debrief to Actuals

If your Service Order is in Task mode, you can import the Task Debrief as a source for your Actuals.

When you import from the Task Debrief to your Actuals, the system imports all material, labor, and expense lines from the Task Debrief into the Actuals.

**Note:** The Debrief Report form does not let you apply contracts per charge line. If you are using the Debrief Report form to generate charges, the system automatically applies the contract at the Service Request level to the charge line.

After you import Task Debrief lines into the Actuals, you can:

- View the Task Number in the Source column of the Actuals tab to see the source of the imported line.
- Add additional Task Debrief lines to the Actuals.
- Manually create additional charge lines. You can manually create charge lines before and after you add lines from the Task Debrief.

Upon importing the Task Debrief lines to the Actuals, the system creates charge lines for each line.

**Note:** You cannot update lines whose Source is Task.

For procedural information on how to add Task Debrief data to the Actuals, see the Steps in the topic Add WIP Summary to Actuals, page 4-102.

**See Also**

- Record Billing Data in Actuals, page 4-101
- Add WIP Summary to Actuals, page 4-102
- Add Estimate to Actuals, page 4-105
- Create Manual Entries in Actuals, page 4-106
- Book Actuals, page 4-108

Add Estimate to Actuals

If your service includes an estimate, you can use the Estimate as a source for your
When you import from the Estimate to your Actuals, the system imports all lines from the Estimate into the Actuals.

After you import Estimate lines into the Actuals, you can:

- Update, add, or delete the Estimate-sourced lines in Actuals.
- View each line’s details to let you view more information about the line, indicate whether or not to override charges, or indicate to make no changes.
- Manually create additional charge lines. You can manually create charge lines before and after you add lines from the Estimate.

  Note: If you manually override the charge, then discounts associated with the contract are not applied.

Upon importing the Estimate lines to the Actuals, the system creates a charge line for each estimate line.

  Note: After you have imported any estimate lines into Actuals, any changes made to those source estimate lines are not automatically forwarded to the corresponding Actuals lines. To take advantage of the new estimate changes, you must delete the corresponding Actuals lines, and then re-import the changed source estimate lines.

For procedural information on how to add Estimate data to the Actuals, see the Steps in the topic Add WIP Summary to Actuals, page 4-102.

See Also

- Record Billing Data in Actuals, page 4-101
- Add WIP Summary to Actuals, page 4-102
- Add Task Debrief to Actuals, page 4-105
- Create Manual Entries in Actuals, page 4-106
- Book Actuals, page 4-108

Create Manual Charges in Actuals

In addition to adding billing data from other sources—such as the WIP Summary, Task Debrief, or Estimate you can:
• Manually create entries in Actuals.

• Update or delete the manual charge lines in Actuals.

**Prerequisite**

You must be processing a Service Order.

**Steps:**

1. To manually create a new charge line on the Actuals line, select the new row on which you are adding a charge line.

   The Source Type field automatically indicates Manual.

2. Enter or select the Billing Category, Item, Price List, Qty, UOM, Pricing Attributes fields, and optionally, the PO Num field.

3. Optionally, complete the Contract Number field.

4. If the profile option CSD: Allow Charge Override for Actuals is set to Yes, you override an amount on one line, as follows:
   
   1. Select Override Charge.
   
   2. In the Charge column, enter a new amount.

   **Note:** If you manually override the charge, then discounts associated with the contract are not applied.

5. To change a line to No Charge, select the No Charge check box.

6. Click Save to record the changes.

**See Also**

• Record Billing Data in Actuals, page 4-101

• Add WIP Summary to Actuals, page 4-102

• Add Task Debrief to Actuals, page 4-105

• Add Estimate to Actuals, page 4-105

• Book Actuals, page 4-108
Book Actuals

After you have recorded your billing data in Actuals, from one or more sources, and possibly entered charge lines manually in Actuals, you can book selected charge lines. The following procedures describe how to book selected Actuals charge lines.

Prerequisite

You must be processing a Service Order.

You must have charge lines in Actuals, either manually entered or added in from a Source of Estimate, WIP, or Task.

Steps:

1. Select either individual charge lines or click Select All if you want to book all the charge lines in the Actuals tab.

2. Click Book Selected.

Comments:

For lines whose Source is Task, the items used in the Debrief Report decrement inventory only after the Field Service concurrent program CSF: Update Debrief Lines is submitted. This concurrent program updates the Quantity On Hand (QOH) in the inventory.

Invoice a Customer

**Note:** Tax, Shipping, and Freight charges are not calculated within Oracle Depot Repair, but are calculated in Order Management when orders transfer to Order Management. For this reason, the charge totals in the estimate lines and lines from Task Debrief may be different from the value charged on the invoice.

The following procedures describe how to invoice a customer.

Prerequisites

You must complete all steps in the relevant business scenario prior to invoicing the customer. For more information, see Oracle Depot Repair Business Scenarios.
Steps:
1. Invoice the customer by using normal business procedures. For more information, see the Oracle Receivables User Guide.

Close a Service Order

The following tasks describe how to close a Service Order.

Prerequisite

You must complete all steps in the relevant business scenario prior to closing the Service Order. For more information, see Oracle Depot Repair Business Scenarios.

Steps:
1. Retrieve the Service Order for the item that you want to ship. For more information, see Find Service Requests and Service Orders, page 4-30.

2. Select the relevant result from the Results area of the Find Service Orders window, and click OK.
   The Depot Repair Workbench shows the selected Service Request and Service Order details.

3. Confirm that the quantity on the Service Order is complete.

4. Consult or create notes if necessary. For detailed instructions, see Create and Maintain Notes, page 4-34.

5. In the Details tab of the Depot Repair Workbench, click Update Status.
   The Update Status window opens. In the Update Status window, you can update the Service Order status. The Service Order can remain Open, be on Hold, or Closed.

6. Select Close by selecting the option button, and click OK to close the Service Order line.
   You can select a Reason Code from the list of values, and enter additional details supporting the status update.

7. Click the Save icon on the toolbar to save the record.
   **Note:** Alternatively, you can set up a workflow to auto-close the
service order after the last item ships. See: Using Workflows to Auto-close Service Orders, Oracle Depot Repair Implementation Guide.

Close a Service Request

The Depot Workbench does not allow you to manually update the service request status and as a result you cannot manually close a service request from the Depot Workbench. However, there are several options for closing the service request.

The first option is to allow the system to automatically close the service request when all of the service orders are closed. This is done by setting the profile option CSD: Close Service Request When All Service Orders are Closed to Yes.

The second option is to click the hyperlinked service request number in the Request Num field on the Depot Workbench window. If the profile CSD: Enable SR Hyperlink is set to Yes, this launches the HTML Service window where you can change the service request status to Closed.

The third option is to log out of the Depot Workbench and log into the Teleservice or HTML Service Request windows.

Steps:
1. Navigate to the Find Service Request window. Retrieve the Service Request that you want to close.
   The selected Service Request details are displayed in the SR header section.
2. In the Service Request Information area, change the status of the Service Request to Closed by selecting from the list of values.
3. Enter the closing date.
4. If required, create notes stating the reason for the Service Request closure. For detailed instructions, see Create and Maintain Notes., page 4-34
5. Click the Save icon to close the Service Request.

Create and Process an Internal Party Refurbishment

In Oracle Depot Repair, you can create and process items that need to be refurbished that belong to an internal party. In these cases, the items to be refurbished do not move from an external location, such as a Spares Management warehouse, they remain in the internal party location.
Note: Spares Management is a module of Oracle Field Service.

Create the Service Request

You must first create a Service Request, and explicitly choose an internal party for your customer.

An internal party is defined as a customer set up in at least one of the following ways:

- The customer is the Party Name set up in the Installed Base Install Parameters.
- The customer is set up in Oracle Order Management with a classification type of Internal.

For more information on setting up internal parties, see the Oracle Depot Repair Implementation Guide.

Create the Service Order

When you create the Service Order, you must select a Service Type that has been set up with a Service Type Ref of Refurbishment, and whose Internal Order check box has not been set.

For more information on setting up Service Types, see the Oracle Depot Repair Implementation Guide.

Process the Service Order

After the Service Order has been created, the Logistics, Estimates, and Actuals tabs are disabled, as is the tools option menu Tools > Coverage.

The main operations that you perform on internal party refurbishment items are services to be carried out through WIP Jobs or Tasks.

The only special considerations that apply to the internal party items to be refurbished are as follows:

- For serialized items, that are Installed Base trackable, the lists of values for Serial Num and Instance show all item instances owned by the internal party, and whose Oracle Installed Base usage is In-Inventory.

- For serialized items, that are not Installed Base trackable, the lists of values for Serial Num and Instance show all item instances whose Oracle Installed Base usage is In-Inventory.
View Service Orders in Oracle iSupport

Oracle Depot Repair customers can now search for their Service Orders through a self-service user interface in Oracle iSupport.

Oracle iSupport authenticates the user and displays only the Service Orders for accounts which the user is authorized to view. For each Service Order, summary and detail information, including Service Order status, can be displayed.

The procedure to view Service Orders in Oracle iSupport is as follows:
1. Login to Oracle iSupport.
2. Click the Accounts tab.
3. Select the Service Orders menu item.
   The Service Order Summary page appears.
4. Click the Service Order Number hyperlink for a Service Order.
   The Service Order Details page appears.

You can also use the Saved Searches function in Oracle iSupport to assist subsequent searches.

For more information, see the Oracle iSupport User Guide.

Third Party Flows

The service centers interface with the third parties to execute many of customer’s service requirements. They track the movement of products, work and financial obligation between all the parties involved in executing a service.

The functions for managing service operations across multiple parties consists of the following:
- Third Party Logistics for Repairs
- Invoice Third Party
- Supplier Warranty Claims
- Invoice Third Party

Third Party Logistics for Repairs
Broken products, serviced products, and exchanges are moved and tracked between service organization, customer, and third parties. The Depot Repair application
supports the following models of third party repair logistics:

- **Ad hoc Repairs**
  A service organization manually creates orders to ship items to a third party or RMA items back from a third party. Outside processing orders for repair service are automatically generated from jobs.

- **Cross Dock Repairs**
  A service organization sends broken customer product out for third party service immediately upon receipt. Depot Repair defaults the appropriate service vendor and ship to location based on customer defined disposition rules. Overdue returns trigger escalation notifications. Third party refurbishment status is tracked via workflow and/or iSupplierPortal.

- **Portal Repairs**
  A service organization provides a third party service shop with technician portal access. The third party views service orders assigned to them, update status, capture time and materials, and capture symptoms and root causes. The service organization keeps the service intelligence without exposing customer or pricing information to an outside party.

- **Control Tower Repairs**
  A service organization coordinates the service process without executing any service or fulfillment operations in house. Customer broken products are routed to third party service shops while exchanges are sourced from OEMs or third party distribution centers. Depot Repair defaults the appropriate service vendor, and ship from inventory based on customer defined disposition rules. Overdue returns and refurbishments trigger escalation notifications. Third party refurbishment status is tracked via workflow and/or iSupplierPortal.

**Setting Up Repair and Return with Third Party**
1. Navigate to the Service Types page. The Service Type Summary region displays the existing service types in the system.

2. To create a new service type, click the New icon on the menu option.

3. Enter the required information in the following fields:
   - **Service Type**: Enter the name of the service type.
   - **Description**: Enter description of the service type.
   - **Business Process**: Select Depot Repair from the list of values.
   - **Service Mode**: The default value is Work In Process. The other available options are Task Mode and None.
**Note:** You must select WIP Mode to use the Technician Portal.

- Service Type Ref: It defaults if you select a seeded Service Type.

- Third Party Ship and RMA: Select the Ship and RMA Service Activity Billing Types from the list of values.

  The list of values displays the Service Activity Billing Types, which are setup in the Charges setup windows. These values must be associated with a third party RMA line and third party Ship line to indicate what OM line types to use, what operating unit to associate them with, what contract entitlements apply, and so on.

  You must set up the Service Activity Billing Types under the Pre-Service and Post-Service columns in order to have a RMA line under pre-service, and a Ship line under post-service.

- Third Party checkbox: Selecting the check box creates a third party ship and RMA line at time of service order creation if a Service Activity Billing Type is selected in the Third Party RMA and ship columns. If a Service Activity Billing Type is selected for the Ship column but not the RMA column, only a ship line will be created at time of service order creation. Likewise, if a Service Activity Billing Type is selected for the RMA column but not the Ship column, only an RMA line will be created at time of service order creation.

  If the third party flag is not checked, no Third party lines will be auto-created, even if service activities are entered in the Third Party Ship and RMA fields.

  **Note:** A service type having third party lines can also have regular lines, provided the Service Activity Billing Types are set up for them in their respective columns.

4. Click Save.

5. In the Service Type Details region, enter Service Activities in the Material, Labor, and Expense tabs. This is optional and is required only when a customer creates Estimate or Actual lines. They are not needed if no billing is done in Estimates or Actuals.

6. Select Automatically enter and book RMA, and Automatically ship through options for third party shipments. This is optional and depends on the business process of the service center. You can use any of the following options: auto-create, auto-enter, or auto-book. Automatically process through option enables the ship lines to create a charge line, or enter an unbooked line in OM, or book a line in OM.

  This is optional and depends on the business process of the service center.
7. Click Save. Close the Service Type form.

8. Navigate to the Service Orders page.

9. Create a new Service Request.

10. Create a new Service Order.

11. Click Save.

12. Navigate to the Logistics tab.

   You can view four lines in the Action Type column. Return and Ship lines for regular repair and return and Ship Third Party and Return Third Party lines for third party (RMA and Ship).

13. Receive the item in inventory. For more information, see: Auto-Receive an Item., page 4-58

14. Select the row to ship an item to the third party and select the Process Trans check box.

15. The third party account field should have defaulted at time of ship line creation if the disposition rules were set up correctly. You cannot change the account if the line is set to automatically book. Click the Ship radio button.

16. Click the Process button. Item is shipped to the third party for repair and the status
of the line shows Shipped.

17. Receive the item from third party using third party RMA line. Item is received from third party and the status of the line changes to Received.

18. Ship the item back to customer through regular ship line.

Invoice Third Party

Depot Repair allows sending service invoices to a different party from that which logged the service request. Invoices can be sent to multiple parties for a single service order.

Updating the Invoice Third Party Flow

1. Navigate to the Depot Workbench and query for a service order.

2. Click the Actuals tab. The tab displays the following information:

   • The Total column reflects the total charges associated with the service order if the Actual Lines are billed to more than one party.

   • The Default Bill To Account, Party, and Address default from the information entered on the Service Request.

   • You can change the default information. Changing the Default Bill To Account, Party, and Address will not impact the already created lines. It will impact the lines created after the change.

3. Click the Line Details button to navigate to the Actual Line Details page.
The Actual Line Details page displays the following information:

- Bill To Account, Party and Address details for each corresponding line, default from Actuals tab.

- You can update the Bill To Account, Party or Address fields if you choose to bill a different party, account, or address than that specified on the Service Request for a specific charge line.

**Supplier Warranty Claims**

Organizations performing services on products manufactured by other companies need a mechanism for reporting and settling warranty claims with the Original Equipment Manufacturers (OEM) or suppliers. The mechanism consists of the following:

- Send Claim to Supplier

Depot Repair enables you to capture claim data and trigger the claim submission workflow. Multiple claims can be made against multiple vendors per service order. The OM Line Flow is used as the mechanism for triggering communications between a repairer and a supplier. The standard Accounts Receivable invoice that OM generates is used for settling third party claims.

- Track Approval Status and Claim Number from Supplier

Depot Repair provides fields to capture the supplier warranty claim number and warranty claim status from the supplier’s claim management system. Multiple claim numbers and statuses can be tracked per service order.
Capturing Warranty Claim Information

1. Navigate to the Depot Repair Workbench and query for a service order.
2. Click the Actuals tab.
3. Click the Line Details button to navigate to the Actual Line Details page.
4. To capture warranty claim information, select the Warranty Claim checkbox in the Actual Line Details region.
5. Enter the Number and Status for the warranty claim. These fields are non editable if you do not select the Warranty Claim option.
6. Select a Replaced Item from the list of values. Replaced item shows list of items belonging to the Organization. The replaced item information is sent along with the warranty claim information.
7. Click Save.

Execute Outside Processing

A service technician can trigger the creation of a purchase order for outside processing by completing an Outside Processing (OSP) operation in the Technician Portal. See: Outside Processing, Oracle Work in Process User’s Guide.

Select Service Parts from Dynamic Repair BOM Window

Depot Repair provides a new region in the Technician Portal to enable a technician to view any bill of materials, or alternate bill of materials. The Technician Portal also enables the technician to choose a routing. The technician can check off the removed, replaced, or serviced parts. You can add the selected parts first to an estimate, and then create a job from the estimate.

Select Repair BOM

The Dynamic Repair BOM screen enables the technician to quickly capture the parts required for a service. Upon completion of the inspection, the selected parts are automatically added to the service order estimate.

1. Navigate to the Depot Repair Workbench and query an item.
2. Click the Estimate tab on the Service Order page.
3. Select the Select Materials button to navigate to the Expanded BOM window.
4. In the Search region, enter a valid BOM item in the Item field or select an item from
the list of values. You can also select an Alternate BOM from the list of values.

5. Click Go. The Select From BOM Hierarchy regions displays those items in the BOM hierarchy which have billing type as Material defined in Inventory Item Master.

6. Select the BOM components required in the service. These materials appear as new estimates lines on the Estimates tab at completion of triage.

7. The Select Additional Items region enables you to enter an Item and corresponding quantity required for service. Add any items which are not in the existing BOM.

8. You can select a routing to associate with the Estimate in the Select a Routing region.

   **Note:** You can save only a single Routing at one time, and that Routing can only be viewed on the Select Material window. You can modify the saved routing if required. The routing is used to create a job from estimate.

9. Click the Save and Process button to commit the selection of desired components. Close the window.

10. Click OK on the alert to trigger the refresh in the Estimate tab.

11. The following values default for Estimate lines created from the Expanded BOM window:
• Source Type: Repair BOM

• Billing Category: Material

• Contract Number: Use the contract associated to the service order if a contract exists

• Price list: Default the Price lists selected on the Details tab

Create Job from Estimate

Once the estimate is created, a service manager works with the customer to approve the estimate. After the approval of the estimate, the service manager initiates the service by generating a job from the estimate.

To create job from estimate
• Select the Create Job button on the Estimate tab.

Clicking the Create Job button initiates and follows the process flow outlined in the section Jobs tab, page 2-31.

Note: The Submit Job button and the Select Materials button appear only if the function to view these buttons is granted.

Print Traveler Document

Depot Repair provides an out-of-box traveler document to enable the service technicians to scan in maximum data thereby reducing the time consumed in data entry. Traveler documents allow easy identification and disposition of items in the service shop. Bar coded serial numbers and service order numbers allow technicians to quickly find service records without typing.

To print a traveler document:
1. Navigate to the Depot Repair Workbench.
2. Create a Service Order or retrieve an existing service order.
3. Select the Print Traveler option from the Data menu.

This command prints the traveler.
Depot provides a standard traveler format, and also a barcoded traveler, both of which can be tailored to a customer’s preferences using XML Publisher.

**View Service Bulletins using Depot Repair Workbench**

Depot Repair automatically links a service bulletin to a service order based on customer defined service bulletin rules. A number of predefined bulletin types are seeded in the product. You can add any additional bulletin types to fit your business needs. You can view service bulletins from the Depot Repair Workbench.

The Depot Repair Workbench enables the service managers, coordinators, billing clerks, and other users to view service bulletins. The Depot Repair Workbench is enhanced to allow a user to view the service bulletins associated with a service order from the Workbench.

**To view a service bulletin from the Depot Repair Workbench:**

1. Navigate to the Depot Repair Workbench.

2. Create a Service Order. Alternatively, you can search and retrieve an existing service order.
   
The Service Orders page opens.

3. Click the View Service Bulletins option from the Data menu.
   
The Service Bulletins page opens.

4. The Service Bulletins page displays the existing service bulletins if the Retrieve Service Bulletins concurrent program is running. Click Retrieve New Service Bulletins button to display any additional new service bulletin.

5. Select the service bulletin and click Show to display the service bulletin details.
Service Order Orchestration

Service Order Orchestration enables users to track important related events that occur in other functional domains during the processing of a service order. The related cross-domain documents currently supported are:

- Shipping Delivery Line
- Internal Sales Order
- Internal Requisition
- Job
- Purchase Requisition
- RMA Line
- RMA Line - Third Party
- Ship Line
- Ship Line - Third Party
- Service Request
- Service Request Task

Using the Service Order Orchestration page:

The Service Order Orchestration page displays the details of a service order and the numbers and status of the documents related to this service order. Service order details and document statuses can be refreshed by using the Refresh Status and Refresh All Statuses buttons on the page or via the Depot Repair Service Order Orchestration concurrent program.

To open the Service Order Orchestration page in the Depot Workbench, query and open a service order and select the option to Launch Service Order Orchestration from the Data menu.

Alternatively, you can launch the Service Order Orchestration page from the Technician Portal. See: Launching Service Order Orchestration in the Technician Portal, page 10-16
Defining Service Order Orchestration Rules:

You can define service order orchestration rules in an organization using the Service Order Orchestration Rules page. You can set up rules to trigger a Service Order status change and/or a PL/SQL action when events (status changes to related documents) occur. The currently supported events are:

- **Shipping**: Delivery Line Status Change
- **Order Management**: Internal Sales Order Line Status Change
- **Internal Requisition**: Internal Requisition Status Change
- **WIP**: Job Status Change
- **Purchase Requisition**: Purchase Requisition Status Change
- **Order Management**: RMA Line Status Change
- **Order Management**: RMA Line - Third Party Status Change
- **Order Management**: Ship Line Status Change
- **Order Management**: Ship Line - Third Party Status Change
- **Service Request**: Service Request Status Change
- **Service Request Task**: Service Request Task Status Change

Following are the non-document related conditions that can be used in addition to existing defaulting rule conditions:

- **Job Operating Unit**
- **Job Country**
- **Service Order Status**
- **Service Order Priority**
- **Service Order Owner**
- **Service Order Contract**
- **Service Vendor** (for third party services)
- **Pre and Post Update Status of Each Document Type**
View Read Only Workbench

Oracle Depot Repair provides the ability to launch the Depot Workbench in read-only mode. The Depot Workbench provides numerous data and functionality that is not specific to any specific user type. It provides functions to service managers, service representatives, receiving clerks, shipping clerks, billing clerks and many more. The read-only mode allows you to access data that they need but restricts them from performing functions outside of their purview.

To view the Depot Workbench in read-only mode, set the profile option, CSD: Read Only Workbench, to Yes.

To Access a Read-only Depot Workbench:
1. Navigate to the Depot Workbench. The Workbench launches in read-only mode. You can only view data, but not execute any functions.

2. The read-only mode allows you to click certain buttons and view menu options. The disabled functions/buttons are:
   • Create new service request
   • Create new contact
   • Create new service order
   • Create Note - Details Tab
   • Change Status - Details Tab
   • Counters - Details Tab
   • Configuration - Details Tab
   • Process Transaction Checkboxes - Logistics Tab
   • Process Transaction Through Checkbox - Logistics Tab
   • Process button - Logistics Tab
   • Receive - Logistics Tab
   • Ship - Logistics Tab
   • Create Job - Jobs Tab
   • Create Task - Tasks Tab
• Capture Quality Plan - Tasks Tab
• Create Estimate, Estimate Line - Estimates Tab
• Create Job from Estimate - Estimates Tab
• Submit Actuals - Actuals Tab

The disabled menu items are:
• Reserve/Un-reserve Serial Number
• Split Service Order
This chapter outlines the broad set of capabilities that a service manager performs in the course of normal service center operations.

This chapter covers the following topics:

- Overview
- Service Manager Portal Page
- Using the Service Order Backlog region
- Using the Quality Event Watchlist region
- Using the Advanced Search page
- Using the Batch Create Jobs region
- Using the Create Service Order page
- Setting Up Aging Threshold
- Setting Up Quality Threshold

Overview

The Service Manager Portal provides the ability to monitor and manage the return center from a single screen. The Portal provides instant visibility to bottlenecks and process exceptions and allows you to manage the exceptions quickly. It allows a manager to:

- Monitor and report product quality issues:
  Managers set quality thresholds for an item regarding the number of services during a specified time. The system triggers workflow notification when the quality thresholds exceed.

- Monitor and manage work backlog and resources:
  Managers allocate resources to ensure that the highest priority work is done first
and all the work is completed on time. Managers set aging thresholds for how long services are open or in the same status without changing. System triggers notification for the ones passed aging thresholds and due dates.

- Monitor and manage processing exceptions and escalations:
  Managers monitor work orders needing attention or approval and drill down to the details of respective service orders. Managers update service orders to remove escalations, change ownership, change priority, and so on.

- Create, update and search service orders:
  Managers create new service orders and/or update existing service orders.
  Managers can perform a mass-update of ownership, priority, due date, and other values on service orders. Additionally, they can search existing service orders and save the search queries, if required.

### Service Manager Portal Page

The header of the Service Manager Portal page is the Service Order Backlog region and the footer is the Quality Event Watchlist region. Additionally, you can use the Shortcuts section to navigate to the Search Service Orders page, Create Service Orders page, and Manage Service Bulletins page.

For more details on the regions, select one of the following:

- Using the Service Order Backlog region, page 5-2
- Using the Quality Event Watchlist region, page 5-3

### Using the Service Order Backlog region

A Service Order Backlog region is a summary table that indicates for each of the resources how many service orders they own, how many are escalated, past due, aging
or on hold.

The Service Order Backlog region displays the following information:

- **View Inventory Org**: Displays the default organization to which you belong based on your user profile organization. You can choose other organization if required.
- **Owner**: Displays the resources that are assigned the service orders.
- **Total**: Displays the number of service orders for the owner in total.
- **Escalations**: Displays the number of escalated service orders for the owner.
- **Past Due**: Displays the number of past due service orders for the owner.
- **Aging**: Displays the number of aged service orders for the owner.
- **On Hold**: Displays the number of service orders for the owner that are on hold.

All the non-zero numerical entry in the columns mentioned above is hyperlinked. Click any hyperlink to navigate to drill down to a details table for any resource or category combination.

**Using the Quality Event Watchlist region**

A Quality Event Watchlist region is summary table that indicates how many of each item type are returned for a selected organization and time period. Additionally, this region indicates a preset threshold for returns in a selected period and an indicator of whether the number of returns is trending upward or downward from the prior period. You can drill down to a details table for any item.

The Quality Event Watchlist region displays the following information:

- **View Inventory Org**: Displays the default organization to which you belong based on your user profile organization. You can choose other organization if required.
- **View Period**: Defaults to 7 days. You can select any value for the view period.
- **Item**: Displays the items returned.
- **Total**: Represents the number of service orders for the item during the selected period.
- **UOM**: Unit of measurement of the item.
- **Threshold**: Displays the quality threshold for each item as defined in the Quality Threshold Setup table. As the period changes the threshold updates to match the selected period.
• Variance: Indicates the difference between Total and Threshold. Has plus or minus prefix. Red for plus, green for minus.

• Trend: The indicator displays whether the number of service orders has increased, decreased or stayed the same relative to the prior time period. Red arrow indicates increase, green arrow indicates decrease, and black line indicates same as prior period.

Using the Advanced Search page

The Advanced Search page provides advanced search capability to search service orders using dynamic queries with many different search criteria.

You can navigate to the Advanced Search page in the following ways:

• From the Service Order Backlog region:

  Click any numeric hyperlink on the Total, Escalations, Past Due, Aging, or On Hold columns to navigate to the Advanced Search page. This page displays pre-populated data for the Owner/column combination you choose. Click a service order hyperlink to drill down to the Technician Portal and see the details of that service order.

• From the Quality Event Watchlist region:

  Click the numeric hyperlink on the Total column to navigate to the Advanced Search page. This page displays pre-populated data for the Item/column combination you choose. Click a service order hyperlink to drill down to the Technician Portal and see the details of that service order.
• From the Shortcuts panel:

  Click the Search Service Orders link on the right hand panel on Service Manager Portal to navigate to the Advanced Search page.

The Advanced Search page enables you to perform a search using the following criteria:

• Item
• Status
• Priority
• SO Number
• SO Owner
• Service Request
• External Reference
• Job Exists

Advanced Search results area displays the information based on the search criteria already mentioned. In addition, some columns are displayed:

• The Job Name column displays the job from WIP. If no job exists, this field is null. If more than one job exists, all Job Names are displayed separated by commas.

• The Internal Orders column displays the internal order, if any, for a service order. This column is hidden by default. Once this field is enabled, you can drill down to the Internal Move Orders page.

**Update Selected Service Orders region**

The Update Selected Service Orders region enables you to select one or more service orders and perform mass update of attributes like ownership, priority, due date, and other values on service orders.
The Update Selected Service Orders region displays the following information:

- **Service Type:** Contains a list of values of the user-defined Service Types. Service type requires that both the old and new service type allow the current service order status.

- **Service Status:** Status of the Service Order. Service Status can only be updated to a status which has a valid transition defined from the current service order status on the service order.

- **Service Org:** Enter the organization to search.

- **Priority:** Priority of the service order.

- **Owner:** Depot resource responsible for execution and completion of the service.

- **Escalation Code:** Indicates whether the service order is escalated, and if so, what type of escalation it is.

- **Note Type:** Limited to Service Order Note Types.

- **Visibility:** Indicates whether the Note is public or private.

- **Note:** Enter the desired note.

- **Attachment Title:** Title of the attachment.

- **Description:** Description of the attachment.
• Category: Indicates the category to which an attachment belongs.

• Type: Type of attachment.

To update selected service orders:

1. Select the service orders you want to update from the Advanced Search results table.

2. Enter the changes in the Update Selected Service Orders region.

3. Click Update Selected Service Orders button to process your request.

A confirmation message on mass update appears at the top of the Advanced Search page.

### Using the Batch Create Jobs region

The Batch Create Jobs region contains a set of job-related parameters and a Create Jobs button that enables you to create a new job for each service order in the selected set of service orders. You can select the set of service orders using the Advanced Search capability.

This region is hidden by default. You can enable this region via Personalization.

The Batch Create Jobs region displays the following information:

• Inventory Org: Specifies the Inventory Org in which a batch of jobs is to be created. This field is mandatory for all jobs.

• Item: Specifies the item on the job header and the item that is completed when the job completes. The Item list of values is restricted based on the selected Inventory Org. If you clear the Inventory Org field, the Item field gets cleared simultaneously.

• Job Type: Specifies the job type.

• Job Status: Allows batches of jobs to be created in Released, Unreleased or On-hold status based on the profile CSD: Default Repair Job Status. If no value is entered in this field, the system assumes that jobs are created in Released status.

• Job Priority: Specifies the job priority

• Accounting Class: Specifies which Accounting Class to associate with each created job. This field is mandatory.

• Start Date: Specifies the Start Date for each job created in the batch. This field is mandatory. The Start Date field always defaults to system date.

• Complete Date: Specifies the Complete Date for each job created in the batch. This
Using the Create Service Order page

The Create Service Order page enables you to create multiple service orders at a time. You create service orders using bulk serial number capture or quick entry of item and serial. Defaulting Rules apply to service orders you create on this page.

Click Create Service Orders link on the right panel of Service Manager Portal to navigate to the Create Service Order page.
This page displays the following information:

- **Party Information region:**
  - Account: Enables you to query for Party.
  - Party Information: Displays the party name for the selected account.

- **Item Information region:**
  - Serial Number: Enter a single serial number or enter the first serial number in the range.
  - Item: Select the item.
  - Quantity: Enter the quantity.
  - UOM: Enter the unit of measurement.
  - External Reference: Capture unique external reference number, if any.
  - Lot Number: Enter the lot number for a lot controlled item.
  - Revision: Enter the revision number for a revision controlled item.
  - To Serial Number: Enter the final serial number in the range.

- View Recently Created Service Orders: Displays the details of the recently created service orders. Click this button to navigate to the Advance Search page and view the service orders.
• Process: Processes the creation of new service orders.

Defaulting rules apply to creation of service orders the same way as it is applied when creating service order from Depot Workbench.

You can also use this page to automatically create internal move orders for the items entered. For more information, see Oracle Depot Repair Implementation Guide.

Setting Up Aging Threshold

Aging is defined as the amount of time from service orders creation or the amount of time that a service order is in a specific status. Aging is related to elapsed calendar time and not to actual service time. The unit of measure (UOM) for aging is time-bound, for example, days, hours, minutes, and so on.

To set up aging threshold:
1. Navigate to the Aging Thresholds Setup page from the Depot Repair Setup menu.
2. Select an organization. To search for an existing aging threshold go to step 3 or continue to step 4 to set up a new aging threshold.
3. Click Go to search for an existing aging threshold in the selected organization.
4. Click the Add Another Row button to enter aging threshold details.

5. Enter the following information:
   • Inventory Org: Displays the default organization to which you belong based on your user profile organization.
   • Item Category: Select the item category.
   • Item: Select the item.
   • Description: Describes the item.
- Revision: For revision-controlled items, you can optionally specify thresholds to specific revision number.

- Service Type: Specifies the service type for which age threshold applies.

- Status: Specifies the status to which age threshold applies.

- Age Threshold (Days): Specifies the number of days at which a service is considered aging. It must be a positive value (>0).

- Delete: This icon deletes an aging threshold entry.

6. Click Apply to record the new aging threshold.
   A confirmation message appears on the top of the page.

### Setting Up Quality Threshold

Quality thresholds setup page enables you to create item record and corresponding quantity per day. Use quality thresholds to set how many items can be returned per day.

**To set up quality threshold:**

1. Navigate to the Quality Thresholds Setup page from the Depot Repair Setup menu.

2. Select an organization. To search for an existing quality threshold go to step 3 or continue to step 4 to set up a new quality threshold.

3. Click Go to search for an existing aging threshold in the selected organization.

4. Click the Add Another Row button to enter aging threshold details.

5. Enter the following information:
   - Inventory Org: Displays the default organization to which you belong based on your user profile organization.
• Category: Select the item category.

• Item: Select the item.

• Description: Describes the item.

• Revision: Active only for revision-controlled item.

• Threshold Quantity/Day: Represents the number of returns per day at which a service is considered a quality event. It must be a positive value (>0).

• UOM: Describes the item’s unit of measurement.

• Delete: This icon deletes a quality threshold entry.

6. Click Apply to record the new quality threshold.
A confirmation message appears on the top of the page.
This chapter covers the following topics:

- Overview
- Interacting with the Returns Portal
- Using the Returns Portal

Overview

The Returns Portal provides an effective and efficient way to enable customers to return products. Customers may exchange or return products for service, testing, take-back, calibration or trade-in credit. The Returns Portal allows customers, business partners, and retail associates and distributors to request returns directly via a web portal.

Use the Returns Portal to perform the following:

- Register: Businesses performing warranty service must know their customer. As a customer, you are required to identify yourself to the web portal before transacting returns. The standard iSupport registration and login frameworks fulfill this requirement.

- Request return: You can request a return online without direct interaction with a business representative. The lucid online system enables you to understand the steps required to submit the request successfully.

- Request one or more services for returned item: The online portal enables you to specify one or more services of a specific type required for the returned item without direct interaction with a business representative.

- Request end-of-life take-back of product: You must specify that you need an item or part to be taken back by the producer of that item. You enter the item, determine if it qualifies for take-back, and receive instructions on where to ship the item or how the producer collects it.
• Validate and display warranty status of return items: The online portal provides you with real-time information about the warranty status of the item for which you are requesting return. The system informs you whether the item is in-warranty, out-of-warranty or any other designation the producer assigns to the item.

• Provide estimated cost for performing return service: You can view the estimated cost for the return service being provided. This estimate factors in warranty entitlements and advanced pricing rules.

• Approve estimated costs online: The portal enables you to approve the estimated costs before returning an item. After an explicit approval the return is authorized.

• Capture and authorize credit card information: Provide credit card information online for authorizing the return of items. The system allows you to enter credit card information securely and in compliance with privacy and security laws. The credit card is automatically authorized for the estimated amount of the service. Oracle Depot Repair will not store any credit card information in its tables.

• View all returns: You can view all your returns on a single page as well as the service order status, scheduled arrival date and scheduled ship date for the repair items in the Returns Portal.

  Note: If multiple ship lines are linked to the same service order, the latest scheduled arrival date and latest scheduled ship date will display in the Returns Portal.

Interacting with the Returns Portal

The Returns Portal uses Oracle iSupport application's existing user registration and login features. You can navigate to the Returns Portal from the iSupport home page.

The Returns Portal enables you to enter one or more return requests. This automatically creates a service request and service orders. Based on the return service selected and the service contract entitlements, the system calculates the cost for your specific item and service. Service Contracts entitlement checks and Advanced Pricing rules are triggered in the same way as in the Depot Workbench Estimate tab. Additionally, the Depot Returns Portal pages allow you to enter credit card information to authorize payment on the estimated costs. This is accomplished through integration with the EBusiness Suite iPayment application. The Depot pages only perform authorization, not payment processing.

Using the Returns Portal

1. Enter Return Information
Navigate to the iSupport Home page.

2. Click the Manage Returns link to navigate to the Manage Returns page. It opens a service order advanced search page.

3. You can perform a search on the following:
   - Item Name
   - Waybill Number
   - Serial Number
   - Service Request

4. Click Add to have additional search criteria.

5. Click Go. An end-consumer can view the service orders they own.

6. Click on the Enter Returns button to navigate to the Enter Returns page. This page enables you to enter the details of the item(s) that you want to return or exchange.

7. Use the Customer Information region to select and search for existing customer using the Customer Type and Customer fields. Use the New Customer button to create a new customer.

8. Enter Returns Information.
   Enter the following information on the Enter Returns page:
• Item
• Quantity
• Return Type
• Return Reason
• Context Value

9. You can capture notes and attachments to their returns using the Add Note and Add Attachment buttons respectively.

10. Based on the Return Type you select, additional attributes associated with the return order maybe displayed. If the Return Type is Upgrade, it displays the Upgrade to Item list of values.

11. Use the Enter Another Return button to enter additional return lines. This allows you to return multiple items in the same return transaction. This button displays once you select the Return Type field. When you select Enter Another Return button, the items you entered first appears in a side bin on the Enter Returns page.

12. The Service Bulletins region is enabled if a service bulletin exists.

13. You can capture notes and attachments to their returns using the Add Note and Add Attachment buttons respectively.

14. Click the Next button to navigate to the Enter Locations page.

15. Enter Locations
Enter ship to, bill to and email information. You can create a new email, ship to and new bill to or choose an existing one.
16. Click the Next button to navigate to the Review and Submit page. Use this page to review the items entered for return. The page displays the return items together with warranty status and total price. Prices are displayed based on customer contract entitlement and advanced pricing rules.

17. You have the option to remove any return line on the summary table by clicking the trash icon.

18. Enter Credit Card information

Enter valid credit card information, if required, to process the payment. The credit card authorization includes validation of the bill to address as entered on the Enter Locations page. In the event of any mismatch, you will be directed to the Enter Locations page to update the information.
19. Approve Estimate and Submit Return Request

Click the Submit button. The Order Confirmation page opens. The Submit Order action triggers the creation of Service Request, Service Order and Logistic lines.

• The Order Confirmation page includes the ship to instructions for the returned item. The ship to address comes from the Logistics lines created with the Service Order.

• The Order Confirmation table displays Order Number, Return Type, Item, Quantity, Serial Number, Warranty Status, and Price. Each returned item must have its own line on the Order Confirmation table.

• This page also displays Shipping and Billing Information.

20. Click the Print Confirmation button to print a custom confirmation document of the order.

21. Click the Print Documents button to print custom shipping documents.

22. Click the Manage Returns button to navigate back to the Manage Returns page.
Service Campaigns and Recalls

This chapter covers the following topics:

- Overview
- Service Campaigns and Recalls Process Flow
- Creating a Recall Event
- Using the Details Tab
- Using the Items Tab
- Using the Corrective Actions Tab
- Using the Metrics Tab
- Finding a Recall

Overview

A service campaign is a coordinated set of service actions focused on a specific set of customers or products in a business's install base. Some examples include:

- Calling all customers approaching their next regular maintenance interval.
- Calling all customers who have received service in the last month to survey their satisfaction.
- Emailing customers whose warranties are about to expire soon.
- Coordinating warehouse personnel to replace batteries on all spare parts that have been on the shelf over a certain period of time.

Service campaigns also include field change orders (FCOs), field actions, technical bulletins, and safety alerts. A service campaign enables a business to increase service revenue, improve product performance and increase customer satisfaction. When a campaign is used to address imminent safety hazards or possible product failures, it is
A recall is an action taken to address a problem with an item that makes it likely to fail, cause injury, or violate safety laws. A recall is not always an intimation to a customer to discontinue using the product or return it to the company. It means that the item or device needs to be checked, adjusted, recharged or fixed. Recalls are also called field change orders (FCOs), field actions, technical bulletins, and safety alerts.

A recall is of two types depending on where the recall action takes place:

- **Correction**: A correction addresses a problem with an item in the place where it is used or sold. This is managed by providing information to end customers to fix the problem, sending replacement part to swap out the defective part, or sending a field service agent to resolve the issue.

- **Removal**: A removal addresses a problem with an item by removing it from where it is used or sold. Removals include items in warehouse inventories; spare pools or parts inbound in transit. A company may ship a replacement product to the customer or the customer may return the product to a depot for service. Removals also include items replaced in the place of purchase.

When a company recalls an item, it contacts the impacted parties, supplies information on how to correct the problem, and ensures a plan to prevent the recurrence of the same. Sometimes unsold finished goods are recalled from internal warehouses and refurbished items are recalled from the exchange pool. In such cases, notification and corrective action are directed to the appropriate internal parties. In the cases where the manufacturer issuing the recall is not aware of the end consumers, he only notifies the distributors and instructs them on the various corrective actions to take.

**Service Campaigns and Recalls Process Flow**

There are different types of user types involved in a typical recall business flow.
Quality Manager: Responsible for monitoring customer complaints and the return stream to determine the potential quality event. The Quality Manager can log a product service request in Agile to indicate to the product management and engineering teams that a quality event has occurred.

Product Manager: Works with the Quality Manager to determine if a product service request indicates a legitimate quality event that requires corrective action. If action is required, the Product Manager works with the Engineering and Service teams to determine the best corrective action for the problem.

Service Manager: Responsible for launching and managing the recall effort. The Service Manager provides reports on recall progress and cost, and is responsible for ensuring that service fulfillment is performed.

Returns Coordinator: Works through the queue of recall orders to notify customers of the recall and next steps. He is also responsible for requesting the movement of materials from one location within the enterprise to the appropriate processing location. Additionally, he is responsible for moving materials to another internal or external location after completion of service processing.

End Customer: Receives notification of recall via phone, E-mail or letter. He is responsible for shipping the correct item or part to the appropriate location based on the information provided. He should be able to view details and status for their recalled product online.

Receiving Clerk / Shipping Clerk: Receiving Clerks receive returned materials at the
receiving dock. They enter returned material information into the system; log discrepancies between expected and actual returns, and stage material for the next step in processing. Shipping Clerks pack and ship materials to their next destinations, both within an organization or external to it.

Service Technician (internal or third party): Responsible for processing recalled items. This involves performing service, upgrade, hazardous material removal, part swap, and retirement processing or recycling. He is responsible for tracking the actions they perform, the parts that they use and the hours they spend on each job.

Creating a Recall Event

A recall event must be unique. It is described by attributes that makes it clear as to what event or problem triggered the recall, when it was initiated, who initiated it, and the actions needed to resolve it. The recall record is linked to all the related service requests, service orders, logistics operations, and service operations required to resolve the recall. These linked connections are required to accurately track the scope, progress and cost of a recall.

To create a recall event:

1. Navigate to the Search Recalls page and click the New Recall button. The Create Recall page opens. This page enables you to create a new recall or view and update the attributes of an existing recall record.

2. Enter the following details in the fields provided. Fields marked as * are mandatory fields.
   - Recall Number: System generated unique identifier for the recall. It is not
updateable.

- Recall Name: Unique name of the recall.
- Status: The status of the recall.

3. Expand Hide Additional Details to enter the following details:
   - Classification: Codes indicating categorization.
   - Estimated Number of Units Affected: Estimation of units being affected by the recall.
   - Consumer Contact: Employee or contractor who customers contact with recall queries.
   - Recall Hotline: Number that customers call to get details about the recall.
   - Recall Website: Web site for consumers to find out information about the recall.
   - Reported Date: Date on which recall is made public.
   - Initiation Date: Date on which recall activity starts.
   - Estimated Completion Date: Date on which recall is anticipated to terminate.
   - Mandated Completion Date: Date on which a regulatory body mandates recall completion.
   - Attachments: Represents standard Oracle Applications attachments. You can link attachments to a particular recall.

4. Click Apply to save the new recall. The Update Recalls page opens.

What's Next

The main body of the Create Recall/Update Recalls page contains four tabs - Details, Items, Corrective Actions, and Metrics. For more details about these tabs, select one of the following:

- Using the Details Tab, page 7-6
- Using the Items Tab, page 7-7
- Using the Corrective Actions Tab, page 7-9
- Using the Metrics Tab, page 7-11
Using the Details Tab

The Recall Details region of the Details tab enables you to update the attributes of a recall.

The various attributes that can be updated are:

- **Item Category**: Includes product category, family, or line. You can include multiple categories in a recall.
- **Item Names**: Name of the item. You can include multiple names in a recall.
- **Description**: Description of the selected item.
- **Revision Start and End**: The iterative value assigned to an item with multiple design configurations.
- **Serial Number Start and End**: The serial numbers stamped on item instances that uniquely identify them. Recalls sometimes apply to specific ranges of serial numbers, or to serial numbers with specific prefixes or suffixes.
- **Lot Start and End**: Lot numbers tie together groups of items that came from the same production run, shipment, configuration or other arbitrary association. A recall may include multiple lot numbers.
- **Partner Type**: You can filter by specific partners namely:
  - **Importer**: Party or parties that imported the finished good into the country of sale.
  - **Manufacturer**: Party or parties that manufactured a finished good that is under recall.
  - **Repairer**: Party or parties that serviced a finished good that is under recall.
  - **Seller**: Vendor party or parties that sold an item to the end customer.
- Partner Name: Name of the specific partner
- Partner Location: Location of the specific partner
- Start Date: The start date of the recall
- End Date: The end date of the recall

After entering all the required attributes, click the Apply button to save the changes to the Recall.

**Using the Items Tab**

The Items tab contains a list of all known item instances impacted by the recall. You can link each item instance to a service request, service order and an associated WIP job during recall execution.

You can click on the Service Request number or Service Number to drill to the service request and service order windows.

![Image of Items Tab]

**To use the items tab:**

1. Click the Add Multiple Instances button to navigate to the Search Item Instances page. The Search Item Instance page allows you to perform advanced searches against the Installed Base.

2. Specify any one of the mentioned search parameters to query for the required item instance. To add more search parameters, select a parameter from the Add Another list and click the Add button.

3. Select the Go button to display the Installed Base instances matching your search criteria.
4. Select the item instance you want to add or click the Select All option to add all the item instances.

5. Click the Add to Recall button. A confirmation message appears confirming the addition of item instances.

6. Click the Done button. The Update Recall page appears with the selected item instance(s).

7. Select one or more instance numbers and click the Generate Recall Work button to generate service requests, service orders and/or jobs for them. The quantity on the service order is directly derived from the quantity specified in Installed Base for the instance.
   - If you enter only the Service Request Type and click Generate, it creates a service request for each selected item instance, or if there are multiple non-serialized quantities create a single service request for the entire non-serialized quantity.
• If you select both Service Request Type and Service Order Type and click Generate, it creates a service request and service order for each item instance, again consolidating multiple non-serialized quantities.

• If you enter a Service Request Type, a Service Order Type and a Service Code and click Generate, it creates a service request, service type and job for each checked item instance, again consolidating multiple non-serialized quantities.

• If no service request exists for an item, you cannot generate service orders and jobs. Similarly, if no service order exists, you cannot generate a job for an instance. However, if a service request was previously created for an instance, then you can generate a service order and job for it at a later time.

• If an upgrade item is specified, and a job is created for the selected instance, the job is created for the upgrade item and not for the item specified by the instance. This job has at least one material requirement line with item as the item of the selected instance.

8. The system generates a service request, service order, and work order for the specific item instance.

9. You can navigate to the Service Order page of the Technician Portal by clicking on the Service Order Number link generated on the Items tab. The Service Execution tab displays the operations, materials and resources specified by the Service Code that displayed on the Items tab before you clicked Generate Recall Work.

Using the Corrective Actions Tab

When a company recalls an item, it contacts the impacted parties, supplies information on how to correct the problem, and puts a plan in place to prevent the problem from happening again. Sometimes unsold finished goods are recalled from internal warehouses and refurbished items are recalled from the exchange pool. In such a case, notification and corrective action are directed to the appropriate internal parties. In some cases, the manufacturer issuing the recall may not know the end consumers, and notifies their distributors and instructs them on the corrective actions to take.

The Corrective Actions tab stores information regarding the reason for the recall, risk, discovery and resolution plan.
### Problem Region

The Problem region enables you to enter the problem details. Enter the following information in the fields provided:

- **Discovery Date**: The date on which the company realized that a recall is needed.
- **Recall Reason**: Descriptive text describing why a particular recall was made.
- **Problem Description**: Description of the problem that resulted in a need for recall.
- **Discovery Method**: Description of how the problem was identified.
- **Incidents and Injuries**: Description of notable cases of occurrence, especially those involving injuries.
- **Risk**: Describes the possible risks introduced if the recall is not made.
- **Consequence**: Description of the potential impact to customer health, customer satisfaction, company reputation and company finances.

### Resolution Region

Resolution region enables you to enter the details of the remedial actions taken. Enter the following information in the fields provided:

- **Remedial Actions**: Description of specific actions that need to be taken to resolve the problem under recall.
- **Recall Strategy Description**: Description of the plan of action for the recall. This is required for reporting to regulatory agencies. This includes a description of the
different phases of the recall.

After entering the problem and resolution details, click the Apply button to save the changes to the Recall.

Using the Metrics Tab

The Metrics tab provides information regarding how many item instances are impacted, how many customers are impacted, how many items still require processing, and how many customers are still impacted.

Additionally, the Metrics tab tracks the accumulated cost of the recall so far and the estimated remaining cost of the recall.

The various fields in the Metrics tab display the following information:

- **Number of Recalled Units**: Derived from the number of item instances linked to a recall. If item instances have multiple quantities, the total quantity is aggregated.

- **Number of Units Remediated**: Derived from the quantity of Installed Base (IB) instances linked to the recall with closed service requests. If an IB instance with multiple quantities is linked to a service request, and the service request is still open, the system considers the entire quantity un-remediated. If the service request is closed, the system considers the entire quantity remediated.

- **Number of Units Un-remediated**: Derived from the number of item instances linked to a recall for which no closed service request exists. In cases where item instances linked to the recall have no service request, these instances are included as un-remediated.

- **Accumulated Cost**: The calculation for accumulated cost factors in the cost of issued material and transacted labor time for jobs linked to the recall.

- **Estimated Remaining Cost**: Derived as, (Accumulated cost till date / Number of units used for calculation of accumulated cost) * Number of item instance quantities
that are eligible but not yet costed

Number of item instances that are eligible but not yet costed, represent all the instances that do not have a positive cost yet, minus the closed service requests (SR). Since a closed SR is a remediated unit, you must not consider it for the calculation of estimated cost remaining.

**Example**

A recall has 4 instances linked to it and the quantity for all the instances in Installed Base (IB) is 1.

Instance 1 has SR, SO and WIP job created and some part and labor costs are recorded against it. Assume the cost is $100.00

Instance 2 has SR, SO and WIP job created but no part of labor costs recorded against it.

Instance 3 has SR and SO created but no WIP job created against it yet.

Instance 4 has only SR created and the SR is closed.

The Estimated Remaining Cost: in this case is (100/1)*2.

- Number of Customers Impacted: Derived from the unique number of customers linked to the recall. This is determined from the installed base instances linked to the recall.

- Number of Customers Remediated: Derived from the unique number of customers linked to the recall for which all service requests are closed.

- Number of Customers Un-remediated: Derived from the unique number of customers linked to the recall whose service requests are not all closed.

- Click the Recalculate Metrics button to refresh the Recall Metrics.

**Finding a Recall**

On the Search Recalls page, you can retrieve Recall records from the database. A search in Oracle Depot Repair enables you to retrieve Recalls based on parameters related to a Recall. You can use a combination of these parameters to restrict your search so as to retrieve only the Recall that you want.

**To find a recall:**

1. Navigate to the Search Recalls page.

2. Enter any one of the following search parameters:

   - Recall Number
• Recall Name
• Recall Status
• Creation Date
• Item Category
• Item
• Item Revision
• Initiation Date

3. Click the Go button. The results area displays the recall record matching your search criteria.
This chapter covers the following topics:

- Overview
- Environmental Impact Dashboard Overview
- Using the Returns Tab
- Using the Eco-Impact Tab
- Using the Disposition Summary Tab
- Using the Put on Market Tab

Overview

Environmental Impact Dashboard enables the organizations to monitor its return streams to reduce returns processing costs, recover value from returned assets, build better products, and minimize its impact on the environment. Environmental Impact Dashboard also helps to adhere to various environmental regulations such as WEEE and ROHS. These laws require organizations to take back products that a customer no longer wants, take back packaging materials, track the recycling programs and scrap contributions, and remove hazardous materials from returns and dispose them properly. Organizations require tools to help manage these new requirements, minimize their costs and provide the reporting necessary to comply with the legislation.

The Environmental Impact Dashboard enables you to perform the following:

- Monitor how much material is being returned through each return stream: Environmental Impact Dashboard helps to monitor how much material is returned from customers and the value of that material. This helps to reduce the overall number of returns, monitor the return stream to react quickly to rapidly increasing returns, and create programs to increase the recovery of higher-value assets.

- Monitor how much scrap and hazardous material comes from returns: Companies have legal and ethical responsibility to monitor and mitigate their impact on the
environment. In addition to energy consumption and carbon emissions, manufacturing and retail companies produce significant amounts of scrap and hazardous waste. Environmental Impact Dashboard provides the capability to monitor how much of the return stream ends up in scrap so that effective ways are developed to re-use and recycle materials and to build products that create less waste and hazardous material.

Environmental Impact Dashboard Overview

The Environmental Impact Dashboard displays current Returns Streams and Material Disposition metrics. The header of the Environmental Impact Dashboard enables you to select the time period and organizational scope for which you want to see data.

**Note:** You must run the concurrent program, Depot Environmental Impact Dashboard Business Intelligence, to update the materialized views and set the profile option CSD: Default Category Set for Environmental Impact Dashboard to Yes before running queries in the Environmental Impact Dashboard.

The Environmental Impact Dashboard Header displays the following information:

- **Period:** Represents the following:
  - Year to Date displays data for the current year.
  - Quarter to Date displays data for the current quarter of the selected year.
  - The Last 7 Days allows you to pick the last seven days (inclusive).
  - Choosing a specific date displays data only for that date.
  - Choosing the current date, month, quarter or year, the Dashboard displays data for that period-to-date.

- **Operating Unit:** Refers to the Operating Unit for which you want to view data.

- **Weight UOM:** Indicates the unit of measure of the weight of units returned.

- **Item Category:** Comes from the Service Validation Inventory Organization. It is not
associated with the Operating Unit and Inventory Organization values selected on the header.

- Customer Type: Draws from the Customer Type value (person, organization) associated with the returning Party. This allows data to be filtered based on whether the return is from a business to business or business to consumer transaction, which some regulatory agencies require companies to report. You can also use this filter to query Put on Market shipments.

- Inventory Organization: Refers to the location to where the material was returned. It is the collection, aggregation or processing center.

- Currency: Represents the currency in which returned materials are valued.

- Geography: This filter refers to the Trading Community Architecture (TCA) Geography for the transactions being queried.

- Region: Supports the ability to report take-back, put on market and disposition information at the macro-region level.

- Export button: Exports the data from either the entire tab or from just a table to a spreadsheet.
  - For Returns: Region and Geography information indicate where the material was returned from.
  - For shipments: Region and Geography information indicate where the material was Shipped to.
  - For material transactions: Region and Geography information indicate the location of the subinventory that the material was transacted to.

You can view metrics for across all operating units and also view metrics for any operating unit if the profile option, CSD: Environmental Impact Dashboard Visibility Level, is set to Enterprise level. If you have operating unit visibility, and MOAC is enabled, the Operating Unit field in the Environmental Impact Dashboard header requires you to pick an operating unit you have access to via MOAC setup, in order to query Returns metrics. If MOAC is not enabled and the profile is set to Operating Unit, then the operating unit field in the Environmental Impact Dashboard is not updateable and is set to the operating unit specified by the profile MO: Operating Unit.

To view the relevant return streams, enter the fields mentioned above and click the Go button. The Returns tab, Eco-Impact tab, Disposition Summary tab, and the Put on Market tab populate with the information of the specified period.

The body of the Environmental Impact Dashboard contains four tabs - Returns,
Eco-Impact, Disposition Summary, and Put on Market. For more details about these tabs, select one of the following:

- Using the Returns Tab, page 8-4
- Using the Eco-Impact Tab, page 8-6
- Using the Disposition Summary Tab, page 8-8
- Using the Put on Market Tab, page 8-8

**Using the Returns Tab**

The Returns tab displays a consolidated report of the number of units returned by the return stream.

The Return Stream Comparisons region displays the following information.

- **Return Stream**: Return Streams are lookups associated with an Order Management (OM) return reason code. Returns must have an OM reason code that is linked to a Return stream in order to be shown in this table.

- **Units Returned Selected Period**: Represents the number of units on RMAs for the specified return stream within the period of analysis. You can query this from the Sales Order and Service Order tables.

- **Units Returned Prior Year**: Represents the number of discrete units returned to the business that map to the specified return stream during the prior year. Prior year represents same period of time as the selected period, except in the prior year. For example, if the selected period is March 1st-31st 2010, then the prior year data is returns from March 1st-31st 2009.

- **Returned Weight Selected Period**: Represents the total weight of all units returned that map to the specified return stream. The weight of any item is defined for it in the Inventory Item Master.

- **Returned Weight Prior Year**: Represents the total weight of all units returned during the prior year. The weight of any item is defined for it in the Inventory Item Master.
**Returned Value Selected Period:** Represents the total value of all units returned that map to the specified return stream. The value of any item is specified as the standard cost of that item in Cost Management.

**Returned Value Prior Year:** Represents the total value of all units returned during the prior year. The value of any item is specified as the standard cost of that item in Cost Management.

**Note:** The Returns tab includes only the RMAs that are received. The rcv_transaction entry exists for the order line and has source_document_code = RMA and transaction_type = DELIVER.

The Returns by Inventory Organization graph represents the flow of returns for a particular inventory organization for a selected period and its corresponding previous year.

The Returns by Return Stream graph represents the flow of returns for various return streams for a selected year and its corresponding previous year.

The Returns Trends for Selected Period graph shows the total flow of returns for a selected period.

The Returns Trends for Prior Period graph shows the total flow of returns for the previous period.
Using the Eco-Impact Tab

The Eco-Impact Tab provides a comparative analysis of targeted eco-impacts. The tab provides the following information:

- **Number of Units by Disposition** shows the number of units for each disposition in the selected period vis a vis the prior period and the percentage change in these periods. Green threshold indicators indicate that everything is operating within acceptable limits.

- **Weight by Disposition** shows the total weight of the units transacted for each disposition in the selected period vis a vis the prior period and the percentage change. Green threshold indicators indicate that everything is operating within acceptable limits.

- **Percentage of Units by Disposition** shows the number of units dispositioned against the number of units returned in all return streams expressed as a percentage.

- **Percentage of Weight by Disposition** shows the total weight dispositioned against the total weight returned in all return streams expressed as a percentage.

**Note:** The Eco-Impact tab includes dispositions of all materials that are negative or return transacted in WIP. This is regardless of whether or not the job or service order is closed.

- **Scrap Trends for Selected Period** shows time-series trends for weight of material sent to scrap during the analysis period.
• Scrap Trends for Prior Period shows time-series trends for weight of material sent to scrap during the same period in prior year.

• Hazardous Materials Trends for Selected Period shows time-series trends for weight of material disposed as hazardous materials during the analysis period.

• Hazardous Materials Trends for Prior Period shows time-series trends for weight of material disposed as hazardous materials during the same period in prior year.

• Scrap by Inventory Organization shows the weight of returned material sent to scrap for a particular Inventory Organization.

• Hazardous Materials by Inventory Organization shows the weight of returned material disposed as hazardous materials for a particular Inventory Organization.

Note: All the Scrap and Hazardous Materials metrics are measured by the amount/weight of the materials that were WIP negative issued or returned with a reason code that belongs to the Scrap/Hazardous
Materials dispositions that were setup.

Using the Disposition Summary Tab

The Disposition Summary tab provides an overview of the profit and loss from processing different categories for returned materials in different ways. For each category and disposition combination, the table lists the cost to process the material, the value of the recovered material, and the profitability of the value minus the cost. Operations personnel use this table to track the effectiveness of various processing options.

The Disposition Summary Information region of the Disposition Summary tab displays the following information:

- **Category:** The categories belonging to the category set in the profile option CSD: Default Category Set for Environmental Impact are used. The profile option lists only the Category Sets that allow one category per item in that category set. The items will only belong to one category for the environmental impact reporting.

- **Disposition:** This value maps to the disposition values available in the Material Transaction Reason Code column on the Technician Portal Materials table.

- **Quantity:** The number of units returned in each category bucket determines this value.

- **Recovery Value:** This is derived from the standard cost of the item defined the Service Inventory Validation Org.

- **Processing Cost:** Processing Cost is derived from the Order Cost of the item for the organization that the item was transacted in. For example, if the material transaction is performed in the inventory Organization M1, the processing cost is the same as the order cost for that material in M1 inventory organization.

- **Recovery Profit:** This value is derived by subtracting Processing Cost from Recovery Value.

Using the Put on Market Tab

The Put on Market tab helps to assess how much the given products or product category been sold or placed into a specific geographic region by the business. This is required for regulatory compliance in many countries and states.

The Put on Market tab displays the following information:

- **Category Name:** This value is derived from the Service Inventory Validation Org.
• Category Description: Description of the Category you select.

• Quantity: This value is derived from the number of units sold once converted to the primary unit of measure as defined in the Service Inventory Validation Org.

• Weight: Displays values for items for which a weight is defined in the Inventory Item Master. If the weight of an item is not defined in the Inventory Item Master, that item is not included in the total weight calculation.
This chapter describes how to easily receive items into the depot that arrive with or without an RMA.

This chapter covers the following topics:

- Overview
- Entering and Processing Bulk Receive Data
- Bulk Receive Items Processing Logic

Overview

The Bulk Receiving module enables you to record the information required to process service order items when they arrive in the depot with or without a return materials authorization (RMA). This module enables a receiving clerk to process both expected and unexpected receipts using the same screen.

In general, you use the bulk receiving function to create a batch of items per customer per shipment. The items can have any of the following attributes:

- Serialized or non-serialized
- Trackable or non-trackable - the tracking is performed by Oracle Installed Base
- Lot controlled
- Locator controlled
- Revision controlled

All combinations of these attributes are allowed.

The bulk receiving module facilitates the following:

- For a returned item if a matching RMA exists, the system automatically receives the
item against that RMA. In this case, the receiving clerk does not need to know the RMA number.

- For a returned item if no matching RMA exists but an open RMA exists for that customer, the system automatically creates a Service Order (SO) and RMA with the item received.

- For a returned item if no SR, SO, or RMA exist, the system automatically generates the SR, SO, and RMA and receives the item against it. The system marks such an RMA as an unexpected receipt.

- For a returned item, you can capture unique external reference number, if any, using bulk receiving. You can personalize this field to capture the required external reference number.

- In case of over-receipt, the system automatically receives the material by creating new RMA lines to match the over-received quantity. Corresponding new ship lines are also created for service types that require them, and the system tracks this material as unexpected for later audit.

- In case of under-receipt, the system automatically receives the materials returned and then split off separate open RMA lines for the materials pending receipt.

- Few customers log a service request for items they return, but do not specify the item numbers, serial numbers or quantities. The service request is used to track that a shipment was sent for service. At receipt, you can open a SR to match the items received, and have the system automatically create the SO and RMA numbers for each returned item.

- Bulk receiving supports capture of locator, lot and revision controlled items at the time of receiving.

**Bulk Receive Process Overview**

For each batch perform the following operations:

1. Enter either the customer account number, or a service contract number - from which Oracle Depot Repair derives the account number.

   **Note:** The search criteria in the header region are only used to uniquely identify a Party and Account. It does not filter the search to limit serial numbers.

2. For each item, enter as much of the following data as you know:

   - Item Name
• Serial Number, for serialized items

• Quantity (mandatory)

• UOM
  
  If the UOM is not entered, the primary UOM of the item is derived.

3. Click Process to process the batch; if there are any problems with the data entered for any item, you can correct the data, and then process the batch.

A concurrent request is submitted, whose objective is to create the following objects for each batch of items:

• One service request

• A service order and an RMA for each item

The concurrent request will also attempt to auto-receive the items. When an item is auto-received, its status in the Return line in the Logistics tab of the Depot Repair Workbench is set to Received.

The following diagram shows an overview of the Bulk Receive processing, as performed in two pages, the Bulk Receive page and the Bulk Receive Warnings page.
Entering and Processing Bulk Receive Data

Steps

1. Select the Account or Contract Number.
   Oracle Depot Repair uses Contract Number to derive the Account.
   The Party is derived from the Account.

2. For each item, you enter as much of the following data as you know:
   - Item Name
Bulk Receiving Module

- Serial Number, for serialized items
- Quantity (mandatory)
- UOM

3. For processing the expected receipts, set the profile option, CSD: Enable Expected Receipts for Bulk Receiving, to Yes. The Party Information region has Incident Number that defaults the account details and is used if there are any unplanned receipts. A new unplanned Service Order is created against this incident number if it is entered.

To proceed without processing the expected receipts, continue with the following steps.

4. Click Process.

5. If there are no problems with any of the data, continue at step 9.

6. If there is at least one problem, the Bulk Receive Warnings page appears.

7. You can optionally edit any of the fields.

8. Click Process.
For any unplanned receipts, it is displayed in the Unplanned Receipts page.

9. The Depot Repair Bulk Receive Items concurrent request is submitted. A confirmation message shows the request number and the Transaction number parameter associated with the request.

   **Note:** Note down the Transaction number. In case there are any errors in the processing of the entries, it can be reused in a subsequent submission of the concurrent request - see step 12.

10. The concurrent request attempts to create the following objects for each data row, depending on what data has been entered:

    • One service request

    • A service order and an RMA for each item

   The concurrent request will also attempt to auto-receive the items.

11. To see the results of the concurrent request, examine the output of the request. The report shows which objects were created, and also any errors.

12. After you correct the errors, you can explicitly resubmit the Depot Repair Bulk Receive Items concurrent request, entering as a parameter the same Transaction number that appeared in the confirmation message at step 8. This resubmitted concurrent request will attempt to process only the error entries.

**Bulk Receive Items Processing Logic**

The objects created during the Bulk Receive processing depend on the following:

• The predefined attributes of each item

• Whether or not you entered all the required attribute values for the item

• Predefined profile options
Predefined Item Attributes

The item attributes are associated with the item when it is defined in Oracle Inventory. The item attributes examined by the Bulk Receive processing logic are as follows:

- Whether the item is trackable by Oracle Installed Base
- Whether the item is serialized, and if so, how is the serial number attached to the item instance - predefined, at receipt or at sales order issue?

Item Data Entered on Bulk Receive Page

The main consideration for entering bulk receive data is to enter item identification and serial numbers when required for serialized items.

If you enter insufficient or mismatching data, you will get warnings on the Bulk Receive Warnings page.

Note: After you have entered either an Account or a Contract Number, for each item entry - that is, each data row entered in the Bulk Receive page - the Bulk Receive processing logic always creates a service request, which you can edit later.

Use of Profile Options

Default Values

Several fields in the objects created by Oracle Depot Repair derive their values from profile options.

The profile options used for default service request values are:

- CSD: Default Service Request Owner for Bulk Receiving
- CSD: Default Service Request Severity for Bulk Receiving
- CSD: Default Service Request Status for Bulk Receiving
- CSD: Default Service Request Summary for Bulk Receiving
  This provides the Problem Summary for the service request.
- CSD: Default Service Request Type for Bulk Receiving
- CSD: Default Service Request Urgency for Bulk Receiving

The profile option used for service orders is:
Ownership Transfer

The profile option CSD: Transfer of Ownership for Bulk Receiving is used when all the following conditions apply:

• A serial number is entered on a Bulk Receive row.

• The item is defined as trackable by Oracle Installed Base.

• The party associated with the entered serial number does not match the party in the Bulk Receive batch header.

If an item instance for the serial number does not exist, it is created, else the existing item instance is updated.

For both item instance creation and item instance update, the item instance owner is set according to the value of CSD: Transfer of Ownership for Bulk Receiving, as follows:

• If the value of the profile option is Yes; the item instance owner is set to the Bulk Receive party.

• If the value is No, the item instance owner is set to the party associated with the entered serial number, with the following Note: "Install base owner will be changed to the entered Party."

Bulk Receive Processing Logic Table

**Note:** In this section, the term Internal Party refers to the Party Name set up in the Oracle Installed Base Install Parameters.

If you do not enter the Item field in a Bulk Receive row, then only a service request is created, with the following attributes:

• Party = Internal Party

• Note = "No item has been entered"

If you enter an Item in a Bulk Receive row, the table following shows the different processing options that occur.

*Key to the abbreviations in the following table:*
• **IB** = Oracle Installed Base
• **RMA** = Return Material Authorization
• **SO** = Service Order
• **SN** = Serial Number
• **SR** = Service Request

<table>
<thead>
<tr>
<th>IB-tracking Item?</th>
<th>Serialized Item?</th>
<th>Serial Number Entered?</th>
<th>Other</th>
<th>Processing Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>SN matches the Item entered</td>
<td>Create SR, SO, RMA, and attempt to Auto-Receive.</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>SN does not match the Item entered</td>
<td>New IB instance and SN created for the Item. Create SR, SO, RMA, and attempt to Auto-Receive.</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>-</td>
<td>Create SR for specified party. If Quantity &gt; 1, then create SO in Draft status; if Quantity = 1, then create SO, RMA, and attempt to Auto-Receive.</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-</td>
<td>Create SR for Internal Party with Note = &quot;Serial number has been entered for a non-serialized item.&quot;</td>
</tr>
<tr>
<td>IB-trackable Item?</td>
<td>Serialized Item?</td>
<td>Serial Number Entered?</td>
<td>Other</td>
<td>Processing Logic</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
<td>------------------------</td>
<td>-------</td>
<td>------------------</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>-</td>
<td>Create SR, SO, RMA, and attempt to Auto-Receive.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>SN matches the Item entered</td>
<td>Create SR, SO, RMA, and attempt to Auto-Receive.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>SN does not match the Item entered</td>
<td>If SN is Predefined, then create SR for Internal Party with Note = &quot;Cannot create new Serial num for a Predefined Serialized item&quot;. If SN is At Receipt or At Sales Order Issue, then create new SN and create SR, SO, RMA, and attempt to Auto-Receive.</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>-</td>
<td>Create SR for specified party. If Quantity &gt; 1, then create SO in Draft status; if Quantity = 1, then create SO, RMA, and attempt to Auto-Receive.</td>
</tr>
<tr>
<td>IB-trackable Item?</td>
<td>Serialized Item?</td>
<td>Serial Number Entered?</td>
<td>Other</td>
<td>Processing Logic</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
<td>------------------------</td>
<td>-------</td>
<td>-----------------</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>-</td>
<td>Create SR for Internal Party with Note = &quot;Serial Number has been entered for a non-serialized item.&quot;</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>No</td>
<td>-</td>
<td>Create SR, SO, RMA (all for specified party), and attempt to Auto-Receive.</td>
</tr>
</tbody>
</table>

**Comments**

If you enter a Serial Number for a serialized item, and a Quantity greater than 1, a error message appears warning you that the Quantity should be 1. Click the link in the error message to take you back to the error row.

If you do not correct the error and continue to Process, the service order that is created will be in Draft status. You can then enter the individual serial numbers through the standard Oracle Depot Repair facility Tools > Capture Serial Numbers.
This chapter describes an enhanced set of operations to process service order items. This chapter covers the following topics:

- Overview
- Searching for Service Orders
- Service Order Page Overview
- Using the Evaluation Tab
- Using the Service Execution Tab
- Using the Debrief Report Tab
- Launching Service Order Orchestration in the Technician Portal
- Generating Estimates
- Using the Complete Work button
- View Service Bulletins from the Technician Portal
- Manage ECOs
- Backflush Service Parts
- Auto-Issue Service Items to Jobs
- Using Time Clock
- Deleting Operations

Overview

The Technician Portal is an enhancement to the standard repair and return process. It automates and facilitates the creation of work orders, procuring and issuing materials, and assigning resources with minimal input and decision making from a service technician. Based on a finite number of possible symptoms and a finite number of responses to those symptoms, the system can recommend or dictate work to be done,
materials demanded, and resources needed for low complexity services based on symptoms captured by a technician.

The following diagram shows an overview of the high volume repair processing, to be performed in two pages, the Service Order Search page and the Service Order page.

- **Service Order Search page**
  - Search for items
  - Select item to process

- **Service Order page**
  - **Evaluation tab**
    - Evaluate current problem based on solutions to problems for same or similar items
    - Generate jobs
  - **Service Execution tab**
    - Add materials to job operations
    - Add resources to job operations
    - Complete job operations
  - **Debrief Report tab**
    - Select root causes of defect
    - View key performance indicators
    - View activities
    - View supplier warranty

You can view and add Notes in all the tabs
Searching for Service Orders

In the Service Order Search page, you can search for all non-draft service orders. The seeded default search parameters are

- Item
- SO Number
- Service Order Status
- Service Order Owner

After filling in one or more search parameters, click Go to perform the search. In the results area, you can hide or show details about each service order.

**Note:** A Service Order may be displayed twice in the Results region if it has two RMAs associated with it, that is, one entry per RMA is displayed.

Click the SO Number link to continue processing a service order in the Service Order page.

**Service Order Page Overview**

The top of the Service Order page contains general information about the item instance.
that is being serviced. You can also show or hide service order details in this region.

Note: You can view the Recall Number link if it’s view is personalized. Click on the link to drill down to the view-only Recall Details screen.

The main actions to perform in this page are controlled by the buttons: Save, Apply, Cancel, and Update Status.

When a job is created, a logic starts off to determine if the job is impacted by supplier warranty.

The main body of the Service Order page contains three tabs - Evaluation, Service Execution, Debrief Report - where you perform the main service order processing.

For more details about these tabs, select one of the following:
- Using the Evaluation Tab, page 10-5
- Using the Service Execution Tab, page 10-7
- Using the Debrief Report Tab, page 10-13

The Notes region, at the bottom of the page, is to allow you to view and add notes.
Using the Evaluation Tab

The Evaluation tab enables you to examine summary information about previous service orders and service requests for the current service order item instance, and also the diagnostic codes and service codes associated with the current service order item. After evaluating this information, you can generate one or more WIP jobs.

The first-ever display of the Evaluation tab for a service order item shows the following:

- All the diagnostic and service codes that have been associated with the service order item.

- All the service orders that reference the current service order item instance. Click a Service Order link on the Service Order History region to view the details of that service order.

- All the service requests that reference the current service order item instance. Click a Service Request link on the Service Request History region to view the details of that service request.

The main tasks to perform in the Evaluation tab are to select - that is, mark as Applicable - diagnostic codes and service codes to generate WIP jobs with appropriate bills and routings.

Diagnostic Codes Region

The Diagnostic Codes region displays the diagnostic codes associated with the service order item, that is, the diagnostic codes that fulfill at least one of the following conditions:

- The diagnostic code has the service order item as one of its item domains.

- The diagnostic code has a category domain which is the same as the category of the service order item.

<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Applicable</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC4</td>
<td>Diagnostic Code 4</td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>DCS</td>
<td>Diagnostic Code</td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>DEMC2</td>
<td>Demo Diagnostic Code 2</td>
<td></td>
<td>0%</td>
</tr>
</tbody>
</table>

For more information, see the topic Setting Up Diagnostic Codes in the Oracle Depot Repair Implementation Guide.

The frequency indicates the percentage of times that the diagnostic code was marked as Applicable in all closed service orders that are for the same service item.
Using the Diagnostic Codes Region

- Mark one or more of the diagnostic codes as applicable.
  The applicable diagnostic codes are used in determining which service codes to use when you click Recommend Services in the Service Codes region.

- Duplicate one or more of the diagnostic codes as applicable.
  The Duplicate functionality enables you to save more than one set of DFF values for a particular diagnostic code in a service order. The Duplicate icon for a row is enabled if the diagnostic code is marked as Applicable.

- Add one or more of the diagnostic codes to the existing list.
  The Add Another Row button enables you to quickly add extra rows to input DFF data. You now do not have to search for the appropriate diagnostic code row and duplicate it using the Duplicate icon. When you add another row, you cannot duplicate it unless you save it. Also, it must be marked as Applicable.

Service Codes Region

The Service Codes region initially displays the service codes associated with the service order item, that is, the service codes which fulfill at least one of the following conditions:

- The service code has the service order item as one of its item domains.
- The service code has a category domain which is the same as the category of the service order item.

For more information, see the topic Setting Up Service Codes in the Oracle Depot Repair Implementation Guide.

The frequency indicates the percentage of times that the service code was marked as Applicable in all closed service orders for the same service item.

Using the Service Codes Region

1. Mark one or more service codes as Applicable.
2. Click Recommend Services.

Note: To use this feature, you must have previously set up the

After you click Recommend Services, you may get several service codes returned and automatically marked as Applicable in the Service Codes region, depending on how you set up your recommendations.

When the profile option CSD: Mandate Service Code Recommendations is set to Yes, then any service codes returned which had been set up with a Recommendation type of Always are automatically marked as Applicable and are disabled. This is to ensure that the service codes are used in any jobs generated from this region.

3. Click Generate Jobs.

For each service code marked as Applicable, Oracle Depot Repair generates a WIP job, with any bills and routings that were previously associated with that service code.

For more information, see Setting Up Service Codes in the Oracle Depot Repair Implementation Guide.

4. In the Service Code table, click the hyperlinked Job number to drill into the WIP Details. The WIP Details page provides information on the available quantity for the parts required on a job, the operations which are for outside service, and other details that are provided in WIP Jobs.

Using the Service Execution Tab

The general objective of the Service Execution tab is to enable you to process and monitor the WIP jobs that you have generated for a service order item from the Evaluation tab of the Service Order page.

In the Service Execution tab, you can add materials and resources to jobs. To assist you in doing this, Oracle Depot Repair provides you with statistics of the most common materials and resources used in previous service orders for the same item.

You can complete operations, and even complete jobs.

1. In the Service Execution tab, you can also create jobs; to add materials and resources for these jobs, use WIP pages associated with Oracle Work In Process responsibilities.

2. Oracle Depot Repair provides E-records and E-signature (ERES) functionality in WIP mode via Oracle WIP.

When the following profile options are set to Yes, the current revision defaults and you
are not prompted to enter a revision. When the profile options are set to No, the revision does not defaults and you navigate to the Material Details page to choose a revision along with other required item details:

- CSD: Default Current Item Revision for Material Transactions
- CSD: Default Current Item Revision for Job Completions

The two profile options behave independently, so that the revisions default for issuing materials but not job completions, or the other way round.

**Note:** When a user clicks the Service Execution tab, it may trigger custom logic your business has developed using user hooks embedded in this tab.

### Service Operations Region

The Service Operations region shows the operations for the current service order item instance, whether generated from the Evaluation tab, or created explicitly in the Service Execution tab.

### Using the Service Operations Region

1. **Update operation details** - click the Update icon for the operation.

2. **Add operations to a job** - select one or more operations, select the Action Add Operation to Job, select the job from the list of values, and click Go.

3. **Complete operations** - select one or more operations, and click Complete.

4. **Complete the job** - select the Complete Job action from the Action list, select the job from the list of values, and click Go.

5. **Release the job** - to manually release an unreleased job, select the Release Job action from the Action list and click Go. You can also change the Job status to Unreleased or OnHold

**Note:** The ability to change the status of a job in the Technician Portal using the Action list is possible provided the following security function is granted: Depot: Allow Update of Job Status in Technician Portal.
6. Drill into WIP Details – Click the Job link to navigate to the Job Details page to drill into the WIP details of the job.

7. Click the DFF field to enter the DFFs for operations. The DFF name for operation is Depot Repair WIP Transaction Details and the context field shown in the table is determined by the profile, CSD: Descriptive Flexfield Context for Technician Portal Operations.

Materials Region

The Materials region has two sub-regions:

- The general Materials area
- The Most Common Materials Issued area

The first-time display of the Materials area shows the materials automatically added to a job through service codes.

The Most Common Materials Issued area, if populated, shows which materials were used in previous similar jobs and service orders.

Specifically, all closed service orders for the current service order item with completed or closed jobs are examined. The Frequency column for a material shows the proportion of those examined service orders whose completed and closed jobs used the material.

The Average Quantity Used shows the average units used in all the “matching” service orders whose jobs contained the material, rather than in all the examined service orders.

Using the Materials Region

1. Examine the materials in the Most Common Materials Issued area, and decide if they are relevant to the current service order. If so, select one or more materials, and click Add to Materials.

   **Note:** You cannot add materials that already appear in the general Materials area.

   The selected materials appear in the general Materials area.

2. In the general Materials area, you can enter quantity and UOM values for a material before or after it is issued to a job.
3. If the quantity to issue is 1 for a serialized item, you must also enter the Serial Number for the item.

4. For materials added from the Most Common Materials Issued area, enter and select values for Quantity to Issue, UOM to Issue, Operation, and Job.

5. The Reason column tracks the Disposition Code that indicates how materials were processed. You can override the defaulted value before issuing materials.

6. You also have the option to issue one quantity of a material with one Disposition Code, and issue more quantity of the material with a different disposition code.

7. Click Save to save the data you have entered so far.
   
   If you selected an operation and job in the current session, the materials are added to the job details, but not issued to the job; the Job field displays a link to the job.

8. To issue materials to a job, select one or more materials, and click Issue.

9. For materials that require more information, the Material Issue Details page appears.
   
   For example, if you want to issue more than one serialized item, you must enter the serial numbers here. Also, if your item has lot control, you must enter the lot number here.

10. After you have issued materials, the general Materials area shows the Issued Quantity and the primary UOM.

11. You can continue to enter Quantity to Issue values, including negative integer quantities. If the quantity is negative then the material will be added to the subinventory specified.

12. Click the DFF field to enter the DFFs for materials. The DFF name for materials is Depot Repair WIP Transaction Details and the context field shown in the table is determined by the profile, CSD: Descriptive Flexfield Context for Technician Portal Materials.

   **Note:** You can personalize the Materials table to enable the hidden Revision field. The Revision field allows you to enter and transact revision-controlled items. If the revision field is blank for a revision-controlled item, you are directed to the Material Issue Details page at time of issue or at time of operation or job completion for items with Assembly Pull Supply Type. If the revision field and all other required fields are entered then the item is issued immediately.
The Revision field defaults to the latest revision for revision-controlled items if the profile option CSD: Default Current Item Revision for Material Transactions is set to Yes. When the profile is set to No, the revision field is not defaulted and it is left blank.

You can personalize the Materials table to display the Request Parts button that enables a technician to create a purchase requisition for one or more items on the Materials table.

You can personalize the Materials table to display the Material Transaction Reason Code column that provides Disposition Code that is used in the Eco-Impact tab of the Environmental Impact Dashboard. For more information on the Environmental Impact Dashboard, please see: Environmental Impact Dashboard chapter.

You can personalize the Materials table to enable the hidden Create SO column which can be used to auto-create service orders for recovered parts after a technician has completed jobs. Use Defaulting Rule attributes to indicate for which parts service orders should be auto-generated. You can choose to auto create service orders for all parts, or for specific parts or situations. The workflow CSD: Auto-Create Service Orders for Recovered Parts is linked to the service order status transition once the technician completes the service work.

You can view the activities SO Created and Component SO Created in the Technician Portal Activities region as well as from the Depot Workbench Activity form.

**Resources Region**

The Resources region has two sub-regions:

- The general Resources area
- The Most Common Resources Transacted area
The first-time display of the Resources area shows the resources automatically added to a job through service codes.

The Most Common Resources Transacted area, if populated, shows which resources were used in previous similar jobs and service orders.

Specifically, all closed service orders for the current service order item with completed or closed jobs are examined. The Frequency column for a resource shows the proportion of those examined service orders whose completed and closed jobs used the resource. The Average Quantity Used shows the average units used in all the "matching" service orders whose jobs contained the resource, rather than in all the examined service orders.

### Using the Resources Region

1. Examine the materials in the Most Common Resources Transacted area, and decide if they are relevant to the current service order. If so, select one or more materials, and click Add to Resources.

   **Note:** You cannot add resources that already appear in the general Resources area.

   The selected resources appear in the general Resources area, with the Employee field set to the value of the profile option CSD: Default HR Resource.

2. In the general Resources area, you can enter quantity and UOM values for a resource before or after it is transacted to a job.

3. You can select a new employee.

4. For resources added from the Most Common Resources Transacted area, enter and select values for Quantity to Transact, UOM to Transact, Operation, and Job.

5. The Subinventory field defaults based on the value of the profile CSD: Default Material Subinventory. If no value is set for this profile, the user must enter a value before saving the material line.

6. Click Save to save the data you have entered so far.
If you selected an operation and job in the current session, the resources are added to the job details, but not transacted to the job; the Job field displays a link to the job.

7. To transact materials to a job, select one or more resources, and click Transact.

8. After you have transacted resources, the general Resources area shows the Transacted Quantity and the primary UOM.

9. You can continue to enter Quantity to Transact values, including negative integer quantities. If the quantity is negative then the material will be added to the subinventory specified.

10. Click the DFF field to enter the DFFs for resources. The DFF name for resources is Depot Repair WIP Transaction Details and the context field shown in the table is determined by the profile, CSD: Descriptive Flexfield Context for Technician Portal Resources.

   **Note:** When you transact the resources in the Technician Portal either by Work In process (WIP) move or manual transact, the records are put into WIP interface tables. A WIP concurrent program then processes it. The control comes back immediately to Technician Portal page. However, the actual transaction data is not posted to the WIP tables immediately. Thus, if we try to import the actuals from WIP immediately after completing the job, the actuals may be incomplete at times.

### Using the Debrief Report Tab

The Debrief Report tab enables you to view certain post-service details, such as activity events, summary activity statistics, key performance indicators, such as time to service, and supplier warranties.

You can also select one or more defect types to associate with the service order.
Root Cause of Defect Region

The Root Cause of Defect region lists the defects that you can associate with the service order. You can optionally select one or more of the defects as applicable to the service order.

Defect code domain setup enables you to link each root cause code to specific items or item categories. The Technician Portal displays only the root cause codes that match the item or category of the item on the service order.

See: Setting Up Defect Codes, Oracle Depot Repair Implementation Guide.
Key Performance Indicators and Activities Regions

The view-only Key Performance Indicators and Activities region provides statistics about the service order, including a history of the service activity events.

Supplier Warranty Region

The Supplier Warranty functionality provides the ability to manage supplier warranty claims resulting from maintenance and service work. The two key users involved in the supplier warranty flow are the technician and the warranty administrator.

The technician performs the following actions in Oracle Depot Repair using this new functionality:

- View applicable supplier warranty information
- Change or remove warranty

The warranty administrator performs the following actions in the Supplier Warranty Workbench using this new functionality:

- Create Supplier Warranty Template
• Create Supplier Warranty

• Link Supplier Warranty to Item Instance

• Create and Manage Warranty Claim

See: *Oracle Complex Maintenance, Repair, and Overhaul User’s Guide* for more information on warranty administration.

The Supplier Warranty region displays the following information:

• Item Warranty: The check mark in the Item Warranty column indicates that the item has one or more valid supplier warranties.

• Item: Refers to the item on the service order.

• Job Name: Refers to the service order name.

• Warranty Contract: It is the unique number of the supplier warranty applied to the service order. The list of values (LOV) is active only for open work orders.

• Description: Refers to the descriptive text from the CMRO supplier warranty contract.

• Details icon: Click the Details link to launch the View Warranty Contract page.

*Note:* The Depot Repair application automatically applies supplier warranty to service order if only one valid warranty exists. If more than one valid warranty exists, a check mark in the Item Warranty checkbox is displayed.

### Launching Service Order Orchestration in the Technician Portal

Use the View Details button in the Technician Portal to launch the Service Order Orchestration page.

For more information on Service Order Orchestration page, see: *Service Order Orchestration*, page 4-122.

### Generating Estimates

Once an item is inspected and analyzed, technicians can use the Generate Estimate button in the Technician Portal to create an estimate by first creating a job and then selecting the materials, resources, resource time and/or service codes required to complete the indicated service for the item.

When clicked, the Generate Estimate button creates an estimate using the materials and
resources linked to a service order. If no estimate header exists, the function will create one. A new estimate will always be created in Draft status, and a regenerated estimate will always change the estimate status to Draft. The Generate Estimate function creates a single estimate even if there are multiple jobs created for the service order.

A customer service representative can then view the generated estimate on the Depot Workbench Estimate tab, apply service contracts, determine customer charges and send the estimate to the customer for approval. See: Estimates Generated in the Technician Portal in the Estimate Tab, page 2-24.

The following profiles determine which materials and resources are added to the estimate:

- CSD: Import WIP Resources to Estimates
- CSD: Import WIP Materials to Estimates

See: Setting Up Oracle Depot Repair Profile Options, Oracle Depot Repair Implementation Guide.

To generate estimates:

1. Create a service order.
2. Query the service order in Technician Portal.
3. Create a job.
4. Add Operation, Material, and Resource requirements.
5. Click Generate Estimate button.

Note: The Generate Estimate button will only be enabled if there is no existing estimate, or if the estimate header has the status New. When the estimate header is New, all existing estimate lines will be deleted prior to generating the estimate. The estimate does not support revisions and the deleted lines cannot be retrieved. The generated estimate will be created with the status Draft.

Using the Complete Work button

The Complete Work button in the Technician Portal enables you to achieve the following with a single click:

- If clocked into the Time Clock, clock the user out.
- Issue all material requirements that have not yet been transacted.
• Transact all resource requirements that have not yet been transacted.

• Complete all operations.

• Complete all jobs.

• Change the status of the service order after completing all jobs, as specified in the profile option CSD: Complete Work Service Order Status.

View Service Bulletins from the Technician Portal

Depot Repair automatically links a service bulletin to a service order based on customer defined service bulletin rules. A number of predefined bulletin types are seeded in the product, but you can add any additional bulletin types to fit your business needs. Service bulletins provide information to service managers and technicians regarding:

• Recalls

• ECOs, FCOs, or Supercessions

• Regulatory Compliance - WEEE, RoHS, International Laws

• Parts Shortages

• Up-sells and Cross-sells

• Special Customer Entitlements, Priority, or Expedited Processing

• Processing Exceptions - Late Service Orders, RMAs, Loaners, or Vendor Shipments

To view service bulletins:

1. Navigate to the Technician Portal. Query the service order number for the item to associate the service bulletin.

2. Click on the service order number link to navigate to the Service Order page. The Service Order page displays the detailed information of the corresponding service order number.

3. In the Service Bulletins region, click Retrieve New Service Bulletins to display the newly created service bulletins. You can view a service bulletin by Type. For example:

   • You can retrieve multiple service bulletins within one service order. In this case, one service order triggers multiple service bulletins.

   • You can retrieve service bulletin for Chronic Service Order. Set the profile CSD:
Number of Days in Quality Check period to use this feature.

**Note:** The Depot Repair Service Bulletin Retrieval concurrent program checks the set of applicable service orders and links any service bulletins which apply to them and have not already been linked. This supports business scenarios that need to check all open service orders for service bulletin applicability. This concurrent program scans a selected set of open service orders based on parameters such as:

- Service Bulletin Type
- Service Order Status
- Service Order Inventory Organization
- Service Organization
- Service Order Item

4. Select a service bulletin and click Show to display the following details:

- The Mandatory flag represents that the service bulletin is marked as mandatory in the setup stage. This also indicates to the service technician that this service bulletin is mandatory.

- The Attachment icon represents that an attachment is added to the service bulletin. Click the attachment to download the attachment.

- The Viewed flag represents you have selected the service bulletin to Mark as Viewed from the list of values at the time when the service bulletin was set up. You can view who has viewed the service bulletin and the date of viewing. You
can mark a service bulletin as not viewed by selecting Mark as Unviewed. It enables a service organization to capture whether or not a technician has viewed and complied with a bulletin that contains an instruction. No enforcement for this exists within the application, but this provides a tracking mechanism if you choose to enforce it.

• The Service Code represents that a service code is linked to the service bulletin.

5. Navigate to the Service Codes region. The selected Applicable checkbox represents that a service code is linked.

These service codes are attached to the service bulletin on the setup page. When you retrieve the service bulletin and attach it to an SO, if any of the service codes linked to the service bulletin at time of bulletin setup are valid for the service item and inventory organization then the Applicable checkbox on the Service Codes region of the Evaluation tab is checked.

6. At this point, service technicians can generate jobs from these service codes by clicking Generate Jobs. Once you generate a job, the job number displays in the Job column and the Applicable checkbox is disabled.

Manage ECOs

Engineering Change Orders (ECO) occur when a product has a fault, or when the technical team designs a better way to build it, finds better parts, or regulators specify that certain parts cannot be used anymore. Under these circumstances, the technical team creates a new revision of the master plan for the parts included, the technique to manufacture, or service an item. Technically, this process requires the creation of new bills of material, route and/or service code.

In Depot, the following two steps occur in the processing of an ECO:

• A Service Bulletin notifies the service technician that an ECO exists for the item (the service technician pushes the Check ECO button).

• The service bulletin automatically applies the specific service code to the service for taking the ECO.

Note: If the ECO is applied already, the profile stops the notification from triggering each time, assuming you have already applied the ECO.
the first time you were notified. This prevents you from receiving constant notifications.

When a job is created from the Evaluation tab of the Technician Portal, it uses the service code from the bulletin. Thus when the service technician goes to the Execution tab in the Technician Portal, he will see the parts and operations that the ECO requires.

**Backflush Service Parts**

Backflushing implies automatically performing an inventory material transaction whenever an operation is completed or whenever a job is completed. There are two Supply Type setup options in Inventory/BOM that allow backflush:

- **Assembly Pull:** Assembly Pull issues the material to the job when the job is completed
- **Operation Pull:** Operation Pull backflushes the item when the Operation is completed.

If either of these values are chosen for the supply type, then the item backflushes, if its non-serialized. This function reduces the service technician clicks on jobs where components are not tracked serially.

**Auto-Issue Service Items to Jobs**

The high volume repair centers mostly create a single job for any item they service. When an item is serviced using a WIP job, the item must be issued to that job, and when the job is completed the same item is transacted to the WIP completion subinventory.

Auto-issue service item to jobs feature enables a depot to automatically add the service item as material demand for a job, thus freeing service technicians from additional data entry.

**Using Time Clock**

A service technician works on services from his queue. To begin work, a technician selects the next physical item on the cart or shelf, takes that item to work area, and queries the service order in the system by scanning or entering the serial number. One option is to start the clock automatically once a service order opens and the other option is to punch in work starts. The Time Clock functionality enables a technician to clock in and clock out the time for a service. The system tracks the amount of time a technician spends clocked in on a service and automatically capture that time as a resource transaction. The technician need not manually track time spent on a job or enter information into the system. The technician can pause the clock when taking breaks and allocate time to different operations.
Time clock facilitates a service technician in the following ways:

- It enables the technicians to mark the start time of a service. This time is logged in the system. This is triggered by opening the service or by manually clocking in.

- It enables the technicians to clock out a service. You may clock out for various reasons: lunch break, resource shortage, missing parts, and the like. Clock out stops the clock but no other actions are triggered. This time is logged in the system.

- When a service is finished, technicians perform many actions like: complete operations, complete jobs, log labor hours, transact resources, issue materials, change service status, or kick off a workflow. The Complete Work button enables them to stop the clock and trigger these actions automatically.

The Technician page contains a header level bin named Time Clock that facilitates clock in and clock out.

The Time Clock bin has the following layout:

**Operation**
- This field defaults to the first operation on the Operations table.
- If no operation exists, this field is left blank but defaults to operation 10 when creating Resource lines. You can select different operation from the list of values but you cannot select an operation outside of the Operations table.
- You can update the Operation LOV before you clock in your time. You cannot update an operation once you clock in as the clock in time operates against a specific operation.
- Operation LOV displays operations sequentially.

**Work Started**
- Work Started field displays the first clock in time for a technician.
- You can view the work-started time for your service order only.


**Last Clocked In**
- This timestamp displays the last recorded clock in time and date for the current technician.
- This field is blank for the first time the technician opens the service order.
- When you clock in the time, this field reflects this new clock in time.
- When you clock in the second time, the original clock in time is overwritten with the new time.

**Last Clocked Out**
- This timestamp displays the last recorded clock out time and date for the current technician.
- This field is blank of you are clocking out for the first time.
- When you clock out, this field reflects this new value.
- When you clock out the second time, the original clock out time is overwritten with the new time.

**Clock In and Clock Out**
- Clock In and Clock Out are same buttons with toggled text.
- This button displays Clock In when the clock is stopped and Clock Out when the clock is running.
- You can clock in / clock out against a particular job multiple times.
- Clock In button creates your record in the Resource Time table for the service order, resource item, resource name, operation, and clock in time.
- Clock Out button updates the clock out time for your record in the Resource Time table for the service order, resource item, resource name, operation and clock out time.
- You can clock in and clock out when there is no job or operation. The system assumes that all the time accrues to the first job created.

*Note: If you fail to clock in or clock out you can notify the manager. The manager then opens the service order and adjusts the total labor on the Resources table and updates the service order status. This assumes that personalization is used to restrict access to the Resource table. In the absence of this personalization, you can add or remove resource time from the table.*
Next

- This button permits to clock out from current operation and clock in to the next one.

- The button is enabled when you clock in the first time and it is disabled when you clock in to the final operation for a service order.

- This creates a new resource record in the Resource table. The Operation LOV gets updated to the next operation in the sequence. If more than one operation exists, the sequence is to complete all operations on the lowest job number first, then the next lowest job number operations and so on.

- A new clock in record is also created for the resource item, resource name and new operation.

The Technician page contains a header level button named Complete Work that enables you to stop the clock and trigger various actions like: complete operations, complete jobs, log labor hours, transact resources, issue materials, change service status, or kick off a workflow.

- This button is enabled using personalization.

- When you click this button, materials, resources, operations, and jobs are processed first. Then the status is updated which triggers the workflow.

- Clicking this button automatically clocks out the technician if it is not done already.

- When issuing serialized items, you have to manually capture the serial number before clicking Complete Work button.

- This button processes only the unissued items, transacts only the un-transacted resources and completes the un-complete operations or jobs.

  **Note:** Both the Time Clock bin and Complete Work order button are enabled by personalization.

Deleting Operations

You can use the Depot Repair Technician Portal’s Delete functionality to delete saved operations which match all of the following criteria:

- The operation can be deleted via WIP forms.

- The user has not clocked into the operation using the Depot Time Clock feature

- The user has not transacted any materials for this operation
**Note:** Limitations of the Delete functionality are as follows:

- Depot will not support the deletion of WIP operations outside of the Repair Technician portal.

- The first operation cannot be deleted as by default, the first operation in a WIP job created via Depot is always in to-queue status.
Windows and Navigator Paths

This appendix lists each window available for use in the Oracle Depot Repair application as well as the associated navigator path for each window.

This appendix covers the following topics:

- Depot Repair Windows and Navigator Paths

Depot Repair Windows and Navigator Paths

Although your system administrator may have customized your navigator, typical navigational paths are presented in the following table:

**Note:** [B], [T], and [M] indicate button, tab and menu respectively.

<table>
<thead>
<tr>
<th>Window Name</th>
<th>Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Data[M] &gt; Activity</td>
</tr>
<tr>
<td>Activity Rules</td>
<td>Depot Repair &gt; Set Up &gt; Activity Rules</td>
</tr>
<tr>
<td>Activity Line Details</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Actuals [T] &gt; Line Details[B]</td>
</tr>
<tr>
<td>Aging Threshold Setup</td>
<td>Depot Repair &gt; Set Up &gt; Manager Thresholds &gt; Aging Thresholds</td>
</tr>
<tr>
<td>Bulk Receive</td>
<td>Depot Repair &gt; Receive Returns</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Service Orders</td>
<td>Depot Repair &gt; Create Service Orders</td>
</tr>
<tr>
<td>Create Tasks from Template Group</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Tasks [T] &gt; Use Template [B]</td>
</tr>
<tr>
<td>CSD: Material Dispositions Lookups</td>
<td>Depot Repair &gt; Setup &gt; Environmental Impact Dashboard &gt; Material Dispositions</td>
</tr>
<tr>
<td>CSD: Return Streams Lookups</td>
<td>Depot Repair &gt; Setup &gt; Environmental Impact Dashboard &gt; Return Streams</td>
</tr>
<tr>
<td>Coverage</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Tools [M] &gt; Coverage</td>
</tr>
<tr>
<td>Debrief Report [T]</td>
<td>Depot Repair &gt; Technician Portal &gt; Service Order Search &gt; Service Order</td>
</tr>
<tr>
<td>Defect Code Domains</td>
<td>Depot Repair&gt; Setup &gt; Diagnostics, Services and Root Cause &gt; Defect Code Domains</td>
</tr>
<tr>
<td>Defaulting Rules</td>
<td>Depot Repair &gt; Set Up &gt; Defaulting Rules</td>
</tr>
<tr>
<td>Diagnostic Codes</td>
<td>Depot Repair&gt; Setup &gt; Diagnostics, Services and Root Cause &gt; Diagnostic Codes</td>
</tr>
<tr>
<td>Dynamic BOM</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Estimate[T] &gt; Select Materials[B]</td>
</tr>
<tr>
<td>Enter Returns</td>
<td>Depot Repair &gt; Returns Portal &gt; Enter Returns [B]</td>
</tr>
<tr>
<td>Estimate Charge Line Details</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Estimate[T] &gt; Line Details [B]</td>
</tr>
<tr>
<td>Estimated Costs vs Estimated Charge</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Estimate[T] &gt; Costs[B]</td>
</tr>
<tr>
<td>Feature</td>
<td>Path Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Evaluation [T]</td>
<td>Depot Repair &gt; Technician Portal &gt; Service Order Search &gt; Service Order</td>
</tr>
<tr>
<td>Environmental Impact Dashboard</td>
<td>Depot Repair &gt; Environmental Impact Dashboard</td>
</tr>
<tr>
<td>Find Customer</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Tools [M] &gt; Find Customer</td>
</tr>
<tr>
<td>Find Expected Receipts</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Logistics [T] &gt; Go [B]</td>
</tr>
<tr>
<td>Find Service Orders for Job Submission</td>
<td>Depot Repair &gt; Submit Jobs &gt; Organizations</td>
</tr>
<tr>
<td>Find Service Requests</td>
<td>Depot Repair &gt; Depot Workbench</td>
</tr>
<tr>
<td></td>
<td>Depot Repair &gt; Repair Orders</td>
</tr>
<tr>
<td>New Customer</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; New Contact [B]</td>
</tr>
<tr>
<td>New Party - Customer</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; New Customer [B]</td>
</tr>
<tr>
<td>Move Items Internally</td>
<td>Depot Repair &gt; Repair Orders &gt; Find Service Orders &gt; Service Orders &gt; Logistics [T] &gt; select Internal Move Orders in Actions list</td>
</tr>
<tr>
<td>Manage Portals</td>
<td>Depot Repair &gt; Returns Portal</td>
</tr>
<tr>
<td>Material Disposition Reasons</td>
<td>Depot Repair &gt; Setup &gt; Environmental Impact Dashboard &gt; Material Disposition Reasons</td>
</tr>
<tr>
<td>Recall Flow Status Lookups</td>
<td>Depot Repair &gt; Setup &gt; Service Campaign / Recalls &gt; Service Campaign / Recall Statuses</td>
</tr>
<tr>
<td>Feature</td>
<td>Path Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Recalls Setup</td>
<td>Depot Repair &gt; Setup &gt; Service Campaign / Recalls&gt; Service Campaign / Recall Setup</td>
</tr>
<tr>
<td>Recall Status Setup</td>
<td>Depot Repair &gt; Setup &gt; Service Campaign / Recalls&gt; Service Campaign / Recall Status Setup</td>
</tr>
<tr>
<td>Region Geographies</td>
<td>Depot Repair &gt; Setup &gt; Environmental Impact Dashboard &gt; Region Geographies</td>
</tr>
<tr>
<td>Reason Lookups</td>
<td>Depot Repair&gt; Setup&gt; Reason</td>
</tr>
<tr>
<td>Regions Lookups</td>
<td>Depot Repair &gt; Setup &gt; Environmental Impact Dashboard &gt; Regions</td>
</tr>
<tr>
<td>Repair Order Defect Code Lookups</td>
<td>Depot Repair&gt; Setup&gt; Diagnostics, Services and Root Cause&gt; Defect Codes</td>
</tr>
<tr>
<td>Repair Statuses Lookups</td>
<td>Depot Repair &gt; Set Up &gt; Service Order Status Definition</td>
</tr>
<tr>
<td>Returns Parameters</td>
<td>Depot Repair&gt; Setup&gt; Returns Portal &gt; Return Parameters</td>
</tr>
<tr>
<td>Return Parameter Values</td>
<td>Depot Repair&gt; Setup&gt; Returns Portal &gt; Return Parameter Values</td>
</tr>
<tr>
<td>Reserve / Unreserve Serial Numbers</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Orders &gt; Service Orders &gt; Data [M] &gt; Reserve Serial Number or Unreserve Serial Number</td>
</tr>
<tr>
<td>Return Types</td>
<td>Depot Repair&gt; Setup&gt; Returns Portal &gt; Return Types</td>
</tr>
<tr>
<td>Quality Threshold Setup</td>
<td>Depot Repair &gt; Set Up &gt; Manager Thresholds&gt; Quality Threshold</td>
</tr>
<tr>
<td>Service Bulletins</td>
<td>Depot Repair &gt; Set Up &gt; Service Bulletins</td>
</tr>
<tr>
<td>Service Contracts Coverage</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Tools [M] &gt; Coverage &gt; View Coverage</td>
</tr>
<tr>
<td>Service Codes</td>
<td>Depot Repair &gt; Setup &gt; Diagnostics, Services and Root Cause &gt; Service Codes</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Code Recommendations</td>
<td>Depot Repair &gt; Setup &gt; Diagnostics, Services and Root Cause &gt; Service Code Recommendation</td>
</tr>
<tr>
<td>Service Execution [T]</td>
<td>Depot Repair &gt; Technician Portal &gt; Service Order Search &gt; Service Order</td>
</tr>
<tr>
<td>Setup Eco-Impact Thresholds</td>
<td>Depot Repair &gt; Setup &gt; Environmental Impact Dashboard &gt; Eco-Impact Thresholds</td>
</tr>
<tr>
<td>Service History</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Data [M] &gt; Service History</td>
</tr>
<tr>
<td>Service Manager Portal</td>
<td>Depot Repair &gt; Service Manager Portal</td>
</tr>
<tr>
<td>Service Orders</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; New [B] or Find [B] &gt; OK [B]</td>
</tr>
<tr>
<td></td>
<td>Depot Repair &gt; Repair Orders &gt; Find Service Requests &gt; New [B] or Find [B] &gt; OK [B]</td>
</tr>
<tr>
<td>Service Order Status Set-Up</td>
<td>Depot Repair &gt; Set Up &gt; Service Order Status Details</td>
</tr>
<tr>
<td>Service Order Orchestration</td>
<td>Service Orders &gt; Data [M] &gt; Launch Service Order Orchestration</td>
</tr>
<tr>
<td>Service Order Orchestration Rules</td>
<td>Depot Repair &gt; Setup &gt; Service Order Orchestration Rules</td>
</tr>
<tr>
<td>Submit Jobs</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Jobs [T] &gt; Create Job [B]</td>
</tr>
<tr>
<td>Submit Jobs for Service Orders</td>
<td>Depot Repair &gt; Submit Jobs &gt; Organizations &gt; Find Service Orders for Submission &gt; OK [B]</td>
</tr>
<tr>
<td>Setup Return Streams Reason</td>
<td>Depot Repair &gt; Setup &gt; Environmental Impact Dashboard &gt; Return Stream Reasons</td>
</tr>
<tr>
<td>Feature</td>
<td>Path</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search and Update Service Orders</td>
<td>Depot Repair &gt; Search and Update Service Orders</td>
</tr>
<tr>
<td>Service Types</td>
<td>Depot Repair &gt; Set Up &gt; Service Types</td>
</tr>
<tr>
<td>Service Order Status Transitions</td>
<td>Depot Repair &gt; Set Up &gt; Service Types &gt; Service Order Status Transitions [B]</td>
</tr>
<tr>
<td>Service Type Transitions</td>
<td>Depot Repair &gt; Set Up &gt; Service Types &gt; Service Type Transitions [B]</td>
</tr>
<tr>
<td>Tasks Detail</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Tasks [T] &gt; More [B]</td>
</tr>
<tr>
<td>Technician Portal: Service Order Search</td>
<td>Depot Repair &gt; Technician Portal</td>
</tr>
<tr>
<td>Technician Portal: Service Order</td>
<td>Depot Repair &gt; Technician Portal &gt; Service Order Search</td>
</tr>
<tr>
<td>Technician Portal: Update Service Order</td>
<td>Depot Repair &gt; Technician Portal &gt; Service Order Search &gt; Update Status [B]</td>
</tr>
<tr>
<td>Update Status</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Details [T] Update SO Status</td>
</tr>
<tr>
<td>Update Tasks</td>
<td>Depot Repair &gt; Depot Workbench or Repair Orders &gt; Find Service Requests &gt; Service Orders &gt; Tasks [T] &gt; Debrief [B]</td>
</tr>
</tbody>
</table>
Index

A
access Depot Repair, 2-2
accounting class, field, 2-31
Actual Qty for Tasks, 2-37
Actual UOM for Tasks, 2-37
advanced exchange
  service type, 1-2
Advanced Scheduler, integration with, 1-12
  process, 3-6
all contracts, 2-43
approval
  forced, 2-9
  obtain customer, 4-57
Assignment Manager
  icon, 2-37
  integration with, 1-12
audit
  history log, 2-37
  track task update, 4-87
Audit, 2-37
Auto-Issue
  service items, 10-21
auto-receive, 4-58

B
Backflush
  service parts, 10-21
billing category, 2-24
Bills of Material, integration with, 1-12
Booked, status, 2-12, 2-14
business process flows, 1-6

C
charge line
  add new, 2-24
  delete a charge line, 2-24
  edit, estimate, 2-24
  estimate details, 2-24
Charges, integration with, 1-12
  close
    service order, 4-109
    service request, 4-110
Closed, field, 2-7
Completion Transactions window, 4-82
concurrent program
  Customer Profile Engine, 4-4
contact
  create customer, 4-10
  enabling creation of, 2-37
Contact, field, 2-5
Contact ID, field, 2-5
contact information, service request, 2-4
contract
  default service order, 2-29
  entitlement, 2-43
  view active, 2-43
  view all, 2-43
Contracts, integration with, 1-12
counter, history issues, 1-12
Counters, integration with, 1-12
create
  customer contact, 4-10
manual ship line, 4-93
notes, 4-34
RMA manually, 4-25
service order, 4-16
task, task template, 4-85
task manually, 4-84
tasks, 4-82
WIP job, multiple orders, 4-77
WIP job, single order, 4-73
Created, status, 2-12, 2-14
currency
field, 2-9
in estimate, 2-24
single, in service order, 2-24
support within service request, 2-24
customer
approval, obtain, 4-57
contact, create a, 4-10
data store, about, 1-2
information, service request, 2-4
invoice, 4-108
management, about, 1-2
profile, 1-2
profile, engine, 1-12
profile, integration, 1-12
profile, open service request, 4-4
profile, review, 2-2
profile, view, 2-43, 4-4
Customer Care, integration with, 1-12
Customer Profile, integration with, 1-12
Customer Profile Engine concurrent program, 4-4
Customer Take-back Request
process, 3-14

D
date closed
field, 2-9
service order field, 2-49
service request field, 2-48
Date Created, field, 2-9
date opened
service order field, 2-49
service request field, 2-48
debrief
invoice based on, 4-89
prepare tasks, 4-89
Debrief button, 2-37
Default PO Num
field, 2-9
Define Triggers
service bulletins, 2-56
Dependencies, 2-37
Depot Repair
customer management, 1-2
key features, 1-2
manage processes, 4-3
relationship management, 1-2
what is, 1-1
Depot Repair Workbench
about, 1-2, 2-2
Details Tab
resolve by date, 2-9
Diagnostics tab
about and using, 4-36
Dynamic Repair BOM
select service parts, 4-118

E
Entered, status, 2-12, 2-14
Environmental Impact Dashboard, 2-61, 8-2
disposition summary tab, 8-8
eco-impact tab, 8-6
overview, 8-1
put on market tab, 8-8
returns tab, 8-4
escalated service request, 4-4
estimate
approval statuses, 2-7
create service, 4-51
currency, 2-24
default service order contract, 2-29
detail worksheet, 2-24
editable fields, 2-29
edit charge lines, 2-24
enable or disable, 2-24
expenses required, 2-24
fields, 2-24
fields of service, 2-24
forced approval step, 2-9
freeze, 2-43
generated in Technician Portal, 2-24
in resolution management, 1-2
in service process, 1-1
labor required, 2-24
launch worksheet of, 2-24
line details area, 2-24
logistics and maintenance, 1-6
multi-record fields, 2-24
no charge, 2-24
notes, 2-24
override charge, 2-24
profile option, service, 2-24
reason code, 2-26
recommended entry of charges, 2-16
required material, 2-24
revise service, 4-56
save, 2-24
save header and charge lines, 2-24
See also estimate., 2-24
service, multi-record fields, 2-24
service charges, 4-49
statuses, 2-24
statuses of, 2-24
summary of charges, 2-24
totals, 2-24
transactions to complete service, 2-24
Estimate Approval Required, 2-9
Estimate Approved, field, 2-7
estimated charges fields, 2-24
Estimate Qty for Tasks, 2-37
Estimate UOM for Tasks, 2-37
Event, 2-48
exchange
  process, 3-5
  process advance, 3-6
  service type, 1-2
Execute Repair, 2-59
expense
  billing category, 2-24
  captured to complete task, 2-37
debrief a job, 4-89
enter required information, 4-89
required in estimate, 2-24
subtotal of estimated, 2-24		
tab, in Debrief Report, 4-89
total in estimate, 2-24

F
Field Service, integration with, 1-12
Find Discrete Jobs window, 4-81
freeze estimate
  See also frozen estimate., 2-43
  specify, 2-43

G
General Ledger, integration with, 1-12
Generating Estimates
  Technician Portal, 10-16

H
history
  audit log, 2-37
  audit of tasks, 4-87
counter issues, 1-12
detailed service, 1-2
message, service order, 4-93
message, view, 2-43
note about Installed Base product service, 4-6
product service, 2-2, 4-6
view message, 2-44
view product service, 4-6
window, service, 2-48
HRMS, integration with, 1-12

I
IB Ref Num, field, 2-6
Install Base, integration with, 1-12
Installed Base
  display of product information, 2-43
  note about product service history, 4-6
Installed Products Only, check box, 2-4
Installed Site, field, 2-9
Instance, field, 2-9
Instance number, in service request, 4-12
integration with other Oracle modules, 1-12
Internal Moves, 2-61
internal service operation business flow, 1-6
inventory
  logging service request for products in, 4-12
Inventory, integration with, 1-12
invoice
about, 1-1
based on debrief value, 4-89
create with loaner, 1-2
customer, 4-108
repair and return, 1-2
use with Order Management, 1-12
iSupport, integration with, 1-12
item
   auto-receive, 4-58
   receive, 4-59
   receive refurbishment, 4-63
   ship, 4-94
Item
   move
      usable spares subinventory, 4-98
J
job
   management, tasks, 1-2
   management, WIP, 1-2
See also service order., 2-50
   submit, 2-50
job status, field, 2-31
K
Knowledge Management
   database, about, 1-2
   integration with, 1-12
L
labor
   billing category, 2-24
   captured to complete task, 2-37
   charging and invoicing, 1-1
   debrief a job, 4-89
   enter required information, 4-89
   log using the Debrief Report, 1-12
   required in estimate, 2-24
   subtotal of estimated, 2-24
   tab, in Debrief Report, 4-89
   total in estimate, 2-24
   transfer for invoicing, 1-6
Launch Workflow, 2-37
loaner
   about invoicing customer, 1-2
   repair and return, process, 3-3
   repair and return service type, 1-2
   service type, 1-2
logistics maintenance
   with call center business flow, 1-6
   without call center business flow, 1-6
Lot Num, field, 2-9
M
maintain
   notes, 4-34
manage
   service process, 4-72
Manage ECO, 10-20
   mandatory for service process, 4-12
material
   billing category, 2-24
   captured to complete task, 2-37
   debrief a job, 4-89
   enter required information, 4-89
   required in estimate, 2-24
   subtotal of estimated, 2-24
   tab, in Debrief Report, 4-89
   total in estimate, 2-24
   message
      history, view, 2-43
      view history of, 2-43
   messaging
      workflow-based, 4-93
Move
   item
      usable spares subinventory, 4-98
   Move Items Internally, 4-27
   multiple order
      create WIP jobs, 4-77
      process WIP jobs, 4-80
N
no charge, estimate, 2-24
note
   create, 4-34
   display, 2-9
   estimate, 2-24
   maintain, 4-34
   Notes, integration with, 1-12
   number, service request, 2-48
O
Opened, field, 2-7
order
    Estimate tab, 2-24
    WIP, create job, 4-73
    WIP, process single job, 4-76
Order Management
    integration with, 1-12
    invoice customer, 1-12
    status of order number, 2-12, 2-14
Outside Processing
    execute, 4-118
override charge, estimate, 2-24

P
Parameters
    setup, 1-7
Phone, field, 2-5
Planned Returns
    planned, 2-59
prepare, tasks debrief, 4-89
Price List
    field, 2-9
Pricing, integration with, 1-12
product
    coverage, view information, 4-5
    field, 2-6, 2-7, 2-9
    log service request for, 4-12
    service, view history of, 4-6
Product Description, field, 2-7
profile
    customer, 1-2
    tool, 2-43
    view customer, 4-4
Promise Date, field, 2-9
Purchasing, integration with, 1-12

Q
Qty Completed in WIP, 2-48
Qty Received, 2-48
Qty Shipped, 2-48
Qty Submitted to WIP, 2-48
Quantity, field, 2-7

R
Recalls
    corrective actions tab, 7-9
    create, 7-4
    details tab, 7-6
    find, 7-12
    items tab, 7-7
    metrics tab, 7-11
    overview, 7-1
    process flow, 7-2
Receivables, integration with, 1-12
receive
    auto-receive, 4-58
    item, 4-59
    refurbishment item, 4-63
Recurrences, 2-37
Reference, 2-37
refurbishment
    process, 3-8
    receive, 4-63
refurbishment service type, 1-2
Relationship, field, 2-5
relationship management, about, 1-2
Released, status, 2-12, 2-14
repair
    and return, process, 3-1
    invoicing with repair and, 1-2
    loaner and return process, 3-3
repair and return
    service type, 1-2
repair depot, manage processes, 4-3
replacement
    process, 3-7
    service type, 1-2
request information, service request, 2-4
Request Num, field, 2-7
Request Type, field, 2-7, 4-12
resolution management, 1-2
Resource Manager, integration with, 1-12
Resources, 2-37
return and repair process, 3-1
return materials authorization. See RMA., 1-2
Return only repair
    process, 3-11
return product
option, 2-12
Returns Portal
interacting, 6-2
overview, 6-1
using, 6-2
Revision, field, 2-6, 2-9
revision status, 2-9
RMA
  automatically enter and book, 2-9
  book a, 2-12
  Charges, 1-12
  completion of line, 1-6
  create, manually, 4-25
  create and view lines, 2-12
  displays number, 2-12
  internal service operations, 1-6
  job without, 4-73
  loaner, 1-2
  loaner, repair, and return, 1-2
  option, action to receive, 2-12
Order Management, 1-12
partial quantities, 4-76
quantity received, 2-48
repair and return, 1-2

S

search
  job submission, 2-50
Send Message tool, 2-43
Serial Num, field, 2-6, 2-9
serial number
  changes to, 1-12
  for serialized products, 4-12
  of serviced item, 2-9
  product information field, 2-6
Service
  create manual ship line, 4-93
  create task from task template, 4-85
detail history of, 1-2
  estimates, revise, 4-56
  history of product, 2-2
  history window, 2-48
  invoice customer, 1-12
order. See service order or job., 4-92
  prepare task debrief, 4-89
  product, history of, 4-6
  tasks, create, 4-82
WIP, create job single order, 4-73
WIP, create multiple service orders, 4-77
WIP, process multiple service orders, 4-80
WIP, process single order, 4-76
Service
  charges, estimate, 4-49
  estimates, create, 4-51
Service Bulletins
  view using Depot Repair Workbench, 4-121
  view using Technician Module, 10-18
Service Campaign or Recall
  process, 3-12
Service Campaigns and Recalls, 2-60
service history
  view, 2-48
service history window, 4-6
service history window, 2-48
service Manager Portal, 2-60
Service Manager Portal
  Advanced Search, 5-4
  overview, 5-1
  Quality Event Watchlist, 5-3
Service Manager Portal page, 5-2
Service Order Backlog, 5-2
  setting up aging threshold, 5-10
  setting up quality threshold, 5-11
using the create service order page, 5-8
service order
  Activity window, 2-48
  Actuals tab, 2-39
  close, 4-109
Coverage window, 2-43
  create, 4-16
  created against service request, 4-16
currency support, 2-24
Details tab, 2-9
Diagnostics tab, 2-21
fields, 2-49
Find Service Orders for Job Submission, 2-50
information area, 2-7
Jobs tab, 2-31
link, 2-48
Logistics tab, 2-12
message history, 4-93
Service History window, 2-48
show history, 4-6
split, 4-70
status, 2-9
Tasks tab, 2-37
update concurrently, 4-92
view related activities, 4-90
window tools, 2-43, 2-48
Service Order Orchestration
view using Depot Repair Workbench, 4-122
view using Technician Portal, 10-16
service process
manage, 4-72
mandatory service request, 4-12
service request, 4-12
access knowledge repository, 1-12
apply contract, 4-89, 4-101, 4-105
assigns by owner, 2-7
automatically create, 2-2
builder, 1-2
close, 4-110
contact for, 4-10
contact information fields, 2-4
contract selected, 4-5
create, 4-12
currency support, 2-24
customer information fields, 2-4
details, 4-5
escalated, 4-4
fields, 2-48
filter view of notes, 2-9
for products in inventory, 4-12
in business flow, 1-6
information area, 2-4, 4-12
Instance reference number, 4-12
internal service operations, 1-6
key management processes, 1-2
linked service order field, 2-49
log, 1-2, 4-3
management, about, 1-2
new contact, 4-10
note about profile, 4-12
number, link, 2-48
open, 1-2, 4-4
quick menu, 2-2
request information fields, 2-4
save, 4-12
service orders created against, 4-16
Service Orders window, 4-12
show details, 4-89
SR Owner field, 4-12
view activities against, 4-21
view all, 4-6
Service Requests, integration with, 1-12
service type
about, 1-2
advanced exchange, 1-2
exchange, 1-2
field, 2-7
loaner, 1-2
loaner, repair and return, 1-2
processing, 1-2
refurbishment, 1-2
repair and return, 1-2
replacement, 1-2
standard, 1-2
severity
field, 2-7
service request field, 2-48
ship
item, 4-94
Shipped, status, 2-12, 2-14
single order
create WIP job, 4-73
process WIP job, 4-76
SO Num, field, 2-7, 2-9
SO Owner, field, 2-9
SO status, field, 2-7
split service order, 4-70
SR Owner, field, 2-7
standard service type, 1-2
status
active Order Management order number, 2-12,
2-14
Booked, 2-12, 2-14
change replaced product, 1-2
Created, 2-12, 2-14
current task, 2-37
Entered, 2-12, 2-14
estimate approval, 2-7
field, 2-7
Issued, 2-12, 2-14
Job Status, 2-31
query order, 1-2
Received, 2-12, 2-14
Released, 2-12, 2-14
revision, 2-9
service order, 2-9
service order (SO), 2-9
service order field, 2-49
service request field, 2-48
Shipped, 2-12, 2-14
WIP job, 2-31
Summary, field, 2-7
Supplier Warranty process, 3-14

T

Task
  audit trail (history), 4-87
  create, 4-82
  create, manually, 4-84
  current status, 2-37
  enter and update details of, 4-87
  job management, 1-2
  prepare, debrief, 4-89
  track update (audit), 4-87
Task Manager, integration with, 1-12
task template, create task from, 4-85
Technician Portal
  Complete Work button, 10-17
  deleting saved operations, 10-24
  generating estimates, 10-16
  overview, 10-1
  service order orchestration, 10-16
TeleService
  APIs, 1-12
TeleService, integration with, 1-12
Third party flows, 4-112
Third Party Repair process, 3-11
Time Clock, 10-21
Trade-in or Upgrade process, 3-15
Traveler Document
  print, 4-120
type
  field, 2-48
  service order field, 2-49
  service request field, 2-48

U

unit of measurement. See UOM., 2-7

Unplanned Returns
  receive, 2-59
UOM, field, 2-7
Update Counters, 2-9
Update SO Status, 2-9
urgency
  service request field, 2-48
Use Template, 2-37

V

view, 2-43
  active contracts, 2-43
  activities related to service order, 4-90
  customer profile, 4-4
  product coverage information, 4-5
  product service history, 4-6
View IB Config, 2-9
View Message History tool, 2-43

W

Warranty Status, field, 2-9
WIP
  create job, multiple orders, 4-77
  create job, single order, 4-73
  job, current status, 2-31
  job management, 1-2
  process job, multiple orders, 4-80
  process job, single order, 4-76
WIP Jobs and Schedules window, 4-82
WIP Material Transaction Find window, 4-81
workflow
  messaging, based on, 4-93
Work in Process
  integration with, 1-12
  See also WIP., 1-2